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Introduction

A CT!is the best-selling contact manager software on the market today.
For many of these users, ACT! represents their first foray into the area
of contact relationship management (CRM). Contact management software is a
little more complex to understand than other types of software. With a word
processor, each document that you create is totally separate; if you make a
mistake, you need only to delete your current document and start fresh.
Contact management, however, builds its way into a final product; if you
don’t give a bit of thought as to what goal you wish to achieve, you could end
up with a muddled mess.

[ am a fanACTic, and I'm not ashamed to admit it.  use ACT! at work. I use
ACT! on the road. [ use ACT! at home. I've even inspired my friends to use
ACT!. I'm excited about the product and know that by the time you discover
how to unleash the power of ACT!, you’ll be excited, too.

So what am I so excited about? I've seen firsthand how ACT! can save you
time and help make you more efficient in the bargain. To me, accomplishing
more in less time is an exciting thought — it allows more time for the fun
things in life. Best of all, ACT! is a program that’s very easy to get up and run-
ning in a very short time. You’ll be amazed not only at how quickly you can
set up a database but also at how easily you can put that database to work.
Maybe by the time you finish this book, you, too, will become a fanACTic!

About This Book

ACT! by Sage For Dummies, 9" Edition is a reference book. As such, each chap-
ter can be read independently and in the order you want. Each chapter
focuses on a specific topic so you can dive right in, heading straight for the
chapter that interests you most. Having said that, however, | must say that
I've tried to put the chapters into a logical sequence so that those of you who
are new to ACT! can just follow the bouncing ball from chapter to chapter.
More experienced users can use the Table of Contents and the index to
simply navigate from topic to topic as needed.

Essentially, this book is a nuts-and-bolts how-to guide for accomplishing vari-
ous tasks. In addition, drawing on many of my own experiences as a full-time
ACT! consultant and trainer, I include specific situations that should give you
a feel for the full power of ACT!.
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Conventions Used in This Book

Like in most Windows-based software programs, you often have several
different ways to accomplish a task in ACT!.

For the most part, I show you ways to perform a function by using the ACT!
menus. When an instruction reads Choose File>Open, you must access the
File menu (located at the top of the ACT! screen) by clicking it with the left
mouse button and then choosing the Open option from the subsequent menu
that appears. In most cases, you can access these commands from anywhere
within ACT!, but I generally advise new ACT! users to always start a task from
the Contact Detail view, which is the first window you see when ACT! opens.
If you must be in a particular area to complete a task otherwise, I tell you
where.

When you need to access one of ACT!"’s hidden menus, click an appropriate
area of the screen with the right mouse button and then choose from the con-
textual menu that appears. In these instances, I simply say right-click when
you need to right-click.

What Vou Should Read

Of course, | hope that you're going to sit down and read this entire book from
cover to cover. But then again, this book isn’t The Great American Novel.
And, come to think of it, the whole reason why you bought this book in the
first place is because you want to get your ACT! together (no groans, please!)
as quickly as possible because you’re probably finding yourself with too
much to do and too little time in which to do it.

For the time being, I'm going to let you get away with reading just the parts
that interest you most. I'll let you read the last chapter first and the first
chapter last if you like because this book is designed to allow you to read
each chapter independently. However, when you find yourself floating in a
swimming pool, soaking up the sun, and wondering what to do with all your
spare time, you might want to go back and read some of those chapters you
skipped. You just might discover something!

What You Don’t Have to Read

This book is intended for both new and existing ACT! users. Most of the
instructions apply to both groups of readers. Once in a while, [ include some
information that might be of special interest to more advanced readers.
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Newbies, feel free to skip these sections! Also, any information tagged with a
Technical Stuff icon is there for the truly technically inclined. Everyone else
can just skip this info.

Foolish Assumptions

One of my least favorite words in the English language is the word assume,
but I've got to admit that I've made a few foolish — albeit necessary —
assumptions when writing this book. First of all, I assume that you own a
Windows-based computer and that ACT! is installed on it. Second, [ assume
that you have a basic knowledge of how to use your computer, keyboard, and
mouse, and that ACT! isn’t the very first application that you're trying to
master.

[ also assume that you have a genuine desire to organize your life and/or
business and have determined that ACT! is the way to go. Finally (and I feel
quite comfortable with this assumption), [ assume that you’ll grow to love
ACT! as much as I do.

How This Book Is Organized

[ organized this book into six parts. Each part contains several chapters cov-
ering related topics. The following is a brief description of each part, with
chapter references directing you where to go for particular information:

Part I: The Opening ACT!

In Part I, you get an introduction to the concept of a database and why ACT!
has become such a popular choice of database users (Chapter 1). In this part,
you read about what to expect the first time you fire up ACT! (Chapter 2) and
how to set the main preferences in ACT! (Chapter 3).

Part II: Putting the ACT!
Database to Work

Part Il focuses on putting your contacts into ACT! (Chapter 4) and, more
importantly, how to find them again (Chapters 6). [ show you how to view all
the details about one contact, how to pull up a list of all your contacts, and
even how to create an easy list report.
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After you master organizing your contact information, Part Il helps you orga-
nize your day. ACT! makes it easy to take notes (Chapter 7) so that you start
relying on ACT! more and your memory less. You find out how to schedule
appointments, calls, and to-do’s — and other important events in your life.
And, you discover how to view those activities in the daily, weekly, and
monthly calendars (Chapter 8). Your life can become complicated, but have
no fear because ACT! does its best to help you navigate through the maze by
providing you with customizable Dashboards designed to let you see a com-
plete snapshot of your business (Chapter 9). The History, Documents, and
Secondary Contacts tabs allow you to accumulate lots of information about
each and every one of your contacts (Chapter 5).

Part I11: Sharing Your Information
with Others

Corporate America lives for reports, and ACT! is up to the challenge. Whether
you want to print labels or telephone directories on commercially printed
forms or prefer to utilize the ACT! built-in reports, Part Ill shows you how
(Chapter 10).

One of the best features of ACT! is the ability to communicate easily with the
outside world. Part Ill shows you how to work with templates to automate
routine documents as well as how to send out mass mail merges — whether
by snail mail, fax, or e-mail (Chapter 11). You also discover the advantages of
using ACT! for your e-mail (Chapter 12).

Part IU: Advanced ACTling

We're all different and often like to do things in our own unique way. ACT!
understands that concept, and Part IV helps you to customize ACT! to your
heart’s content. At first glance, ACT! might seem like just an over-the-counter
piece of software, but by adding fields (Chapter 13) and placing them on cus-
tomized layouts (Chapter 14), you can make it perform as well as an expen-
sive piece of proprietary software.

Every database needs an Administrator. If you're elected to the job, you need
to know how to perform administrative tasks, such as performing routine
maintenance, backing up your database, and checking for duplicate data
entry (Chapter 15). You'll read about ACTdiag, the higher-level maintenance
tool, how to add multiple users to your database, and how to limit access to
various contact records (Chapter 16). If you have remote users who need to
access all or parts of your database, you need to know how to synchronize
your database (Chapter 17).
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Part U: Commonly Overlooked
ACT! Features

Part V focuses on four of the most frequently overlooked ACT! features:

» Microsoft integration: Synchronize your ACT! and Outlook address
books and calendars; attach a Web site in Internet Explorer directly to
an ACT! contact; and explore the various ways that you can use ACT!
and Excel together (Chapter 18).

1 Sales opportunities: Track your prospective sales, prioritize them,
and analyze what you did right — or wrong — in making the sale
(Chapter 19).

v Groups: Group your contacts to add a new dimension to your database
(Chapter 20).

v Companies: The Company feature enables you to view and edit contacts
that all “belong” to the same company (Chapter 21).

In addition, I show you how to install and customize ACT! Premium for Web,
the online version of ACT! (Chapter 22).

Part Ul: The Part of Tens

With apologies to David Letterman, Part VI gives you two of my favorite ACT!
lists. First, I discuss a few of the features that are found only in ACT! Premium
2008 (Chapter 23). Finally, I give you ten of my favorite ways to help you uti-
lize ACT! to its fullest extent (Chapter 24).

About the Web site

2004 marked a milestone in the history of ACT!. Prior to that time, the ACT!
development team was fairly small, which is evidenced by the fact that only
six versions of ACT! were released in the first 17 years of its existence. In
2004, Sage Software took over the ownership of ACT!. With the new owner-
ship came a new database engine for ACT! — SQL — and a commitment to a
yearly update schedule.

To help you keep up with the exciting new features of successive versions of
ACT!, this book (although written using ACT! 2008) will guide you through
both ACT! 2008 and ACT! 2009. We are instituting a Wiley Web site (pun
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intended!) where you will be able to catch up on any new ACT! developments
that come along: You'll find links to the products mentioned throughout this
book, and, most importantly, when ACT! 2009 arrives on the scene, you'll be
able to read all about the new enhancements — free of charge — by visiting
www . dummies.com/go/actfordummies9e.

ons Used in This Book

A Tip icon indicates a special timesaving tip or a related thought that might
help you use ACT! to its full advantage. Try it; you might like it!

A Warning icon alerts you to the danger of proceeding without caution.
Do not attempt to try doing anything that you're warned not to do!

Remember icons alert you to important pieces of information that you don’t
want to forget.

A Technical Stuff icon indicates tidbits of advanced knowledge that might be
of interest to IT specialists but might just bore the heck out of the average
reader. Skip these at will.

Where to Go from Here

For those of you who are ACT! old-timers, you might want to at least skim the
entire contents of this book before hunkering down to read the sections that
seem the most relevant to you. My experience is that the average ACT! user
probably uses only a portion of the program and might not even be aware of
some of the really cool features of ACT!. You might be surprised to discover
all that ACT! has to offer!

For the ACT! newbie, | recommend heading straight for Part I, where you can
acquaint yourself with ACT! before moving on to other parts of the book and
the ACT! program.
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The Opening ACT!

The Sth Wave By Rich Tennant
O RITENNgy T

VYes, I know how to query information £rom
the program, but what i€ T yust want to
leak it insteadz”



In this part . . .

know that you're excited about all the possibilities

that ACT! has to offer and want to dive into the pro-
gram as soon as possible. Here’s where you find an over-
view of some of the cool features that you find in ACT!. You
also become familiar with the many faces of ACT!; after all,
you wouldn’t want to get lost along the way. But first, you
have to do a bit of homework and whip ACT! into shape
by fiddling with a few preference settings to ensure that
ACT! produces the type of results that you're looking for.




Chapter 1

An Qverview of ACT!

In This Chapter
What is ACT!?
Who uses ACT!?
Basic ACT! concepts

A few basic ground rules
The three ACT! flavors

5) what is ACT!, anyway? I find that one of the hardest things that I have
to do with ACT! is to explain exactly what it is. I like to initially explain
ACT! by using very politically correct terminology. For example, ACT! 2008

v [s a contact management software package

v Provides users and organizations with powerful tools to manage their
business relationships

v Can be customized based on your company’s requirements

v Is the world’s leading contact management software

Feel free to use these points to impress your friends. You might want to men-
tion some of the wonderful features of ACT!, which I do in the first section of
this chapter. I also describe the typical ACT! user and give you a brief primer
on some pertinent ACT! terminology. I give you a few ground rules that I've
established over the years after watching new users wrestle with certain
aspects of using ACT!. Finally, I talk about the three versions of ACT! that are
available to you.

What Does ACT! Do?

Because [ want you to enjoy the benefits of using ACT!, ['ve put together a
little shopping list of features so that you can see all that ACT! can do for you,
too. In parentheses after each item, I include a chapter reference where you
can find more information about a particular feature (if you're so inclined).
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ACT! is a multifaceted personal management tool that

v~ Stores complete contact information, including name, company,
phone numbers, mailing addresses, and e-mail addresses. (Chapter 4)

v Comes with over 50 predefined fields for each contact that you add to
your database. If you want to add additional fields to meet your specific
needs, go right ahead. (Chapter 13)

+ Records an unlimited number of dated notes for each of your contacts
so that you can easily keep track of important conversations and activ-
ities. This feature is particularly useful for those of us who (unlike our
friend, the elephant) do forget things on occasion. (Chapter 7)

1 Keeps more than a boring, old calendar. Your scheduled activities are
cross-referenced with the appropriate contact so that you have a full
record of all interactions that you've had — or will have — with that
contact. In addition, you can set an alarm to remind you of the impor-
tant stuff as well as roll over less-important things until the next day.
(Chapter 8)

v Prints out anything from simple address books and labels to detailed
reports on activities, notes, leads, and sales opportunities. You can
print reports of your reports if you feel so inclined. (Chapter 10)

1 Merges your contact information into any of the template documents
that you create. And you can send those merged documents via snail
mail, fax, or e-mail with ACT!. (Chapters 11 and 12)

v Manages your sales pipeline with built-in forecasting tools. You can
easily print a few sales reports or create a graph showing your open,
won, or lost sales (Chapter 19) or take a peak at one of the customizable
dashboards. (Chapter 9)

v~ Synchronizes data with remote users. If you have other ACT! users in
remote locations, you can exchange database changes with them.
(Chapter 17)

1 Lets you design and activate a series of activities to automate your
tasks, thus assuring that none of your contacts “fall through the
cracks.” (Chapter 8)

The Typical ACT! User

So just who is the typical ACT! user? Well, with more than 4 million registered
ACT! users and 11,000 businesses currently using ACT!, you're safe to assume
that nearly every industry is represented among its user base. Although

ACT! started primarily as a tool for salespeople wanting to follow up on their
prospects and customers, ACT! has evolved into a tool used by any individual
or business trying to organize the chaos of daily life.
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[ think it’s only fair to warn you about one of the possible side effects that
you might develop if you use ACT!. If you're anything like me, you’ll become
addicted to ACT! and eventually use it to manage all facets of your busy exis-
tence. You might just become a fanACTic. (Quite simply, a fanACTic is an ACT!
user who has become addicted to using ACT!.)

So just who is using ACT!? Everyone.
v A CEO uses ACT! because he wants to know what his salespeople are

doing and how his customers are being treated.

v An administrative assistant uses ACT! to automate routine tasks and to
keep a schedule of various tasks and activities.

v A salesperson uses ACT! to make sure that she’s following up on all her
prospects.

v A disorganized person uses ACT! to help him become more organized.

v A smart person uses ACT! because she knows that she’ll have more time
to play by working more efficiently.

v Alazy person uses ACT! because he knows it’s more fun to play than to
work.
So what kinds of businesses use ACT!? All kinds.
v~ Large businesses that want to improve communication among
employees

»* Small businesses that have to rely on a small staff to complete a
multitude of tasks

v Businesses of all sizes looking for software that can automate their
business and make them more productive in less time

v Businesses looking to grow by marketing to their prospects

1 Businesses looking to retain their current customers by providing an
excellent level of customer service and developing lasting relationships

A Few Concepts to Get You Started

Nobody likes technical jargon, but in the course of showing you how to use
ACT!,  might end up lapsing into Geek Speak and use a handful of somewhat
technical terms; I just can’t avoid it. Becoming familiar with them now is less
painful in the long run.
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First things first. ACT! is a database program. A database is a collection of
information organized in such a way that the user of the database can quickly
find desired pieces of information. Think of a database as an electronic filing
system. Although most ACT! users create a database of contacts, some users
develop ACT! databases to collect information about things other than con-
tacts. For example, you might create an ACT! database to catalog all the CDs
and DVDs in your collection.

Traditional databases are organized by fields, records, and files:

v~ Field: A field is a single piece of information. In databases, fields are the
smallest units of information. A tax form, for example, contains a number
of fields: one for your name, one for your Social Security number, one for
your income, and so on. In ACT!, you start with 50 separate fields for
each individual contact. You find out how to add information into these
fields in Chapter 4. And, in Chapter 13, [ show you how to change the
attributes of existing fields and how to add new ones to your database if
you’re the database Administrator.

v Record: A record is one complete set of fields. In ACT!, all the informa-
tion that you collect that pertains to one individual contact is a contact
record.

v~ File: A file is the entire collection of data or information. Each database
that you create in ACT! is given a unique filename. You can create more
than one file or database in ACT! — head to Chapter 3 to find out how.

The Basic ACT! Ground Rules

MBER
@&
&

Sometimes you just need to figure out things the hard way. After all, experi-
ence is the best teacher. Luckily for you, however, I've compiled a list of rules
based on a few mistakes that I see other ACT! users commit. You're not going
to find these rules written down anywhere else, and they might not even
make a whole lot of sense to you at the moment. However, as you become
more and more familiar with ACT!, these rules will make all the sense in the
world. You might even want to refer to them from time to time.

Karen’s Four Rules of Always:

v Always log in to ACT! as yourself.

v Always strive for standardization in your database by entering your data
in a consistent manner.

v Always input as much information into your database as possible.

v Always perform routine maintenance of your database at least once a
week and create a backup after any session that involves new data input!
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The Three Versions of ACT! 2008

ACT! 2008 comes in three separate editions. Everything I cover in this book
applies to all versions of ACT!, which are

v ACT! 2008: This is generally the version that one user purchases.
However, up to ten users can share a database across a network if each
user purchases his own copy of ACT! 2008.

v ACT! Premium 2008 (EX): This version contains additional contact and
field security features, so it’s generally used by larger organizations.
However, smaller organizations also use Premium to take advantage of
other Premium features, including additional ways to remotely access a
database.

v ACT! Premium 2008 (ST): This version includes all the same features as
EX but uses SQL 2005 Standard Edition — which means that you can
build a bigger database. It’s also the version of choice for those of you
with more than 30 users.

Every feature found in ACT! 2008 is also found in both versions of ACT! 2008
Premium as well. However, from time to time, [ point out a feature that is
found only in the Premium versions. You might also look at Chapter 23 for a
full list of some of the cooler ACT! 2008 Premium features.

In addition to extra workgroup type features, the three ACT! flavors use dif-
ferent versions of SQL. ACT! 2008 uses the desktop version of SQL, EX uses
SQL Express, and ST uses SQL 2005 Standard Edition.

All users sharing the same database must be using the same edition of ACT!;
this means that one user can’t be in ACT! 2008 while another is in ACT! 2008
Premium (EX). It also means that users of an older version, such as ACT! 6 or
even 2006, can’t share a database with users of an ACT! 2008 database.

So what are you waiting for? Boot up your computer, grab this book, and get
going. After all, it’s time to get your ACT! together (pun intended).
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Chapter 2
The Various Faces of ACT!

In This Chapter

Starting the correct database
Logging in correctly

Knowing about the My Record
Maneuvering in ACT!

Getting help with ACT!

A fter getting the hang of maneuvering in ACT!, you'll find that it’s an
amazingly easy program to master. The key is to become familiar with
the lay of the land before you start building your contact database. By doing
s0, you avoid playing hide-and-seek later. To that end, I show you how to log
in to and open an ACT! database. Although initially getting around in ACT! is
pretty easy, you might become lost in the maze of views and tabs that ACT! is
divided into. I help you navigate through that maze by taking you on a tour of
ACT! so that you can become familiar with the various ACT! screens. Finally,
you discover the places that you can turn to if you need additional help.

Locating the Correct Database

A\

When you open ACT!, by default, ACT! opens the database that was last open
on your computer. Easy enough, huh? If, however, you stumble into the incor-
rect database by mistake, you need to know how to find the correct one. If
you’re lucky enough to have inherited a database that someone else devel-
oped (someone who maybe even placed that database on your computer for
you), be sure to ask where that database is located — before that person
walks out of your life.

The default database location is the place on your computer that ACT! uses to
store any new databases that you create and look in to open any existing
database. If your database isn’t in the default location, you have to move
your database to the correct location, change the default location (as I dis-
cuss in Chapter 3), or browse to the location of your database.
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|
Figure 2-1:
Opening

an ACT!
database.
|

The first screen that you see when opening an ACT! database each and every
time is the Contact Detail window. If you click around and end up in any of
the other ACT! screens by accident, don’t panic. One of the nice things about
ACT! is that you can execute most commands from any ACT! screen (unless

[ tell you otherwise). And [ promise that pretty soon, the various screens
become so familiar to you that you’ll be able to navigate through ACT! with
the best of them.

To open an existing database, make sure that ACT! is open and then follow
these steps:

1. Choose File=>Open Database from the ACT! Contact Detail window.
The Open dialog box appears (as shown in Figure 2-1).
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2. Click the drop-down arrow to the right of the Look In box.
3. Double-click the folder that contains your database to expand it.
4. Click the name of your database and then click Open.

If you prefer, double-click the name of the database that you want to

open.

When you open an ACT! database, you actually use a shortcut; these short-
cuts all end with the . pad file extension. Every ACT! database actually stores
three different groups of data:
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+ Main database: The main database consists of all your contacts’ infor-
mation, activities, notes, histories, and so on. The database files are
stored on your local machine by default. You can move the database and
all associated files to another location or even over to a network drive if
you so desire. This information is stored in the .adf and .alf files.

1 Database supplemental files: These files and folders are created auto-
matically when you create a new database and include layouts, tem-
plates, e-mail messages, and any attachments associated with a contact
record. You can’t change the location of these files in the database;
they’re automatically stored as part of your database.

* Personal supplemental files: These files, which are saved to your local
computer, include files, such as word processing documents not associ-
ated with a contact, newly created layouts, and templates. E-mail mes-
sages and attachments associated with contacts are also saved as
personal supplemental files.

The ACT! Login Screen

|
Figure 2-2:
Logging on
to ACT!.
|

If more than one person shares your ACT! database, ACT! presents you with a
login screen each time you attempt to open your database. If you're the only
person using a database, the login screen doesn’t appear. Essentially, the
login screen (as shown in Figure 2-2) asks you for your user name and your
password. Your user name isn’t case sensitive (that is, you can enter your
name by typing either lowercase or UPPERCASE letters) but your password
is. You also need to make sure that you correctly enter your user name and
password information. For example, if your user name includes your middle
initial with a period, you must type that middle initial — including the

period — to gain access to your database.

Log on to ACT10Demo

Enter your user name for this database:

Karen Fredricks

Enter vour password for this database:

[1Remember password

Cancel

17
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Generally, the Administrator of your database determines your password.
The database Administrator is the person responsible for making major
changes to the database and for performing routine database maintenance.
(For more information, see Chapter 16.) Although several users may all have
access to an ACT! database, ACT! doesn’t require that each user have a pass-
word. If the database Administrator didn’t assign you a password, leave the
password area blank.

If you're assigned a password, notice that dots appear while you type it in.
That’s normal. Just like when you type your ATM card PIN, your ACT! data-
base password is hidden while you type it to prevent any lurking spies from
discovering your password. You can change your own password; see Chap-
ter 3 to find out how.

Figure 2-2 shows that ACT! gives you the option of saving your password.
Although this option helps you to log on to your database a little faster in the
future, think about making this decision. First of all, what good is a password
if it always magically appears anytime that you attempt to access your data-
base? Secondly, by having ACT! remember your password, you may eventu-
ally forget it yourself!

The Importance of Being My Record

The first contact that you see when opening an ACT! database is your own —
that’s your My Record. My Record is nothing more than a contact record
that’s associated with a user of the database. Your My Record stores all your
own information, which automatically appears in some of the preset tem-
plates that come with ACT!. For example, a fax cover sheet includes your tele-
phone and fax numbers; a report has your name at the top; and a letter has
your name at the bottom.

If someone else’s information appears as the first contact record that you see
when you open your database, explore these three possibilities:

+ Did you log in as yourself? If not, do so. Then when you open ACT!
again — logged in as yourself — your My Record appears.

v+ Did you inadvertently change your own contact information? If that’s
the case, change it back.

v If you’re 100 percent certain that you logged in as yourself and
haven’t changed your contact information, your database is likely
corrupted. I'm not trying to scare you, but [ recommend that you turn
to Chapter 15, where I show you how to perform a little CPR on your
database.
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Taking the time to enter all your own contact information is very important. If
you don’t, you might find that you're missing key information when you start
to work with templates and reports. For example, if you never enter your own
fax number, your fax number doesn’t appear on the Fax Cover Sheet tem-
plate, which means you have to fill it in every time that you send a fax. Save
yourself the trouble and fill in your My Record right off the bat.

Your My Record also allows you to use a few other important ACT! features:
v Permission to perform various functions is based on the security level of

your My Record.

v Contacts, notes, histories, activities, and opportunities marked as
Private can be viewed only by the Record Manager who created them.

v Every time you enter a new contact, group, company, or opportunity,
your name appears as the creator of that contact.

1 When you delete a contact, a history of that deletion appears in the
History area of your My Record.

v Every time that you add a note to a contact record, your name appears
as the Record Manager of that note.

v When you schedule an activity, your name automatically attaches to that
activity.

Finding Your Way around in ACT!

The purpose of this book is to serve as a reference for both new and existing
ACT! users. I certainly don’t want to lose anyone along the way. New ACT!
users might be somewhat intimidated when they encounter ACT! for the first
time. Be assured that this experience is akin to the first time you drive a new
car at night in the rain — momentary panic sets in. After you’ve driven the
car for a week or so, the location of the light and windshield wiper controls
becomes second nature. I guarantee you’ll have the same experience

with ACT!.

Navigating through ACT! is fairly easy. However, to make the navigating even

easier, I highlight throughout this section a number of pitfalls that you want
to avoid.

The title bar

The title bar at the top of the screen provides you with two pieces of key
information: the software name and the database name.

19
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|
Figure 2-3:
The opening
ACT!
screen.
|

Don’t overlook the importance of this wealth of information! If your title bar
reads FreeCell, you've stumbled into the wrong piece of software. If the
database name indicates ACTdemo, chances are pretty good that you're in the
wrong database and could be adding hundreds of new contacts to the wrong
place. And if the user name isn’t yours, you might not be getting the appropri-
ate credit for all your hours of hard work. You can see the title bar, along with
other key areas of ACT!, in Figure 2-3.
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The record counter

ACT! supplies you with a record counter in the top-left corner of the Contact
Detail window (as shown in Figure 2-3). The first number indicates the
number of your record as it relates alphabetically to the other members of
your current lookup. A lookup refers to the contacts in your database that
you’re currently working with. (You can find out everything that you’ll ever
want to know about a lookup in Chapter 6.) This number changes when you
add or remove contacts. The second number supplies you with the total
number of contacts in either your entire database or your current lookup.
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To the left and right of the record counter is a set of left- and right-pointing
triangles. You can click these triangles to navigate through the contact
records. For instance, to go to the previous record, you simply click the left-
pointing triangle.

I recommend getting into the habit of checking the total number of contacts
in your database each time that you open ACT!. If the total number of con-
tacts changes radically from one day to the next, you just might be in the
wrong database. Worse yet, a dramatic change in the number of contacts
might indicate corruption in your database.

The layout

One of the biggest sources of confusion to the new ACT! user is the use of lay-
outs. The layout refers to the order in which fields appear on the ACT!
screens as well as the colors, fonts, and graphics that you see. You can spec-
ify the colors, fonts, and graphics in the layout as well as the position and
order of fields. If the database Administrator creates new fields for the data-
base, he needs to add them to a layout. In Chapter 14, I explain how you can
create your own customized layouts in one of the following ways:

v Modify the contact, company, and group layouts or create your own
layouts to suit your needs.

There’s no right or wrong layout — only the layout that you prefer. For
example, maybe the Sales Department needs to see one set of fields, but
the Customer Service Department needs to see an entirely different
group of fields and wants them to appear in a specific order.

+ Remove fields that you don’t use or move fields to other tabs.
1 Add fields to your layout.

+ Change the order of the tabs.

v Add your own tabs to the bottom of a layout.

Renaming and reordering the tabs to your liking helps you organize your
fields. For example, you might want to keep all the personal information
about a customer on one tab and the products that he’s interested in on
another tab.

You can find the name of the layout by clicking the Layout button in the
lower-left corner of the ACT! screen, as shown in Figure 2-3. If you inadver-
tently switch layouts, you might not be able to see all the information in your
database, or you might see your information arranged in a different order. At
this point, panic often sets in. Don’t worry — your data is most probably

21
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|
Figure 2-4:
Getting the
most out

of ACT!
menus.
|

alive and well and viewable with the help of the correct layout. To switch lay-
outs, click the Layout button to access a list of all layouts; from that list,
choose a different layout.

Make sure that you take the time to acquaint yourself with the name of the
layout that you’re using. You might find yourself the victim of one of those
random, drive-by clickings you’'ve been hearing so much about and end up in
the wrong layout. If you know the name of your preferred layout, you can
easily find it.

The menu bar

Like most software programs, ACT! comes equipped with a menu bar that
appears at the top of every ACT! screen. These menus include all the options
available for the current view. You can customize all menus to fit your needs;
check out Chapter 3 for the details.

A quick way to familiarize yourself with ACT! is to click each and every one of
the menu items. You might see something that piques your interest. You might
click the Schedule menu and notice the Activity Series option. Hopefully,
curiosity overcomes you, and you have an overwhelming desire to find out
more about that feature. Or you might notice the Sort choice listed in the Edit
menu and think hmmm, maybe I can sort my database in a different order
than alphabetically by company.

Many times, you'll find that you can accomplish a task in a variety of ways. If
you’re a keyboard shortcut aficionado, you'll find the most frequently used
shortcuts in the front cover of this book. You can also glean these shortcuts
from the menus. In Figure 2-4, you see that the shortcut appears to the right
of each menu item. In addition, notice that an icon appears to the left of some
of the menu items; this means that you’ll find that corresponding icon some-
where on the icon bar if you prefer to click instead of using the menus or key-
board shortcuts.
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The toolbar

ACT! also features a toolbar at the top of each window. The toolbar includes the
most-commonly used tasks of the current view. Toolbars work much the same
way as the menu bars. You can customize each toolbar to include the tasks
that you use most frequently; see how in Chapter 3. And, like the menu bars,
toolbars vary depending on the view that you're in. For example, the toolbars
that you see in the calendar views include a Show Filter/Hide Filter icon to
change the view settings on your calendar, and the toolbar that you see in the
Group Detail window includes icons for creating groups and subgroups.

The Back and Forward bar

Lurking just below the toolbar is the Back and Forward bar, which provides
you with a road map of sorts by letting you know the exact area of ACT!
you’re working in. And, like your Internet browser, the Back and Forward bar
has handy-dandy left- and right-pointing arrows that allow you to return to
the previous window you were viewing.

The Contact Detail window

When you first open ACT!, you land in the Contact Detail window, which
allows you to see information about one specific contact. You can use the
Contact Detail window to enter, modify, and view information about your
contacts. Each contact record displays as a single page that’s divided into a
top and bottom half:

v~ The top half of the screen contains generic fields, such as name, busi-
ness address, and phone number, that are probably used by just about
all ACT! users everywhere. Many of these fields are used extensively in
the templates (that is, reports, letters, fax cover sheets, and labels) that
ACT! has already set up for you.

v~ The tabs at the bottom provide additional fields for each of your con-
tacts. These are generally the fields that you don’t use as much, such as
home address and spouse’s name.

You can — and should — customize the bottom half of the screen to
better serve the needs of your business. You can click through the page
tabs in the middle of the screen to get an idea of some of the fields sug-
gested by ACT!. You can customize the top half of the screen as well if
you so desire. [ show you how to add new fields into your database in
Chapter 13 and how to modify those tabs in Chapter 14.
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The Divider bar

One of the fast food chains used to have a jingle about “having it your way” a
number of years back, and you might want to hum a few bars of that tune
each time you open ACT!. A case in point is the Divider bar that separates the
top half of the Contact Detail window containing the fields from the bottom
half containing the tabs. Got a lot of fields in the top half of your screen? Grab
the Divider bar and drag it down. Want to have more room to view some of
the tabs along the bottom? Grab that bar and drag it up a bit.

The Navigation bar

The ACT! Navigation — or Nav — bar is the column of icons located along the
left side of the program. The Nav bar allows you to move quickly between the
various areas in ACT!. For example, to view all the information about one par-
ticular contact, click the Contacts icon; to see a list of all your groups, click
the Groups icon.

The ACT! tabs

Because ACT! comes with approximately 50 predefined fields — and because
your database Administrator might add another 50 or so customized fields —
placing those fields where you can see them clearly is important. Plunking
100 fields on one half of your screen gives you a jumbled mess. | suppose that
you could lay out those fields by using a smaller font, but the result (although
neat) is impossible to read!

ACT! solves this dilemma in a rather unique fashion. The top half of the
Contact Detail window displays the most basic fields that are fairly typical to
all contacts. In this portion of the screen, the fields include places for the
name, address, and phone numbers as well as a few miscellaneous fields. The
bottom half of the ACT! screen displays additional information about your
contact that’s divided into categories, which you access by clicking tabs
located across the middle of the Contact Detail window.

The first seven tabs (refer to Figure 2-3) — Notes, History, Activities,
Opportunities, Groups/Companies, Secondary Contacts, and Documents —
are system tabs. The system tabs are actually fables, they don’t hold single
fields with a single piece of information in each one. Rather, you can add an
unlimited number of like items to the same tab. For example, you can add
multiple notes about your contact via the Notes tab, or you might have
numerous sales opportunities that involve your current contact displayed on
the Opportunities tab.
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Because the system tabs contain tables rather than fields, you can’t cus-
tomize them in the same way as the other tabs. However, you can remove
system tabs or change their order. Chapter 14 shows you how to fix the
order.

Depending on the layout you’re using, you probably see several additional
tabs after the system tabs. These tabs generally display less frequently used
information about your contact. You generally find ten user fields on one of
those tabs; you can find out how to customize the user fields in Chapter 13
and the layouts in Chapter 14.

Vg\“\NG! Do not proceed to add new information in the user fields without first renam-
S ing them. Many new ACT! users make this mistake and end up with an unruly
assortment of information in each of these fields. Worse yet, other users of
your database might misinterpret this information — or start entering their
égN\BEIi' own data — further complicating the whole mess.
©
&
All the tabs are dependent on the layout that you're currently using. If you
switch layouts, your tabs change as well.
\\3 Some of the ACT! add-on products place new tabs to your ACT! screen. For

example, the ACT! QuickBooks link draws information from QuickBooks and
plops it into a brand new tab called QuickBooks.

Getting Help When You Need It

In addition to the information that I provide in this book, ACT! 2008 comes
with a very good — and quite extensive — online Help system that supplies
step-by-step instructions for just about any ACT! feature that you might want
to explore.

You can access the ACT! online Help system in one of two ways when ACT! is
open:

v Press the F1 key on your keyboard.

v Choose Help from any ACT! menu bar.
When you access the ACT! Help menu, you’re treated to several options. All

these Help options provide a wealth of information, and you shouldn’t be
afraid to use them.
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v~ Help Topics: This option supplies you with lots of information based on
the window that’s open. Use this option when you find yourself scratch-
ing your head about something, and you’ll probably be rewarded with
just the answer you're looking for.

v How to Use Help: This area of Help provides you with the most informa-
tion. In fact, you can find so much good information that this section is
further subdivided into three tabbed areas:

e Contents: Think of the Contents tab as the Table of Contents in a
book. The Contents tab presents you with the major topics cov-
ered in ACT!. Click the plus sign next to each topic to find a more
detailed listing of the subject.

¢ Index: As its name implies, the Index tab is just like the index that
you find at the back of this book. It provides you with an alphabeti-
cal listing of every feature found in ACT!. You can either scroll
through the list of features or type in the first few letters of the fea-
ture that you're looking for.

e Search: The Search tab provides you with the most in-depth infor-
mation about the various ACT! features. This feature is particularly
helpful if you aren’t sure of the exact name of the feature that
you're trying to find. For example, say you're looking for instruc-
tions on how to force a field to display only capital letters. A
search of the Index tab doesn’t help you (the feature is actually
called Initial Capitalization), but you can find the information by
typing capital in the Search tab. Figure 2-5 gives you an idea of all
the help you can find in the ACT! Help menu.

Help
@ Help Topics
@ How To Use Help
EEE— Feature Tours 3
. Online Manuals v
Flgl!re 25 Getting Started Wizard...
Usingthe | acrupdate..
ACT! He|p Service and Support b
menu. Register ACT!...
E—— About ACT!

v~ Feature Tours: We all learn in our own way, and the Feature Tours are
designed for those of us who want someone to take us by the hand and
walk us through a few of the more complex ACT! features, such as
installing handheld link software or integrating to Outlook. When you
open one of the tours, you're treated to ACT! screenshots walking you
through a process. All the relevant icons and buttons have been labeled
so that you get a real understanding of how the process works.
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v Online Manuals: ACT! comes with three nifty PDF files. One is a Quick
Reference card that you can print to help you with the most common of
ACT! features. The other two are documents that you can refer to — or
print — when you need extra help.

v Getting Started Wizard: In your zealous haste to start working with
ACT!, you might choose to ignore the wizard that pops up immediately
after you first fire up ACT!. The Getting Started Wizard ensures that your
word processor and e-mail preferences are set correctly and helps you
to either convert an existing database or create a new one.

v ACT! Update: As much as you might want to think that the software you
purchase is perfect in every way, it’s not. Very often, users like you dis-
cover bugs, or little errors in the software. Sometimes, major changes,
such as the release of a new operating system, can cause your software
to exhibit some bad behavior. An update patch generally corrects these
problems. The ACT! update ensures that you have the latest and great-
est release of ACT!; best of all, there’s no charge for this service!

v Service and Support: Ever wonder how to find help when you really
need it? Three great options here can provide a bit of extra handholding:

e ACT! Service and Support: Takes you to a Web page containing the
various support options offered by Sage Software.

e Contact information: Takes you to a Web link that contains the
most-commonly used phone numbers for Sage Software.

¢ Knowledge Base: Includes articles written by ACT! tech support
about commonly asked questions and procedures.

¢ ACT! Consulting: Your best source of help for ACT! is an ACT!
Certified Consultant (ACC). ACCs earn their livelihood by working
with people like you. They're certified ACT! fanACTics who spend a
great portion of their day working with any and all things ACT!.
They can help you with anything from converting to ACT! from
another program and customizing your database to training your
employees. Most ACCs even make house calls. Clicking the ACT!
Consulting option takes you for a field trip out to an Internet site
that contains a listing of all local ACT! consultants.
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Chapter 3

Getting Your ACT! Together

In This Chapter

Creating a new database

Changing the ACT! preferences

Customizing your toolbars and menus

Icould easily have titled this chapter “Have It Your Way” because here’s
where I show you how to set up a new database. You discover some of the
preference settings that you can change in ACT!. If you’re sharing your data-
base across a network, you’ll read about the preferences that are specific to a
network. Finally, if you're a real power-user, you’ll be excited to know how to
change your menus and toolbars.

Creating a New ACT! Database

CMBER

If your initial meeting with ACT! entailed looking at the ACTDemo database
that comes with ACT!, you know that it’s a great demo database to use for
learning purposes before actually starting to work on your own database.
After playing with the demo for only a short time, you're probably eager to
start working on your very own database. The easiest way to create your first
database is by using the Getting Started Wizard. In addition to setting you up
with a new database, the wizard helps you to set a few of the most basic pref-
erences needed for ACT! to work correctly.

The Getting Started Wizard opens automatically when you first install ACT!.

Follow these steps to set up your new ACT! database with the Getting Started
Wizard:
1. From any ACT! screen, choose Help=>Getting Started Wizard.
The first of the five Getting Started Wizard screens appears.

At this point, feel free to put your feet up on the desk, answer a few
questions, and let ACT! do the grunt work for you.
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2. On the wizard’s introductory screen, click Next to get started.

Quick as a flash, the Getting Started Wizard - Word Processor screen
appears. Here’s where you get to choose your word processor. It’s an
either/or proposition; you have only two choices (see the next step).

. Choose Microsoft Word (if Word is installed on your computer); other-

wise, choose the ACT! word processor.

Chapter 11 explains how to create a mail merge. If you're using Word,
you’ll want to use this as your preference because you’re already famil-
iar with most of its features.

. Click Next.

In the next screen, you get to tell ACT! which e-mail client you're using.
(For information on determining which e-mail client you need to be
using, scurry over to Chapter 12.)

. Select the e-mail program of your choice and then click Next.

Your choices are based on the e-mail clients that ACT! detects on your
system; for example, if you’re currently using Outlook you see Outlook
listed as one of the choices. If you want, you can even tell ACT! that you
prefer to skip the e-mail setup for now. You can read more about setting
up your e-mail in Chapter 12.

By now, I'm sure you realize running a wizard means clicking the Next
button a lot. Smart reader! However, the next step in the wizard gets a
wee bit more challenging because you have to decide whether to create
a new database, convert an existing database from a prior version of
ACT! into ACT! 2008 format, or just skip the database setup. I make the
assumption that you're setting up a brand-new ACT! database; that’s the
direction the steps take.

. (Optional) Indicate whether you want to use the ACT! or Outlook

e-mail program.

If you select Outlook as your e-mail program, you can choose to use the
ACT! e-mail client or have Outlook open when sending an e-mail in ACT!.
Either option results in the transmitted e-mail appearing in Outlook’s
Sent Folder, and new e-mail appearing in Outlook’s Inbox.

. Select Set Up Database Now and then click Next.

In this step of the Getting Started Wizard, you get to make a couple of
decisions about the future of your database, as you can see in Figure 3-1.

e Database Name: You might want to give the database a really cool
moniker, such as the name of your company so that you can easily
identify it later.
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ACT! Premium Getting Started Wizard (7 of 8)
New Database

Before you can begin entering contacts, activities, or oppartunities, you will need to

create an ACT! database and specify where it will be stored.

D atabase name [no spaces, puncluation, must begin with a letter].

ACT_Far_Dummies

Lacation:

CACT Data

Share this database with other users
User name:
Karen Fredricks

| Password [Optional):
Figure 3-1:
Setting up a
new ACT!
database.
|

Confirm Password:

\P
) The name of your database can’t include spaces or punctuation marks.

However, you can use an underscore and capital letters. For example,
consider naming your database My_Company rather than Mycompany.

e Location: By default, the database is saved to the default database
folder. Unless you change that preference, the default location is
C:\My Documents\ACT\ACT for Windows 9\Databases.

e Share This Database with Other Users: Check this box if you want to

share this database with other network users.
“&N\BER
& Although all versions of ACT! can be shared on a network, you

must purchase a separate licensed copy of ACT! for each user who
will be accessing the database.

User Name: The person setting up the database is also one of the
database Administrators. Keeping this in mind, indicate the name
of the database Administrator.

¢ Password: The good news is that when you type your password,
each character appears onscreen as a dot just in case someone is
lurking over your shoulder trying to nab your password. The bad
news is that because you can’t see what you're typing, you might
just type something you didn’t intend to. ACT! demands that you
retype your password to ensure that you didn’t misspeak the first

time.
\

An ACT! database doesn’t require a password. It’s better to leave
the password blank than to add one — and forget what it is!
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8. Fill in the appropriate information and then click Next.

The final screen of the Getting Started Wizard appears, recapping all the
important decisions that you just made about your new database. If you
make a mistake or simply change your mind, now’s the time to click the
Back button and fix things!

9. Double-check your answers carefully, make the appropriate changes
(if any), and then click Finish.

The newly created database opens.
When you’re ready to add contacts to the database, head to Chapter 4.

You don’t need to use the wizard every time you want to create a new, blank
database. If you already set your preferences (see the upcoming section,
“Giving ACT! the Preferential Treatment”), you can create a new, blank data-
base by simply doing the following:

1. Choose File=>"New Database from any of the ACT! views.

The New Database dialog box appears. By coincidence, it is identical
to the New Database screen of the Getting Started Wizard (refer to
Figure 3-1).

2. Fill in the database name, location, user name, indicate whether
the database will be shared, and (optionally) add a password; then
click OK.

Your currently opened database closes, and the newly created database
opens.

Working with Passwords

If you're the only user using your ACT! database, security might not be an
important issue for you. When you start ACT!, it will not prompt you for a
user name and password. But if you're like most people, you probably prefer
not to share every tidbit of information in your database with anyone who
wanders into your office. Whether you want to prevent certain personnel
from changing the basic field structure of your database or adapt a look-but-
don’t-touch attitude with the computer-challenged among your employees,
ACT! has a variety of security methods that can help you accomplish your
security goals. You can choose one of the following:
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v~ Assign a specific security level to each user; [ show you how to do that
in Chapter 16.

v Purchase ACT! Premium 2008 and determine which contacts and
fields any one user can access; you can read about ACT!’s Contact
Access feature in Chapter 16.

v~ Password-protect your database; | discuss this option throughout the
rest of this section.

Setting a password

Both the database Administrator and the individual database user can set a
password for the user. The theory for this is that the individual can pick a
password that has some meaning to him — and so, hopefully, he doesn’t
forget it. If a user does forget his password, however, the Administrator can
reset it; you can see how to do that in Chapter 16.

If you have access to a database and are afraid that some nasty person might
use your name to gain access illegally, | recommend assigning a password to
yourself, which is ridiculously easy. Here’s what you do:

1. From any of the ACT! screens, choose File=>Set Password.

The Set Password dialog box appears, as shown in Figure 3-2.

Set Password

Current Passward:

........

Paszeward Policy Requirements

There are no password limitations on this database.

Caniel

33
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2. Leave the Current Password text box empty.

3. Type your new password in the New Password text box. Then for
added excitement, type it once more in the Confirm New Password
text box.

You'll notice that the Set Password dialog box also indicates the pass-
word policy that has been set by your Administrator.

4. Click OK.

Changing a password

After you add a password to your database or if multiple users access your
database, you're prompted to supply your user name and password each
time you try to open your ACT! database.

From time to time, you might want to change your password. Perhaps you
feel that a former employee compromised your security (or maybe you've
just been watching too many James Bond movies). Whatever the case, you
can follow these steps to create a new, improved password:

1. From any ACT! screen, choose File~>Set Password.
2. Enter your old password in the Current Password text box.

3. Type your new password in the New Password text box. Then for
added excitement, type it once more in the Confirm New Password
text box.

4. Click OK.

Sometimes the unthinkable happens, and you can’t log in to the database no
matter what password you try. At this point, you might have to bribe the
database Administrator into resetting your password. I find that chocolate
chip cookies work the best, but feel free to pick the bribe of your choice.
Then make sure the Administrator follows these steps:

1. Choose Tools=>Manage Users from any ACT! view.

If you're going through this chapter section by section, you already
know that you can do this from within any of the ACT! screens. [ don’t
mean to sound like a broken record here; I just want you to get used to
the idea.

The Manage Users dialog box opens.
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2. Double-click the name of the user for which you want to change the
password.

You can’t reset the password for the currently logged in user. If you need
to reset the password for an Administrator, you need to log in as a differ-
ent Administrator to do so. And, should the database only have one
Administrator — and he or she forgets the password — you need to
send the database to Sage Software to ascertain the password.

3. Enter the new password in the New Password text box.
4. Enter the new password again in the Confirm New Password text box.
5. Click OK.

You might not know your password because you don’t have one. So, before
tracking down your Administrator with that plate of cookies, try leaving the
password field blank. (I frequently get phone calls and e-mails from ACT!
users who have no idea what password is assigned to them. Guess what?
They often don’t have one!)

Giving ACT! the Preferential Treatment

After you install ACT! on your computer, becoming familiar with various pref-
erences is a good practice. If you're the sole user of the database, these set-
tings will likely save your sanity. If you share the database with other users,
these settings can probably save you all a lot of head scratching.

If you create your original database by using the Getting Started Wizard,
some of your preferences are already set. However, reviewing your work
never hurts! Your preference settings is the place to turn to if you're the kind
of person who likes to have things your own way. You might routinely store
all your documents in a specific location and want ACT! to follow that same
example. Or you might have a fondness for fuchsia and orange and want to
have your ACT! screens coordinate with this color scheme.

Here’s how to change several of the most basic preference settings. Feel free
to flip through the various preference tabs to get an idea about additional
preference settings that you might also want to tweak. You can find the ACT!
Preferences dialog box by choosing Tools=>Preferences. The Preferences
dialog box is arranged into six tabs, each of which I discuss in the following
sections.
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General

As the name implies, you find an assortment of preferences on the General
tab. General preferences allow you to specify settings for your database, such
as how names and salutations display on your contact records, whether
checking for duplicate records is enabled or disabled, and where files associ-
ated with your database are stored. ACT! automatically stores your database
in the My Documents folder. Your database contains all your basic contact
information as well as supplemental files, such as layouts, templates, and
saved e-mail messages. In addition, you might want to have your own set of
personal supplemental files; this area is where you can tell ACT! where you
prefer to have them saved.

A few of the preference settings might not be available to you if you're not the
database Administrator; for example, you can’t change the history or dupli-
cate checking options that appear on the General tab of the ACT! preferences.

Colors & Fonts

You can set the colors and fonts for almost any area of ACT!, including all
list views, tabs, and calendars. However, there isn’t a global color setting;
you must set the colors and fonts for each item separately in the Colors &
Fonts tab.

You might want to make sure that the colors you pick for the text and back-
ground colors result in a legible combination. For example, choosing black
text with a black background wouldn’t be a great idea, nor would the combi-
nation of a yellow font on a white background.

Calendar & Scheduling

The Calendar & Scheduling tab allows you to change the way your calendars
look and to determine the default for scheduling activities.

When you click the Calendar Preferences button, you can set the days of the
week that you want to appear on your work week calendar, the minute inter-
vals for your daily and work week calendars, and various calendar options,
such as whether you want to see pop-ups when you hold your mouse cursor
over a scheduled activity.
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When you click the Scheduling Preferences button, you can set options for
each activity type, but you must set the options one activity type at a time.
The options you can include for each activity type include the default activity
priority level, the interval of time before the activity you want the Ring Alarm
to sound, and the default duration for each activity type.

E-mail

Exactly as advertised, the E-mail preference tab is the area where you tell
ACT! exactly how you want to handle your e-mail. The preferences you might
want to set include the e-mail system you want to use with ACT! (Microsoft
Outlook, Outlook Express, Lotus Notes, or Internet Mail), composing options
(including signatures), how often you want ACT! to notify you about newly
received messages, and how you want to handle attachments that you
receive.

Communication

The Communication tab lets you choose your word processor and fax prefer-
ences, including your default word processing and fax software, spell check-
ing options, and Dialer options. (Use Dialer options if you want ACT! to
automatically dial an outgoing number and record the length of the phone
call) You'll also find the Quick Print header and footer options that are used
when printing any of the ACT! lists, including Company, Group, Opportunity,
Contact, Notes, History, Activity, and Secondary Contacts.

Although the Dialer feature can be a great timesaver, you must have the
appropriate hardware installed in order to use it. Quite simply, dialing
requires that your computer can access a dial tone. This can be accom-
plished through the use of a dialup phone modem or a telephone system
equipped with Telephone Application Programming Interface (TAPI) hard-
ware and the appropriate telephone driver software.

Startup

The Startup options dictate both the default settings for each new contact

added to your database and how ACT! starts up every time you run the pro-
gram. The Startup tab preferences includes the Record Creation settings that
set the default to Public, Private, or Limited for each new contact, company,
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group, and opportunity that you add to the database as well as whether you
want to automatically link each new contact to his company record and
record a history of the event. You can also specify whether you want ACT! to
open in the Contact Detail, Contact List, or Dashboard view and which data-
base you want ACT! to open automatically each time you run ACT!. You're
even given the option to automatically check for new ACT! updates.

Administrators of a shared database want to deselect the Automatically
Check for Updates option. Applying updates, which I discuss in Chapter 15,
should always be initiated first on the server by the database Administrator
and then on the local workstations. The automatic update option presents
users with an enticing invitation to initiate an update. This can lead to prema-
ture baldness of the Administrator.

Customizing the Navigation Bar

\\3

One of the things you might find the most endearing about ACT! is your
ability to mold the program to how it feels the most comfortable to you.
You might decide that for whatever reason, you don’t like the look of the
Navigation (Nav) bar (those big icons that run down the left side of ACT!, as
shown in Figure 3-3).

To customize the Nav bar and “have it your way,” all you have to do is right-
click it and then pick your poison, er, menu options from the right-click menu
that appears. Note the menu that appears is divided into sections. The first
section determines the size of the Nav bar icons. The second section pro-
vides you with several preset menu options. Feel free to click the various
combinations until you feel comfortable with the Nav bar.

If you're still not happy with the look and feel of the Nav bar, feel free to
choose the Customize option. A little window opens magically that allows
you to drag additional icons to the Nav bar — or get rid of the ones you don’t
want.

The calendar icon is an example of a Nav bar icon that you might want to
replace. By default, clicking it brings you to the daily calendar. That’s fine if
that’s the calendar you’re most comfortable using. However, many of you
might prefer to use the weekly — or work week — calendar instead. If that’s
the case, customize the Nav bar by dragging away the calendar icon and
replacing it with the calendar item of your choice.
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Modifying the Icon Bar

Customizing the various ACT! menus and toolbars to include functions that
you use on a regular basis is a great way to improve your efficiency. Changing
your toolbar literally allows you to perform various functions at the click of a
button.

Adding items to the toolbar

One thing you might find a little unique in ACT! is the variety of toolbars that
you encounter along the way. You see one toolbar while working in the
Contact Detail window but a different toolbar when you foray into the Group
Detail window. That said, realize that an icon you add to one of your toolbars
doesn’t appear on another. That’s okay because adding icons to any one of
the ACT! toolbars is easy.
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Figure 3-4:
Customize
an ACT!
toolbar
here.
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I encourage you to do a little homework before tackling the toolbar. Don’t
worry, the assignment is fairly simple; you need to decide in advance which
icon you want to add as well as which menu it’s located on. Although this
step isn’t critical, it saves you from floundering around later. After doing your
homework, follow these steps to add an icon to any toolbar:

1. From any of the ACT! screens, choose Tools=>Customize->Menus and
Toolbars.

For the right-clickers in the audience, you can also give the toolbar a
click with the right button of your mouse and choose Customize.

2. Click the Commands tab in the Customize Menus and Toolbars dialog
box (see Figure 3-4).

Customize Menus and Toolbars

Menus are active while this dialog box is open. Drag-and-diop to change
position or right-click a menu item for more options.

TUDIbals_ Commands Upllyps_ K_eybqald Eu_stum_;ummands_

Categaries: Commands:

CalerdaToolbar | Copy/Move Contact Dat.. %)
Caompanies

Contact Detail Toolb Outlook Activities »
Contacts

Custom Commands Synchianize L

El‘ﬁ: Accept Incoming Syncs

Groups @ Spnchronize Maw

Hel

Luuiup Tools »
Opportunity List Tool Conwert ACTI 30 - 601

Reports =

Schedule LCustomize [3
Tools

Vi [ Menus and Taolhars [

Close

3. Select the name of the menu that contains the command that you want
to add to your toolbar.

If you did your homework, pat yourself on the back. If you didn’t, have
fun flipping through all the choices in the Categories list and scrolling
through all the corresponding commands until you stumble upon the
item that you want to add to the toolbar. I hate to be an “I told you so,”
but. ...

4. Drag the desired command to the toolbar.

As you drag the command to the toolbar, a black line materializes that
indicates exactly where the icon is going to appear.

5. Click the Close button on the Customize Menus and Toolbars dialog
box.
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Tweaking the toolbar icons

I'm almost embarrassed to tell you how easily you can further customize the
icons on your toolbars. But, because you're such a good person, | am going
to tell you. You might store this information away for future reference and use
it to impress your friends some time in the near future. To customize a tool-
bar icon

1. Right-click the toolbar and choose Customize (see Figure 3-5).

Task List Toolbar
Contact List Toolbar
CalendarToolbar
Group List Toolbar
| Dashboard
Figure 3-5: Company List Toolbar
.. Company Detail Toolbar
CUStomIng Opportunity List Toolbar
the ACT' Group Detail Toolbar
toolbars. |~ Contact Detail Toolbar

— Customize -

By the way, notice that you can switch toolbars here if you so desire.
Click another toolbar name and you’re the proud owner of another
toolbar.

2. Drag any icon you want to another spot on the toolbar.
Now’s your chance.

3. Right-click the icon that you want to modify.

4. Chose the modification items of your choice.

e Reset All: Resets all your toolbar and menu customization to the
original value

e Delete: Deletes the currently selected icon
e Name: Allows you to rename the icon’s ToolTip

e Default Style: Shows just an icon on the toolbar without including
any text

e Text Only: Shows only a text command on the toolbar without the
icon
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¢ Image and Text: Shows both an icon and text command on the
toolbar

® Begin Group: Places a light vertical bar to the left of the icon to
allow grouping of similar icons

5. Click the Close button on the Customize Menus and Toolbars
dialog box.

Monkeying with the Menus

After you master the icon bar, customizing the menus will seem like a piece of
cake. Most of the techniques that I mention here will sound eerily familiar
because you modify your menus in pretty much the same way as you do your
icon bar.

Ordering additional menu items
For your first feat, add some new goodies to your menus as follows:

1. Right-click the toolbar and choose Customize.

If you feel a slight sense of déja vy, it’s because you're treading on very
familiar territory.

2. Click the Commands tab of the Customize Menus and Toolbars
dialog box.

3. Select the name of the menu that contains the command you want to
add to your toolbar menu.

4. Drag the desired command up to the menu that you want to modify.

This is where you do things slightly differently than you did with the
icon bar (see the preceding section). When you drag the command to
the menus, they pop open. Resist the temptation to let go of your mouse
button! If you linger your mouse on any of the sub-menu items, they pop
open for you as well. When you arrive at your scheduled destination, a
black line materializes that indicates exactly where the item is going to
appear.

5. Let go of your mouse button.

I'll bet you thought [ was never going to say that! If your finger feels
numb, that’s okay — the reward of having your new items appear on
your menus is certainly worth any pain you might have encountered.
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6. Drag any menu item you want to another menu.

You'll probably find that ACT!’s menus seem pretty logical, but as they
say — different strokes for different folks. If you decide that Preferences
should be located on the Edit menu or that the Backup command should
really be listed on the Tools menu, go for it. Hover your mouse over the
menu with the target item; when the menu pops open, drag it to the
correct spot on the new menu.

7. Click the Close button on the Customize Menus and Toolbars
dialog box.

Adding a custom command

Normally I shudder when someone asks me whether they can perform a task
“with the click of a button.” As you can see throughout this book, most
processes take a couple of clicks. You can create custom commands to make
ACT! run one of your favorite software programs or some of your customized
reports and templates; however, it does require more than a click or two.
Want to open Excel from ACT! with the click of a button? Add it to one of your
ACT! menus or toolbars. Have you created some templates that you use
repeatedly? You might want to think about adding those goodies to the Write
menu. To add a custom command

1. Right-click the toolbar and choose Customize.

2. Click the Custom Commands tab (as shown in Figure 3-6) from the
Customize Menus and Toolbars dialog box.

Customize Menus and Taolbars
Menus are active while this dialog box is open. Drag-and-diop to change
position or right-click a menu item for more options.

Toolbars | Commands | Options | Keyboard | Custom Commands
Hew
Add Command
Command name: | E el
Tooltip text: Open Excel
Command fine: C:\Program Files\Microsoft Offi
=
Ch : -
0032 ican: m Icon
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3. Click the New button.
4. Type a name for the command in the Command Name field.

The name you choose is simply used to identify your custom command.
You don’t need to wrack your brain here. If you decide to add Excel to a
menu, you might want to name the command Excel.

5. Enter a short description of the command in the Tooltip Text field if
you want a pop-up description to be associated with a new icon.

6. Click Browse to navigate to either the location of the application’s
executable file or to one of ACT!’s customized documents.

7. Click OK to close the navigation dialog box and then click the Add
Command button.

After you create a custom command, your next task is to get it to magically
appear on one of your ACT! menus. I know, by now, you're getting tired of
reading all about menu bar customizations. You don’t want to follow an entire
new set of commands. I don’t blame you. But guess what? If you've read
through this chapter, you know how to add those new custom command
items to your menus. Hop back to the section “Ordering additional menu
items” to find that those directions are just about all you need to make it
happen.

Refer to Figure 3-4 to see that one of the categories listed is Custom
Commands. What a coincidence. You can find all your newly created custom
commands just sitting there, waiting to be dragged to the appropriate menu.
Time to go put your feet up and rest a bit — you’ve worked very hard!
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In this part . . .

Okay, after you whip ACT! into shape (see the preced-
ing part of this book), it’s time to get your life in

order. ACT! is a contact manager, which (as the name
implies) makes it a great place to manage your contacts.
First, you add new contacts into your database and then
you need to know how to find them again. After you locate
your contacts, you can schedule an activity with any one
of them, set a reminder, and maybe add some notes for
good measure. (Sure beats the heck out of a yellow sticky
note!) And, should you want to see the whole picture, you
can access one of the Dashboards or list views to check
things out.




Chapter 4
Making Contact(s)

In This Chapter

Inserting new contacts
Removing existing contacts

Updating contact information

A database is only as good as the contacts that it contains. In ACT!,
adding, deleting, and editing the contacts in your database is easy to
do. In this chapter, I show you how to do all three of these tasks to maintain
an organized, working database. Adding new contacts is only half the fun;
being able to find them is why you have the database in the first place.
Inputting contacts in a consistent manner ensures that all your contacts are
easy to find. If you need to change that contact’s information or delete the
contact, stay tuned. I demonstrate how to change contact information and
even how to “unchange” changes that you might make by mistake!

Adding New Contacts

On the very simplest level, the main purpose of ACT! is to serve as a place to
store all your contacts. You can add and edit your contacts from the Contact
Detail window because it contains all the information that pertains to one
particular record and allows you to see all your contact fields.

Every time that you add a new contact, ACT! automatically fills information
into three fields: Record Creator, Record Manager, and Create Date. If you click
the Contact Info tab of your layout, you'll notice these three fields. When you
add a new contact, ACT! inserts your user name into the Record Creator and
Record Manager fields and the current date into the Create Date field. This tab
enables you to search for all the new contacts that you created within a given
date range. The Record Creator and Create Date fields serve as a permanent
record, and you can’t change them. Managers and Administrators can over-
ride the contents of the Record Manager field if they so desire.
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You probably have lots of contacts that you're dying to enter into your data-
base, so what are you waiting for? Jump right in and follow these steps:

1. If you aren’t already in the Contact Detail window, go there by click-

ing the Contacts icon on the ACT! Navigation (Nav) bar.

Don’t know about the Nav bar? Check out Chapter 2, where you find out
all you need to know about the Nav bar and then some.

. Choose Contacts=>New Contact in the Contact Detail window to add a

new contact to your database.

Alternatively, you can click the New Contact icon on the toolbar or press
Insert (on the keyboard). In any event, initiating any of the preceding
commands results in a blank contact record; you're now ready to enter
the new contact’s information.

. Begin entering information by clicking in the Company field and

typing the contact’s company name.

ACT! doesn’t distinguish between actual contacts and blank contacts.
Failure to enter information or repeatedly pressing Insert results in
numerous blank contact records, which are of no use and serve only to
clog the database. So, although you’re free to leave any of the ACT! fields
blank, you’ll want to enter something — at the very least, I recommend
the key pieces of information, such as the contact’s name, company
name, and phone number — so you might as well begin with the com-
pany’s name.

You can always go back to a record and delete, add, or change any infor-
mation in any field. See the sections, “Deleting Contact Records” and
“The Contacts, They Are AChangin’,” later in this chapter.

. Click in the next field where you want to enter information and start

typing.

You can also use the Tab key to advance to the next field. In your initial
excitement to start entering all your existing contacts, if you inadver-
tently press Tab once too often, you might find that you advanced one
too many fields and ended up in the wrong field. Don’t fret: Press and
hold down the Shift key and then press Tab to move your cursor in the
reverse direction. If you prefer, you can also get back to any field simply
by clicking in it with your mouse.

. Continue filling in fields.

As I mention in Chapter 2, ACT! comes with approximately 50 prepro-
grammed fields that are needed by most users. Many of the fields are
fairly self-explanatory (and reflect the type of information that you prob-
ably expect to find in any address book): contact name, company name,
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phone, city, state, and ZIP code. Most of these are conveniently located
in the top half of the Contact Detail window. A few of the fields are a little
less obvious:

e Address: If you assume that the three fields ACT! provides for the

address are meant to store three alternative addresses, you're
wrong! The second and third address fields are meant for really
long addresses. These fields are good places to include a suite
number or building name if it is an integral part of the address.

ID/Status: The ID/Status field is essentially the category field, and it
files each of your contacts into categories. By using the ID/Status
field, you don’t have to manually set up a variety of databases: one
for your friends, one for your clients, one for your vendors, and so
on. The ID/Status field comes preset with a few dozen of the most-
commonly used categories in its drop-down list, including employ-
ees, customers, vendors, and competitors, which makes searching
for each of these categories a snap.

Salutation: This field refers to the name that comes after the word
Dear in a letter, which is used in your letter templates. By default,
ACT! (being the friendly type) uses the first name.

If you prefer using the more formal salutation as the default setting,
choose Tools>Preferences and click the Salutation Preferences
button conveniently located on the General tab.

Referred By: This field is one of the most-commonly overlooked
fields in the database. Information entered into this field is used in
the Source of Referrals report; failure to enter Referred By informa-
tion renders the report useless. So what’s the big deal? Suppose
you’re paying for advertising in two newspapers — wouldn’t know-
ing which one attracted the most prospects be nice? If you're
attending trade shows or putting a lot of time and effort into your
Web site, wouldn’t you like to know whether your efforts result in
any new business? And, if an existing customer sends you lots of
new leads, wouldn’t remembering him with a nice gift at holiday
time be nice? Utilizing the Referred By field can help you do all this.

User: Notice the several User fields in the bottom half of the
Contact Detail window. These fields hold information that’s spe-
cific to your business. In Chapter 13, I explain how you can change
these field names to better reflect their contents. For example, you
might rename User 1 to Social Security number.

[ recommend leaving these particular fields blank until you rename
them. If you don’t, you might end up with a mishmash of information in
the user fields.
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6. Don’t be alarmed when ACT! automatically formats some of your field
data when you enter information.

See the section, “Letting ACT! do the work for you: Automatic format-
ting,” later in this chapter for the lowdown on what ACT! does and
doesn’t do for you.

7. Add your data as uniformly as possible.

Check out the section, “Getting the most out of ACT!: Using the drop-
down lists,” later in this chapter to find out how to easily keep your data
uniform and yourself sane.

8. If necessary, add multiple entries to a field.

Generally, limiting yourself to one item per field is the best practice.
From time to time, however, you find a situation in which a contact falls
into two categories. For example, a contact might be both a friend and a
client. In this situation, you can use a multi-select drop-down list to
select more than one item into a field. By default, the ID/Status field is
set to be a multi-select field; Chapter 13 shows you how to create as
many multi-select fields as you want.

To select criteria to be included in a single field, follow these steps:
a. Place your cursor in the field.
b. Click the down arrow to the right of the field.

Figure 4-1 gives you an example of a drop-down list.

[] Competitar ol
[] Consultant I
[] Cantractar
- . | Custamer
Flgure 4-1: [[] Distributar
| |C] Emplayee
An ACT! H o
drop-down | Friend
. [] Gate Keeper
list. [ Influencer w

‘ Edit List Values

c. Click the desired entries from the list.
d. Click anywhere outside the dialog box to close it.
The various entries appear in the field, separated by a semicolon.

9. When you fill in the information for each new contact, don’t forget to
click the various tabs in the bar that divides the upper and lower
parts of your layout.

You find additional fields lurking on these tabs. The Home Address tab is
where you record personal information about a contact. Depending on
your database and the layout you're using, you might see other tabs
with fields waiting for your data.
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Different layouts display different tabs. If you change your current
layout, you're probably looking at a different set of tabs. Confused?
Check out Chapter 2 for a quick refresher.

If you forget to click those tabs along the middle of the Contact Detail
window, you just might overlook some of the fields that hold important
information. Although you can always fill them in later, it’s a good idea
to input the information while it is still fresh in your memory, so be sure
to click those tabs!

10. Save the new contact information.

Theoretically, you don’t have to save new contact information; it’s saved
if you do one of the following:

e Execute any other ACT! command, which includes anything from
adding a note or sales opportunity to scheduling an appointment.

* Move on to another record in the database.

Although it’s not necessary, feel free to do one of the following to save
your information immediately:

e Click the Save button (the small floppy disk icon on the toolbar).
e Press Ctrl+S.

Letting ACT! do the work for you:
Automatic formatting

Entering a new contact into the ACT! database is so easy that you might over-
look some of the magical things that happen when you begin to input contact
information. ACT! is here to help by automatically formatting some of the
contact information that you input, including

v Automatic phone number formatting: A great example of ACT!’s magic
is found in any of the phone fields. When you type in a phone number,
notice how ACT! automatically inserts the necessary parentheses and
hyphens. ACT! automatically inserts the dialing format for the United
States each time that you enter a new phone number. Have relatives
living in Turkmenistan? Have no fear: If you click the ellipsis button (the
three little dots) to the right of the Telephone field, ACT! pops open the
Enter Phone Number dialog box. By default, the country is listed as the
United States, but you can scroll through the list of the countries for just
about any country that you can think of, including Turkmenistan (see
Figure 4-2). After you click OK, the correct telephone country code and
format are applied to the telephone number.
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Enter Phone Number
Figure 4-2: | com Ecuador [593] ]
Automatic B Trinidad and Tobaga [1] -~

Tunizia [21E]

| Tukep 30
telephone | Phonetumber: T 3521

1 Turks and Caicos lglands [1]
formattlng' Edit Formats... | Tuwalu[638]

Uganda [256]
| TR ==t

1 Automatic name formatting: Another field that ACT! automatically pro-
vides you with is the Salutation field. The Salutation field holds the text
that appears after the word Dear in a letter. For example, if you enter
Mary Ellen Van der Snob as the contact name, Mary Ellen magically
appears as the salutation. Of course, if you prefer to address your con-
tacts in a more formal manner, feel free to change Mary Ellen to Ms. Van
der Snob. When you enter a contact name into the database, ACT! auto-
matically divides it into a first, middle, and last name. Again, if you click
the ellipsis button to the right of the Contact field, ACT! shows you how
it plans to divide the contact’s name. This allows you to sort your data-
base alphabetically by last name or to look up a contact by first name.
This chapter and Chapter 5 both include ways to sort your database. If
you attempt to enter a rather large, unique name, ACT! automatically
opens the Contact Name dialog box, as shown in Figure 4-3, and asks you
how you want to divide the name.

Contact Name

ALT! uses the First Mame and Last Name for soiting and lookups.
ALCT! has determined the following to be the First Mame, Middle
Mame, and Last Name of this contact, |f any of these names is
incomect, select the conect name from the drapdown list.

Hame details

Contact:

First name: Minnie Jo ™

— Middle name: | Garcia ™

Figure 4'3: Last name: Perez Mouse w
The Contact

utomatically show this dizlog if the contact name containg mare
Name :than two names

dialog box. [ coe

P ACT! is an amazingly smart and intuitive program. You might want to
input the contact name as Ms. Alyssa Fredricks or Alyssa Fredricks, Esq.
ACT! knows that words like Mr., Miss, and Ms. are usually not first
names, and PhD, MD, and Esq. are generally not last names, so feel free
to add them to the contact name if you’'d like.
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Figure 4-4:
An ACT!
date field.
|

v~ History fields: Any changes to a history field are preserved on the

History tab. Say you have six steps that you want your staff to perform
when dealing with prospects. You might change the drop-down informa-
tion for your history field to reflect those six steps. When you perform
one of the steps and you enter the information into the field, the date
and time of the change appear on the History tab so you know exactly
when each step took place.

Out of the box, only two fields — ID/Status and Last Results — are his-
tory fields. Theoretically, any field can be a history field, and Chapter 13
shows you how to do it.

v Date fields: The one thing you don’t ever want to forget is the birthday

of your significant other. However, as you discover in Chapter 6, entering
data consistently is important if you have any hope of ever finding it
again. What if an important birthday occurs in January, but you aren’t
sure whether the date was entered as January, Jan, 01, or 1? By now,
you've probably guessed that ACT! came up with a cure for the birthday
blues with the addition of date fields. All date fields have a drop-down
arrow, which you can click to bring up a mini-calendar, as shown in
Figure 4-4. Click the appropriate date, buy a card, and you’re ready to
roll. If you prefer, you can also manually enter the date as 01/17/06 or
1/17/06, and ACT! translates it to the calendar mode automatically.

<

January 1936 [# ]

SMTWTFS

Getting the most out of ACT!:
Using the drop-down lists

One sure-fire way to sabotage your database is to develop new and creative
ways to say the same thing. In Florida, users often vacillate between Fort, Ft,
and Ft. Lauderdale, resulting in a bad sunburn and the inability to correctly
find all their contacts. You'll notice that several of the ACT! fields contain
drop-down lists. In these fields, you can select an item in the list or you can
type the first few letters of an item; the field then automatically fills with the
item that matches what you typed or clicked.
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You have two ways of using the drop-down lists to enter information:

v Type the first few letters of an entry that already appears in the drop-
down list, and ACT! auto-completes the word for you. For example, if
you type Bo in the City field, Boise magically appears; then, if you add a
n s, Boston appears.

v Access the drop-down list by clicking its arrow and then choosing the
desired item(s) from the list.

Using these drop-down lists whenever possible helps ensure consistency
throughout your database. In Chapter 13, I explain how to add additional
drop-down fields to your database and control how you use them.

If you want to change the content of the drop-down lists that come with ACT!,
follow these steps:

1. Click in a field that has a drop-down list.

2. Click the drop-down arrow in the field.

3. When the drop-down list appears, click the Edit List Values button.
The Edit List dialog box appears, as shown in Figure 4-5.

Edit List

Enter drop-down lisk values;

Value Description ~ Add
Competitor

Consulkant
Contractar

Customer

Diskributor

Employee

Farnily

Friend

Gate Keeper

Influencer

Inwestor

Lead

Manufacturer

Prospect

Figure 4-5; | |*="

Resource

Ed|t a drOp- Retailer

down list | [>eeler v
here.
o
|

4. In the Edit List dialog box, do one of the following:
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e To add an item to the list: Click the Add button. A new blank line
appears at the bottom of the list. Enter the text that you want to
appear in the list.

e To remove an item from the list: Select an item and click the Delete
button. Click Yes when ACT! asks you to confirm the deletion.

¢ To modify an existing item: Double-click it and edit it exactly like
you would in a word processor.

5. Click OK when you finish editing your list.

That’s all there is to it. A pretty easy way to ensure consistency, don’t you
think?

Deleting Contact Records

What do you do if you find that a contact is duplicated in your database? Or
that you're no longer doing business with one of your contacts? For whatever
reason you decide that a name no longer needs to be a part of your database,
you can just delete that contact record.

ACT! allows you to either delete one contact record or a lookup of contact
records. (A lookup is the group of contacts that displays after a database
search. Peruse Chapter 6 for more information about lookups.) Just realize
that you're deleting either the current contact that you're viewing or the cur-
rent group of contacts that you just created a lookup for. When you’re on the
contact that you want to delete, do one of the following:

v Choose Contact->Delete.
v Press Ctrl+Delete.

1 Right-click the contact record and choose Delete Contact.

Any one of these choices brings up the warning, as shown in Figure 4-6.

|
Figure 4-6:
You get an
ominous | ACT!
- Deleting contacts cannot be undone. “Would you like to delete the current contact or the entire lookup?
warning
When [ Delete Contact J [ Delete Lookup J [ Cancel

deleting a
contact.
|
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Clicking the Delete Contact button deletes the current contact you're view-
ing. If you click the Delete Lookup button, you delete the current contact
lookup.

Thinking before deleting a contact

Although the procedure is rather simple, you might want to rethink deleting
contacts. When you delete a contact, you also delete all the associated notes
and histories tied to that contact. For example, suppose that State College
uses ACT! to keep track of all prospective students that it has contacted — or
has been contacted by. State College admissions personnel receive thou-
sands of inquiries a month and fear that the database will become too large
to manage . . . and subsequently think that deleting all prospects that they
haven’t had contact with in over a year is the best course of action. However,
some of those prospects might be attending different schools that they aren’t
happy with and might want to enter State College as transfer students. Other
prospects might transfer after completing two years at a community college,
and still others might consider attending State College as graduate students.

What to do in such a situation? I'd consider moving the contacts that you no
longer need into another archival database. That way, should the need ever
arise, you can still find all the original information on a contact without
having to start again from scratch. How nice to be able to rekindle a relation-
ship by asking, “So tell me, how did you find the accounting department at
Podunk University?” Although the setup of an archival database is beyond
the scope of this book, an ACT! Certified Consultant (ACT! CC) can assist you
with this matter.

Three warnings before deleting a contact

Losing contacts in your database is a very scary thought. You undoubtedly
rely very heavily on your ACT! database; losing that data can be potentially
devastating to your business. Worst of all, when you realize that you just acci-
dentally removed several — or even hundreds — of contacts from the data-
base, panic can set in!

Avert this panic by following these tips before you attempt to delete any of
your contacts:

+* Know the difference between deleting a contact and deleting a
lookup. That way, you don’t delete numerous contacts when you want
to delete only a single record.
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& e Contact: The single record that you view from the Contact Detail
window.

e Lookup: The group of contacts that displays after a database
search. Chapter 6 gives you more information about creating
lookups.

+ Read the warning and make note of the number of contacts that
you’re about to delete. Don’t be afraid to click Cancel if a large number
of contacts start to disappear.

+” Remember the three rules of computing: backup, backup, backup!
Chapter 15 provides you with instructions on how to create a backup. A
good backup provides the easiest method to restore all your information
after you accidentally deleted it.

The Contacts, They Are A’Changin’

Companies relocate and change their names, people move, and your fingers
sometimes slip on the keyboard. People change e-mail addresses. You might
want to add additional contact information for one of your contacts. All these
predicaments require the editing of contact fields. Not to worry; changing the
information that you store in ACT! is as easy as entering it in the first place.

ACT! gives you two ways of updating contact information:

v Click in the field that you want to change and then press the Delete or
Backspace key to remove the existing field information. Then simply
type in the new information.

v+~ Highlight all the information in a field. By typing in the new informa-
tion, the old information is automatically replaced.

P If you accidentally overwrite information in a single ACT! field, press Ctrl+Z to
undo the changes that you just made to that field — before you move your
cursor to another ACT! record. If you made multiple changes to a contact
record or for those who are keyboard challenged, an alternative is to choose
Edit>Undo from the main menu. After you move on to another record,
neither of these options are available to you.

WING/
&gb After you execute another ACT! command or move on to another record,
ACT! automatically saves the record. At that point, you can’t automatically
undo any changes you made to a contact record.



5 &  Partil: Putting the ACT! Database to Work




Chapter 5
A Few Good Tabs and Lists

In This Chapter

Discovering ACT! lists and tabs
Remodeling ACT! lists and tabs

Putting secondary contacts in the right place

Linking documents to the Documents tab

Froughout this book, you find all the neat ways in which you can cus-

tomize ACT!. In this chapter, you discover how to change the appearance
of the various ACT! lists and tabs. And, although you encounter numerous
lists and tabs in your travels through ACT!, you’ll soon discover that you can
modify them in exactly the same way.

<MBER

After you've seen one list or tab, you've seen them all! And, if you're a

fanACTic, the lists and tabs work pretty much like they did in previous

versions.

Meeting the Lists and Tabs

The bad news is that numerous lists and tabs are sprinkled through ACT!,
and new users might find themselves lost in a maze of windows. The good
news is that lists and tabs all have pretty much the same look and feel to
them — if you master one, you master them all!

You can find all lists by clicking View on the menu bar and then explore one
by selecting a list that sounds fun and exciting. Two of the lists — the Task
List and the Opportunity List — are so much fun that they’re included in the
Navigation (Nav) bar running along the left side of ACT!. And, if you feel so
inclined, you’'re welcome to flip back to Chapter 3 to find out how to add all
the list items to the Nav bar.
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Here’s a few of the lists you’ll work with most often:

v Contact List: Lists all your contacts; the list is filtered based on your cur-
rent lookup. (For more on lookups, see Chapter 6.)

v~ Task List: Lists all the tasks and activities you scheduled for all your
contacts. You can filter these by date, type, priority, user, public versus
private, timeless, cleared status, and Outlook relationship.

v Group List: Lists all groups and can optionally include subgroups.

1+ Company List: Lists all companies and can optionally include divisions.

v Opportunity List: Lists all the sales opportunities that you enter for all
your contacts. You can filter opportunities by date, status, process,
stage, probability, amount, and public versus private.

The two types of tabs are

1 System tabs: These are the same for any and all layouts you use. The
system tabs include

Notes: Lists all notes you record for the current contact, company,
or group. You can filter the notes by date, private versus public,
and user. See Chapter 7 for more on the Notes tab.

History: Lists all correspondence, activities, and document informa-
tion that were recorded automatically by ACT! for a contact, group,
or company. You can filter the histories by date, private versus
public, type of history, and user. Turn to Chapter 7 to find out more
about the History tab.

e Activities: Lists all activities for the contact, group, or company.

You can filter the activities by date, private versus public, cleared,
timeless, type of activity, priority, and user. I go in depth about the
Activities tab in Chapter 8.

Opportunities: Lists the financial lowdown on all the selling oppor-
tunities for the current contact, group, or company. You can filter
the opportunities by date, status, private versus public, and user.
Chapter 19 covers the Opportunities tab.

Documents: Lists all files attached to the current contact, group, or
company. Note: You can't filter this tab. See the section,
“Documenting Your Documents,” later in this chapter for more
about the Documents tab.

Contacts: Lists all the contacts associated with the current group or
company. You see this tab only in the Group Detail window or the
Company Detail window.
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Minding your filters!

When viewing the various system tabs, you
must be aware of the effect that the filters have
on what information you see — or don't see. In
ACT!, you can choose to filter information or to
include it. Different tabs have different filters;
however, all tabs include a date filter and a user
filter. If the filter is set to show only items in the
future and you have an activity scheduled for
today, you don't see today’s activity. And, if you
schedule an activity but you set the filter to
include only Alyssa’s activities, you don't see

When frustrated, check your filters! You might
be puzzled when information you just know has
been entered into the database mysteriously
disappears. This becomes increasingly impor-
tant on the Activities tab, which contains sev-
eral filter options (including three buried away
behind the Option button). The Task and
Opportunity lists can be even more confusing;
these lists contain a variety of filter options —
all of which can be hidden away with one click
of the Hide Filters button.

01

your activity, either.

e Secondary Contacts: Lists the secondary contacts (for example, the
butcher, the baker, and the candlestick maker) that are directly
associated with the current contact. Note: You can't filter this tab.
Flip ahead a few pages to the “Corralling Your Secondary Contacts”
section in this chapter where I discuss the Secondary Contacts tab.

Groups/Companies: This tab has a dual personality. You'll notice
the addition of the Show Membership For drop-down list that lets
you indicate whether you want to view the groups or the compa-
nies that the contact is associated with. This tab appears only in
the Contact Detail window.

P The first five tabs appear on the Contacts, Groups, and Companies
windows. That’s because you can add a note, an activity, and so on
to either an individual contact record, or to a company or group
record.

v User tabs: You can rename and modify these to best fit the way you
work. (See Chapter 14.)

Customizing Lists and Tabs

One of the reasons that you might find the lists and tabs to be so useful is the
ease with which you can customize them. You can add or remove columns,
change the order of the columns, widen the columns, sort on any one of the
columns, and then print out your final product. In this section, I cover a few
ways in which you can change the look of your lists and tabs.
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Adding or removing columns

Probably the first thing that you want to do to modify your lists and columns
is to add or remove a column — or two or three! Follow these steps:

1. Click the Options button (in the top-right corner) on any list or tab
and then choose Customize Columns from the menu that appears.

The Customize Columns dialog box appears (see Figure 5-1).

@ Customize Columns
Available fields: Show as columns in this order:
Acress Level ~ IsUser
Address 3 Private Contact
Alternate Extension ‘Company
Alternate Phone Contact
Birth Date Phone
Country Extension
Create Date Title:
Customer [0 2> Address 1
Department Address 2
E-mail << City
Edit Date - Shate
Fax Extension ZIP Code
Fax Phone fod 1D/Skatus
Reset Cancel

Because variety is the spice of life, you right-clickers will also find that
you can right-click any of the ACT! lists or tabs to get to the Customize
Columns dialog box.

2. Select the field (column) that you want to add by clicking the appro-
priate choice in the Available Fields list.

Depending on the list or tab you’re working with, you see various field
choices. Feel free to include as many or as few as your little heart
desires.

3. Click the single right-pointing arrow.

If you're really into seeing a lot of information, you can click the double
right-pointing arrows; that adds all available fields to your list or tab.

4. To remove an item, click the appropriate choice from the Show as
Columns in This Order list and then click the single left-pointing
arrow.

If you really want to get rowdy, click the double left-pointing arrows to
remove all the current fields. You might do this if you have an over-
whelming desire to start from scratch.

5. Click the Close button when you’re done.
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Changing the order and width of columns

You can change the order of the fields from the Customize Columns dialog
box that I show you how to access in the preceding section. Click the appro-
priate choice from the Show as Columns in This Order list and click the Move
Up or Move Down buttons.

The order in which items appear in the Customize Columns dialog box is
exactly the way they appear in your final product. Knock yourself out,
arrange and rearrange all you want, and sleep peacefully knowing that if you
don’t like the outcome, you can always change it again. Now, if [ could just do
that with my living room!

You can also drag and drop the various column headings to change the order
in which columns appear on the lists and tabs. For example, if you want the
Date field to appear before the Time field on the Task List, simply click the
Time column heading and drag the heading over to the left of the Date
column heading. When you start to drag one of the columns, a black vertical
line appears, indicating the intended location of the column.

Changing the width of a column is just as easy. If you move your mouse on
the line between any two column headings, your cursor transforms into a
double-headed arrow. When that arrow appears, hold down your left mouse
button and drag to the left or right to narrow or widen a column. The column
to the left of your mouse changes width.

Sorting your lists and tabs

In general, | hate terms like automatic and click of a button because your
vision of aufomatic might be quite different from that of a software engineer.
That said, sorting the entries in any of your lists and tabs is, well, automatic
and can be done with the click of a button: Just click the column heading that
you want to use to sort the list. Want the contacts in your Contact List sorted
alphabetically by city? Click the City column heading. Change your mind and
want it sorted by ZIP code instead? Click the Zip Code column heading.

ACT! automatically separates the contact’s name into a first and a last name.
When you click the Contact column heading in any of the lists or tabs, you’ll
notice that your information is sorted by last name so that Andrea Fredricks
appears alphabetically with the Fs rather than with the As.

When you click a column heading, an up arrow appears indicating that the
contacts are sorted in ascending order (in alphabetical, A-Z, or 1-10 order).
To reverse the sort order, click the column heading again. If the list is sorted
in ascending order, contacts that have no information in the selected column
appear at the top of the list. In descending order, they appear at the bottom
of the list.
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Sorting your contacts is so simple that you might decide to get really adven-
turous and sort based on another criterion. Go ahead — I dare you! Click any
column heading to re-sort the list by the field of your choice. Want to have
your Contact List sorted by more than one criterion? Sneak a peak at the final
section of this chapter for a crash course.

Contacting the Contact List

|
Figure 5-2:
The ACT!
Contact List.
|

The Contact List is a good way to view your contacts if you're working with
large numbers of contacts at one time. You can make changes to the contact
information you see directly in the Contact List. Changing the columns that
appear in the Contact List provides you with a way of comparing information
between your various contacts. For example, you might want to see how
many of your contacts purchased each of your products, and have the name
of each product appear in the Contact List, along with their telephone
number.

Getting to the Contact List is half the fun

The road to the Contact List is simple to follow — choose Viewr>Contact List.
A list of your contacts appears, displayed in columns, as shown in Figure 5-2.

File Edit View Lookup Contacts Groups Companies Schedule Write Reports Tools Help @
woa 1520f171 v bl B Contacts |[EiContactlist (S M i A s TR wmEGd e N EEED
' = [
e Look for: [JEditMode ¥ Tag Mode  Tag All Untag All Lookup Selected A
FyS Compai Contact Tile Address 1 Addiessa Dy Srate ZIP Code ID/Stan o
Cotacts | Restawantle Diagon d0i  Jacques Antoine 56, boulevaid de la Fip Faiis 7 75020 Fiospec
I Filvet Rt Tous Fiose Sayer Presidet 750 Lafayelle 5t Balon Fouge La 70801 Fiospec
;P Fiiver Flat Tous Charle Allnut Captsin 150 Lafayetie St Batan Flouge L 70801 Prospec
Gmu’ps Flabettsan Jainery Jule Mies VP of Gales Dene Fload Jesinond Newcastls upar Tor ME3 4KL Prospec
Flosebud Publications Chales Faster (arie Publisher Z2W d4th 5t New York Ny 10038 Influenc
= 50 Enterpiises Kelsey Reay Manager 58 Chuchi 5t Hounslow Middleses v 7T Custorm
e Sewna Fnon The Gianisle Middlebin Dinei 2398 Merkeh - © GenFanekens  CA TRgnALTT Custerms
SOMPANES | Siema's Cafe Brandon Sloan  Duwnier 1823 E. 2nd 5t Long Bsach =) 0807 FriendF
— Simbei Bruce Baker Chist Designer 555 Baale D Sulle 2 Ficacho oz 85111 Custorie
EEEc Slanifonabingbong Incustiies Kyle Wetmore  Fiesident 56 E Feinsetta O Fhoenis oz 85028 Fiospec
Calerdar | Spagheteroni's WMaty Nata The ltalian Goddess o 123 Pasta Way Hew Britzin fuic DED51 Custorne
Spin Racardia il thory ke CHisl Engres Proie:
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Chapter 3 shows you how to add additional icons to the Nav bar. You might
want to add the Contact List to the Nav Bar if you find yourself heading to the
Contact List fairly frequently.

When you come across a contact record in your list that requires a bit of
tweaking, you can do so directly from the Contact List if you're in Edit mode.
A cursor appears at the end of any field you click at which point you can start
to fill in your changes. You know you're in Edit mode if a check mark appears
in the Edit Mode check box at the top of the Contact List.

Alternatively, if you have lots of changes to make to a Contact Record — or
have lots of Contact Records that need changes — you might prefer to flip to
the Contact Detail window to make your changes. You can get to the Contact
Detail window in a number of ways:

+ Double-click a contact in the Contact List.
1 Right-click the contact and choose Look Up Selected Contacts.
» Click the Back button on the Back and Forward bar if you were just in

the Contact Detail window.

The Contact Detail window appears with the selected contact’s record. To
return to the Contact List, choose View=>Contact List or click the Back button
on the Back and Forward bar.

Finding a contact in the Contact List

In Chapter 6, I show you how to create a lookup to find contacts that meet
your specific criteria. The Contact List also allows you to go to a specific con-
tact record in the blink of an eye. Here’s what you need to do:

1. Click the column heading to select that column.

For example, if you want to find a contact by last name, click the Contact
column heading.

This feature works best if you are not in Edit mode.

2. Start typing the first few letters of the contact information that you
want to find in the Look For text field.

ACT! scrolls down the Contact List to the closest match. For example, if
you sorted the list by contact and typed the letter s, you might land on
the Colonel Sanders contact record. If you typed sm, you're probably
looking at all your Smiths.

3. Continue typing until you reach the contact for whom you are
looking.
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Tagging contacts in the Contact List

Using the Contact List, you can easily select — or tag — contacts to manually
create a lookup of your contacts. For example, say that you want to target
some of your best clients for a special promotion; a general lookup probably
doesn’t produce a list of those contacts because you don’t have a field that
includes special promotions. Instead, you can tag those contacts based on
your own instincts.

To switch to Tag mode, make sure that a check mark is showing next to the
Tag Mode option, which is located at the top of the Contact List. You can do
the following things in Tag mode:

1~ Tag a contact. Click anywhere in the contact; a gray bar appears across
the contact record indicating that you tagged it. Figure 5-2 shows tagged
contacts.

v~ Untag a contact. Click anywhere in a tagged contact, and the gray bar
disappears.

1 Tag a continuous list of names. Click the first name in the list that
you're selecting and then press the Shift key while clicking the last name
in the list that you're selecting. All the names between the first name
and the last name that you're selecting are tagged automatically.

Notice the four buttons to the right of the Tag Mode option. After you tag the
contacts that you want to work with or those that you want to omit tem-
porarily, choose one of the following four buttons:

v~ Tag All: Allows you to select all the contacts currently showing in the
Contact List.

v+~ Untag All: Allows you to deselect any contacts that you already
selected.

v Lookup Selected: Allows you to create a lookup based on the contacts
that you tag.

v Omit Selected: Allows you to remove the contacts that you select from
the Contact List. Don’t panic — it does not remove the contacts perma-
nently from your database!

If you need to print out any lists or tabs, flip to Chapter 10 for the lowdown
on Quick Reports.
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Corralling Your Secondary Contacts

Does this scenario sound familiar? You have a main contact, but of course
that person, being the big cheese, is rarely available, so you often have to
work with his assistant. But of course, the assistant can’t do any true deci-
sion making, so you might need to speak to Mr. Big’s sales manager on occa-
sion. And, when the sales manager goes on vacation, you need to call the
assistant sales manager. Yikes! The Secondary Contacts tab, as shown in
Figure 5-3, allows you to store all the pertinent information about Mr. Big and
his partners in crime in the same area so you don’t have to go on a wild
goose chase hunting down names, telephone numbers, and e-mail addresses.
And, just like promotions that often happen, you can “promote” a secondary
contact into a main contact.

Notes | History | Activities | Opportunities | Groups{Companies | Secondary Contacts | Documerts | Contack Info || User Fields | Home Address
New Secondary Contact Promote Options ~
I (6 [Contact £ Title Phane Extension | E-mail Addresss 1 City State | ZIP Code:
Julia Caroline Agsistant (303)555-0373 101 Julia.Caroline@mercuryprodman. com 66 Flash Rd. Central Ciy  CO 90427
FI ure 5_3 Matihew Lee Marketing Manager [303] 555-0178 Matihew. Lee@mercuiyprodman, com 66 Flash Rd, CentralCity  CO 80427
g . Biyan Michael Account Manager  [303) 5550263 204 Biyan. com BE Flash Rd. Central City  CO 80427
The
Secondary
Contacts
tab.
|
<® Not sure whether you should add a contact as a primary or a secondary con-

tact? You might want to think of how you’ll use the secondary contact. If you
just want to be able to access an assistant’s phone number, the assistant is a
good candidate for entry as a secondary contact. However, if you want to be
able to e-mail your monthly newsletter to the assistant or include her in some
of your mail merges, you need to add the assistant as a primary contact
record instead.

Adding a secondary contact

Of course, you can’t add a secondary contact until you create a main contact.
(See Chapter 4 to do so.) After you create the head honcho’s contact record,
here’s what you do to create the secondary contact record(s):

1. From the Contact Detail window, click the Secondary Contacts tab.

2. Click the New Secondary Contact button on the top of the Secondary
Contacts tab.

The Secondary Contacts dialog box appears (see Figure 5-4).
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|
Figure 5-4:
Fill in
secondary
contact
information
here.
|

Secondary Contacts

Company: ‘ La Yaix |

Contact: ‘ Gary Kahn |

Title: ‘ President | |

Fhane: (314) 6165555 [ e [ ]

Phane/E-mail Business Address

Mabike: [e46) 289-5555 [..]

Fax: [ (pemp 16-5555 [

E-mail: gary@layoi.com |

‘web site: | |8 Dix. Com |

1Djstatus: | Influencer 2 |

D Private

Cancel

3. Fill in all the juicy details for the secondary contact.

Although you don't fill in quite as much information as you can for a
main contact, you do have all the really pertinent fields. Don’t forget to
click the Business Address tab for even more fields.

4. Click OK to create the secondary contact.

Congratulations! Your main contact has now given birth to a secondary con-
tact. All the secondary contacts that you create appear on the Secondary
Contacts tab of the primary contact.

If you need to go back and edit or add information for the secondary contact,
just double-click the name from the Secondary Contact List and voila, you're
back to the Secondary Contact dialog box.

Deleting a secondary contact

Sorry to say, but some of the secondary contacts might drift off into the
sunset, leaving you with the need to remove them from your database. Not to
worry; you can delete a secondary contact by following the bouncing ball
through these steps:

1. Click the Secondary Contacts tab from the Contact Detail window.

2. Right-click the contact you want to delete and then choose Delete
Secondary Contact.



|
Figure 5-5:
Promote a
secondary
contact
here.
|
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You can never say that ACT! doesn’t give you ample warning before
deleting a contact. As usual, when you attempt to delete even a sec-
ondary contact, ACT! shows you a scary warning.

3. Click Yes to delete the selected secondary contact.

Promoting a secondary contact

Promoting, promotion — it has a lovely ring to it, don’t you think? That lowly
assistant might be promoted through the ranks and some day become the
“big guy” — or at the very least a more important contact than he/she is
today. If you're worried that you have to reenter all that basic information
again, don’t be. Just promote the contact by following these steps:

1. Click the Secondary Contacts tab in the Contact Detail window.
2. Select the secondary contact that you want to promote.

3. Right-click and choose Promote Secondary Contact from the menu.

Alternatively, you can click the Promote button at the top of your list of
Secondary Contacts. The Promote Secondary Contact dialog box
appears, as shown in Figure 5-5.

Promote Secondary Contact

‘when promating a secondary contact, you have the option to copy data fram
the main contact's pimary fields to the secondary contact fields. Primary
fields are displaved in Define Fields

Optionz

(3) Duplicate data from main contact's primary fields

() Do hot duplicate data from primary fields

4. Select whether to duplicate the main contact’s primary fields.

With promotions come responsibilities and decisions. If the secondary
contact is sliding into the role of the current primary contact, you want
to copy all the primary contact’s information to the record of the newly
promoted contact. If, however, the secondary contact doesn’t have the
same basic information as the primary contact, you can choose to not
copy the primary fields.

5. Click OK.
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No matter how organized you think your documents might be, you probably
occasionally misplace one of them. Of course you can always have Windows
search for it, but ACT! offers an easier — and faster — solution. The Documents
tab, which you can find on the Contacts, Groups, or Companies windows, allows
you to attach or create a shortcut to any and all of your files related to the cur-
rent contact, group, or company. You can add or create a shortcut to a proposal
created in Excel, a contract created in Word, or even a PDF file that you scanned
into your computer.

Adding a document

Adding a file to the Documents tab is very easy, and considering the time you
save down the road, well worth the effort. Just follow these steps:

1. Display the contact, group, or company record to which you want to
add a document.

2. Click the Documents tab.
3. Click the Add Document button on the Documents tab icon bar.
You have two choices here:

e File: By choosing this option you're actually cloning the original file
and adding it to your ACT! database. After you add a document to
the Documents tab, you can open the file directly from ACT! to
view, edit, or print. Removing a file from the Documents tab
doesn’t remove the original document from your computer and
vice versa.

Because the file you add to the Documents tab is a clone of the origi-
nal, changes you make to the original document don’t appear in the
cloned document residing on the Documents tab, nor do changes
that you make to the cloned document appear in the original.
Consider deleting the original document to avoid any confusion.

e Shortcut: Creates a shortcut linking back to the original document
rather than copying it. The location of the original document dis-
plays on the Documents tab.

As you can see in Figure 5-6, the My Documents path is specific to both
the machine and user. Purchasing a new computer or changing the user
information in your existing one renders your shortcut(s) invalid.
Consider creating a new Windows folder, such as ACT Documents, that
can be re-created on a new computer and be seen by a variety of users.
In addition, remote database users who don’t have access to those fold-
ers can’t view the document.
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Notes | History | Activities | Opportunities | GroupsiCompanies | Secondary Contacts | Documents | Contact Info | User Fields | Home Address

[2L Add Document -

[]_[Name Size Fie Type Date Modiied
f) [ c:\Documents and Seltings'Karen Fredricks TOSHIBA7S\My DocumentshTesting Motes.docs | 1 KB | Microsoft Offics wrd Document 51442007
3] | Cleveland directions.dac 43KB Microsaft Office Word 97 - 2003.. | 5/29/2007
B | final payout s 17 KB Miciosaft Dffice Excel 97-2003. | 1/1/2003
8] | Beese ketter.doc 24KB Microsoft Office wiord 97 - 2003 4/18/2006
) | Message Center Il Guick Start pdf 323K8 #Adobe Acrobat Document B/8/2007
1] | Z:\PersonaiiLa COSTA DEL MAR COND doo 1KB Microsoft Office word 97 - 2003, | 5A14/2007

) | 2:\Tashiba Notice.pdf 1KB Adobe Acrobat Dacument 5/14/2007

Depending on your choice, the Attach File or Attach Shortcut dialog box
opens.

. Browse to the document you want to add, select it, and then click

Open.

ACT! adds the document to your ACT! database and displays the size,
type, and last modified date on the Documents tab. Attached files dis-
play the document’s name; attached shortcuts display the path to the
file.

Documents that you add to the Documents tab become a part of your data-
base, so remote synchronization users can now access those document as

well.

You can also add a file to the Documents tab from Windows Explorer or My
Computer by dragging the document’s icon to the Documents tab.

Opening a document

The true benefit of adding documents to the Documents tab is the speed in
which you can open the documents that pertain to a specific contact, group,
or company. Follow these steps:

1. Click the Documents tab.
2. Select the document you want to open.

3. Click the Edit Document button on the Documents tab icon bar.

Alternatively, you can right-click in the file list area and choose Edit
Document from the menu. Or, if variety is the spice of your life, simply
double-click the filename to open it.

Magically, the program associated with the document opens, revealing
the document. You're on your own here — just remember that you can
now edit, save, or print the document as you normally would. Any
changes you make are reflected the next time you open the document
through ACT!.

/1
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If you're opening a shortcut attachment, you must have access to the folder
in which the file resides. In addition, you must have the appropriate software
to view the file. For example, if you're attempting to open an Excel spread-
sheet but you don’t have Excel installed on your computer, you can’t view
the document.

Removing a document

After you add a file or a shortcut to the Documents tab, you might change
your mind and decide to make it go am-scray. Easy come, easy go. Follow
these steps to rid yourself of the offending document:

1. Display the contact, group, or company record that contains the
document you want to eliminate.

2. Click the Documents tab.
3. In the Document List, select the document you want to remove.
4. Click the Remove Document button on the Documents tab icon bar.

Alternatively, you can right-click in the file list area and then choose
Remove Document from the menu.

ACT! makes sure you want to remove the document by presenting a
warning. Software programs very often present you with scary messages
before deleting important information. This is a good thing. Heed the
warnings!

ACT! deletes the document permanently from its database. And because
the document doesn’t end up in the Recycle Bin, think very carefully
before deleting the document.

5. Click Yes to confirm that you really, truly want to remove the
document.

If you originally created the document somewhere in your computer, the
document is still there. Changes made to the cloned copy in ACT! do not
affect the original document. Too, deleting the document in ACT! does not
delete the original document.

Changing the Sort Order

By default, ACT! automatically sorts your data alphabetically by the company
name. If you open the Contact List, you see your contacts listed there in com-
pany order. Scroll to the first contact in the Contacts view — that contact
probably works at a company that starts with the letter A. But, like just about
all of ACT!, you can change that order.
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Although the Contact List provides you with a quick-as-a-bunny way to sort
your contacts, it sorts the contacts based on the contents of a single field. If
you want to sort your contacts based on multiple criteria, you have another
way to do it:

1. Choose Edit=>Sort from either the Contact List or Contact Detail
window.

The Sort dialog box appears (see Figure 5-7).

21 Sont

Sart by Company | | Azcending |

and then by Contact w | | Ascending b

and finally by: [ BRgng w| | Ascending [v]

2. Choose an option from the Sort By drop-down list to specify the first-
level sort criterion.

3. Select the sorting order (Ascending or Descending).

Ascending sort order means from A-Z or from the smallest number to
the largest number. Records with no information in the field used for the
sort appear first. Descending means from Z-A or from the largest number
to the smallest number. Records with no information in the field used for
the sort appear last.

4. Choose a second field option from the And Then By drop-down list
and specify Ascending or Descending.

5. If you want a third level of sorting, choose a field from the And
Finally By drop-down list and specify Ascending or Descending.

6. Click OK.

/3
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Chapter 6

The ACT! Lookup: Searching

for Your Contacts

In This Chapter
Understanding the basic ACT! lookup

Querying companies, groups, and opportunities

Special searching

Performing advanced queries

If all roads lead to Rome, surely all processes in ACT! lead to the lookup. A
lookup is a way of looking at only a portion of the contacts in your data-
base, depending on your specifications. A good practice in ACT! is to perform
a lookup first and then perform an action second. For example, you might
perform a lookup and then print some labels. Or you might do a lookup and
then perform a mail merge. Need a report? Do a lookup first! In this chapter, I
show you how to perform lookups based on contact information, notes and
history information, and advanced query information.

ACT! Is Looking Up

A\

The theory behind the lookup is that you don’t always need to work with all
your contacts at one time. Not only is working with only a portion of your data-
base easier; at times, doing so is absolutely necessary. If you're changing your
mailing address, you probably want to send a notification to everyone in your
database. Comparatively, if you're running a special sales promotion, you prob-
ably notify only your prospects and customers. And if you're sending over-
priced holiday gift baskets, you probably want the names of only your very
best customers.

Most computer programs use the term guery to indicate the result of a data-
base search. However, ACT! generally uses the term lookup. Feel free to use
the terms interchangeably.
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Don't create an extra database —
Use the ACT! lookup instead

Some ACT! users originally create several data-
bases, not realizing that one database can be
used to store information about various types of
contacts. Although you might want to create two
separate databases —for instance, one for cus-
tomers and one for vendors — a better alterna-
tive is to include both your customers and
vendors together in one database. To this one

contacts, including prospects who aren‘t yet cus-
tomers or referral sources that might lead to new
customers. Just make sure that each contact is
identified in some specific way; | recommend
using the 1D/Status field. Then when you want to
see only vendors or only prospective customers,
simply perform a lookup to work with just that
particular group of contacts.

database, you can then add a few miscellaneous

In ACT!, you can focus on a portion of your contacts by

v Creating basic lookups based on the information in one of the ten most-
commonly used contact fields in ACT! or from any one of your ACT! con-
tact fields. (See the later section, “Performing Basic Lookups.”)

v Conducting a query based on information stored in your groups, compa-
nies, and opportunities. (See the later section, “Searching Your Groups,
Companies, and Opportunities.”)

v Creating lookups based on information from other areas in your data-
base, including notes, histories, activities, annual events, and contact
activity. (See the later section, “Performing Special ACT! Lookups.”)

v Creating your own, more advanced, queries based on the parameters of
your own choosing by using logical operators. (See the later section,
“Creating Advanced Queries.”)

Performing Basic Lookups

The easiest way to pose a query is to choose one of your main contact fields
from a menu and then fill in the search criteria. Although this way is easy
because the menus guide you, it’s also the least flexible way. The Lookup
menu that ACT! provides is probably the best — and simplest — place to
start when creating a lookup; just follow these steps:

1. Choose the Lookup menu from the Contact Detail window.

Figure 6-1 shows you the Lookup menu that drops down and the criteria
that you can use to perform your lookup.
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2. Choose one of the criterion listed in Figure 6-1 to create a basic
lookup.

The ACT! Lookup Contacts dialog box appears, as shown in Figure 6-2.

Lookup Contacts | <]

Look i this field Search fior

1D#5tatus “ ) |05 tatus
Frozpect |

For the euirent lookup ) Emphy field

| Replace Laakup » " Noreempty field
Include Private:

Inzlhude lsers

Cahcel

3. (Optional) If you're searching based on an Other field, click the Look in
This Field drop-down arrow and choose a field from the drop-down list.

If you come from a long line of right-clickers, you might prefer to simply
right-click whatever field for which you want to create a lookup and then
click Lookup. Sharp as a tack, ACT! opens the Lookup Contacts dialog
box with your field already selected in the Look in This Field text box.
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4. In the For the Current Lookup area, select an option:

® Replace Lookup: Creates a brand-new lookup based on your
criteria.

e Add to Lookup: Adds the contacts to an existing lookup based on
your criteria. For example, if you create a lookup for your contacts
based in Chicago, select this option to add your New York clients
to the set of Chicago clients.

e Narrow Lookup: Refines a lookup based on a second criterion. For
example, if you create a lookup of all your customers, you could
select this option to narrow the lookup to only those customers
based in Philadelphia.

5. (Optional) Check one or both of the check boxes in the For the
Current Lookup area:

¢ Include Private: Includes Private records in your search.
¢ Include Users: Includes users of the database in your search.
6. In the Search For area, select an option:

e Field Name: The label for this field changes, depending on the field
you choose in Step 2 or 3. In Figure 6-2, 'm searching for an ID/Status,
so the field name reads ID/Status. Choosing this option makes a
blank field magically appear. Type the word to search for or select a
word from the drop-down list to look for contacts that match a
specific criterion.

e Empty Field: If you're looking for contacts who don’t have any data
in the given field — for example, people who don’t have an e-mail
address — choose this option.

e Non-Empty Field: If you want to find only those contacts who have
data in a given field — for example, everyone who has an e-mail
address — choose this option.

P When typing in the match criterion, remember that with ACT!, less is
more. ACT! automatically searches by the beginning of your string.
For example, typing Tech for the company name returns Tech Benders
and Technology Consultants. However, typing Technology returns only
Technology Consultants.

7. Click OK.

If only one contact record matches your search criteria, that’s the record
you see. However, if several contact records match your criteria, the
Contact List appears with a list of all your matches. In either case, the
record counter now reflects the number of contacts that match your
search criteria.

8. (Optional) Choose Lookup=>All Contacts when you’re ready to once
again view all the contacts in your database.
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Build a better query

From time to time you might find that you can't  »~ Formatting: ACT! can't search for a word in
find what you're looking for, even though you a note or history that you've bolded and
know that the information is lurking in your data- changed to a red font.

base — somewhere. By default, ACT! uses the
starts with query, which means the information
you're seeking must start with the information
you type into the Search For box. However, you
have a few tools at your disposal that help give  ©~ The % for complex queries: The percent sign
a bit more flexibility to your lookups: (%) is the universal wildcard. $Carolina
returns both South and North Carolina; B$1
returns bill, ball, and bealle.

v+ Phone fields: Search for the simple phone
number string (5614705500) rather than
a formatted one (561-470-5500).

v Multi-select drop-down lists: These search
by “contains” rather than “starts with.” For
example, if some of your contacts have an
ID/Status of both Customer and Friend, a
search by friend will return all those contacts.

<® Don’t panic right after performing a lookup, wondering what happened to the
rest of your contacts. You can always reassure yourself by doing a lookup of
All Contacts after each and every one of your lookups. Although this won’t
hurt anything, this step is entirely unnecessary. After you finish working with
your current lookup, you can simply wait until you need to create another
lookup. Just do a lookup for your next criterion and save yourself a step.
Confused about the field that you used in creating your lookup? A gander at
the bottom-left corner of either the Contact Detail or Contact List screen indi-
cates the search field that you used.

Searching Vour Groups, Companies,
and Opportunities

Probably the most common lookups you create are based on your contact
fields. However, you aren’t limited to searching by just those fields. You can
also query your groups, companies, and opportunities for key information.
The best part is that all three queries work in pretty much the same way.

Grappling with your groups

When performing a Group lookup, you might look for the name of one spe-
cific group or for a group or groups that all contain the same information. In
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|
Figure 6-3:
The Lookup
Groups
dialog box.
|

other words, I might look for all groups whose names start with Technology,
or [ might look for all groups that are located in New York City. To find the
groups that match your search criteria, here’s all you need to do:

1. Choose Lookup=>Groups and then choose from the following options:

e All Groups: Opens the Group List showing you a list of all the
groups in your database.

e Name: Finds all groups that match the name you specify.

e Other Fields: Allows you to search through any and all group fields
for the groups that match your desired criterion. The list shows all
group fields that you can search in the database.

e Save Lookup as Group: If you just created a lookup (as I describe in
the preceding section) and want to save your results into a new
group, this is your option. You can also see other ways to create
Groups in Chapter 20.

¢ Advanced Query: Use this option if you want to base your query on
multiple group fields.

If you choose the All Groups or Save Lookup as Group option, you're fin-
ished. If you choose the Name or Other Fields option, the Lookup
Groups dialog box opens, as shown in Figure 6-3. You have to continue
along your merry way following these remaining steps.

Lookup Groups

Laiok.in this fizld

Graup Mame

For e eument lnokup

Replace Lookup

Search for
%) Group Mame
Friends w
) Emply field
" Norrempty field

| Cancel

2. In the Look in This Field area, select the Group field you want to

query from the drop-down list.

. In the For the Current Lookup area, choose the Replace Lookup

option.

. In the Search For area, type the word to search for or choose a word

from the drop-down list.

. Click OK.

Like magic, the Group List pops open, displaying a list of all the groups
that match your specifications.
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Calling all companies

Hopefully, creating a lookup of companies seems vaguely familiar because it is so
similar to creating a group lookup. To find the companies that match your search
criteria, here’s all you need to do: Choose Lookup=>Companies and then choose
from one of the options. The choices are almost identical to the contact lookup
choices and include the ability to search for all companies or by company name,
phone number, city, state, ZIP code or ID/Status. You even see the Save Lookup
as Company option that lets you create a company based on the currently dis-
played contact. In Chapter 21, I show you other ways to create a company.

The Company Lookup works the same way as the Group Lookup. If you choose
the All Companies or Save Lookup as Company option, you're finished. If you
choose any of the other options, the Lookup Companies dialog box opens.
From there, you can follow the same steps that you did for the Group Lookup.

Ogling your opportunities

Those of you who aren’t using ACT! to help keep track of all your past, pending,
and future sales can skip this section. However, if your company has an active
sales force, you’ll want to run (don’t walk) to Chapter 19 to read everything there
is to know about ACT!’s cool Opportunity feature. After an opportunity is cre-
ated, you can search through all your sales opportunities in a variety of ways.

1. Choose Lookup~>Opportunities.

2. Choose one of the following options:

e All Opportunities: Opens the Opportunity List, showing you a list of
all the opportunities in your database.

e Name: Finds opportunities that match the name you specify.
Typically, you want to use the quote number as the name of your
quote so that you can look up based on that criterion. Chapter 19
shows you how to name your quotes.

e Stage: Finds opportunities that match a specific sales stage.
¢ Product: Finds opportunities that pertain to a specific product.

e Total: Finds opportunities that match the total sale you specify.
You can also search for opportunities that are larger or smaller
than a specified dollar amount.

e Status: Finds opportunities that match a specific sales status.

® Record Manager: Lets you find any of the opportunities that are
associated with any one particular user.

e Other Fields: Finds all opportunities that match any other opportunity
fields, including the eight opportunity fields that you can customize.
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|
Figure 6-4:
The Lookup
Opportunities
dialog box.
|

If you choose the first option, you’re whisked away to the Opportunity
List. If you opt for one of the other options, the Lookup Opportunities
dialog box appears, as shown in Figure 6-4. If you're getting bored, I apol-
ogize — ACT! is just so darned consistent that you're probably finding
that querying your sales opportunities is every bit as easy as any of the
other lookups I cover throughout this chapter.

Lookup Opportunities 5]

Laiok- i this fizld Search for
Stage “ (%) Stage
Megotistion w

For i rutrent Innkup ) Emply field

Feplace Lookup it (73 Noreempty fild

| Cancel

3. From the Look in This Field drop-down list, select the field on which
you want to search.

The list shows all opportunity fields that you can search.
4. Select Replace Lookup from the For the Current Lookup drop-down list.

5. In the Search For area, type the word to search for or select a word
from the drop-down list.

For example, if you're looking for all opportunities that are in the
Negotiation stage, select Stage from the Look in This Field drop-down list
and Negotiation from the Stage drop-down list. To find out how well your
various gift baskets are selling, choose Product Name from the Look in
This Field drop-down list and type %basket in the Product Name box.

The percent sign (%) is the wildcard that allows you to search for all your
baskets, including Balloon Basket and Birthday Basket Extraordinaire. For
more information on using the percent sign, see the sidebar, “Build a
better query,” earlier in this chapter.

6. Click OK.

Although you might be as happy as a little clam when you’re using the
Opportunity lookup, you can achieve the same results by filtering your
Opportunity List. Filtering might even make you ecstatic because you’ll prob-
ably find it a bit easier and much more flexible. Chapter 5 shows you how to
filter your Opportunity List. Chapter 19 will further astonish you when it
reveals some of the other great Opportunity party tricks!
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Performing Special ACT! Lookups

The ability to perform a simple lookup based on a single field criterion is an
element common to most databases, but ACT! isn’t your average database. All
databases contain fields, but only special databases contain things, such as
notes and activities. And after creating a note to store a useful tidbit of infor-
mation (which I show you how to do in Chapter 7), you might want to find that
information again. Some of you might want to use ACT! to send monthly birth-
day and anniversary greetings. ACT! provides you with three special query
options to find information that was entered into ACT! in a special way.

Searching by keyword

A keyword search can be an extremely useful way to find data about your con-
tacts no matter where that information might be lurking. In fact, I've gotten
many ACT! users to start calling this search the “Senior Moment” search. As
your database increases, you might find yourself in a situation in which you can
remember only one tiny piece of information about a contact. ACT!'s keyword
search enables you to dig for that information in the Activities, Opportunities,
Histories, Notes, and Fields portions of ACT!. For example, suppose that you're
looking for someone to design a new logo for your business but you can’t
remember where you stored that information. Is logo part of the company’s
name, did you enter it into the ID/Status field, or did you stick it in a note some-
where? A keyword search searches throughout your database, checking all
fields, until it finds the word logo.

Here’s how to perform a keyword search:

1. From the Contact Detail window, choose Lookup~>Keyword Search.
The Keyword Search dialog box opens (see Figure 6-5).

2. In the Search For area, enter the key piece of information that you're
searching for.

3. In the Record Type drop-down list, indicate whether you’re looking
for Contact, Group, or Company records.

4. In the Search These Records area, choose an option.

You can have ACT! search through All Contacts, the Current Contact, or
the Current Lookup.
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5. In the Look In area, select all options that apply.

The keyword search is a powerful searching tool, and it does take a bit
longer to run than other searching methods. When you perform a key-
word search, ACT! sifts through every last bit of information in your
database, hoping to find a match that fits your specifications.

To speed up the process, limit the amount of elements to search. You
can limit your search to Activities, Opportunities, Histories, or Fields.

. After making all your choices, click the Find Now button.

ACT! responds with a list of records, similar to what’s shown in Figure
6-5. The lookup results show the contact’s name and company, the field
in which ACT! finds the matching data, and the data that it finds.

. Decide what you want to do with the results.

Like the old saying goes, be careful what you search for because you just
might find it! Okay, the saying doesn’t go exactly like that, but after you
find a number of records via the keyword search, you must decide which
one(s) to focus on. Here are some of your options:

e All records: Click the Create Lookup button to see all the records in
the Contact Detail window. This is by far the coolest choice. When
ACT! places you in the Contact Detail window, your search crite-
rion will be selected. So, if you search for basket, ACT! might just
land you on the contact’s Opportunities tab with the appropriate
opportunity highlighted. If, however, the contact’s company name
contains basket, ACT! highlights that field in the Contact Detail
window.
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e Single records: Double-click any part of a single record, and you
land on that contact record. To get back to your search, double-
click the Keyword Search tab that now appears in the bottom-left
corner of the Contact Detail window.

e Multiple adjacent records: Select multiple adjacent records by click-
ing the first record, pressing Shift, and then clicking the last
record. Right-click one of your selections and choose Lookup
Selected Records. You now have a lookup that consists of only the
contacts that you selected.

® Multiple non-adjacent records: Select records that aren’t adjacent by
clicking the first record, pressing Ctrl, and then clicking the other
records that you want. Right-click one of your selections and
choose Lookup Selected Records. You now have a lookup that con-
sists of only the contacts that you selected.

Annual event lookups

In Chapter 13, I show you how to create Annual Event fields. Annual events
help automate the processes of tracking important dates, such as birthdays or
anniversaries. When you enter a date in an Annual Event field, ACT! automati-
cally tracks the event date from year to year. Because annual events don’t
appear on your calendar, you must perform an Annual Event lookup to display
them. You can use the Annual Event lookup to generate a printed list to dis-
play events for the current week, the current month, or a specified date range.

Combining the power of an Annual Event lookup with an ACT! mail merge is a
great way to save lots of time. Birthdays and anniversaries are good exam-
ples of annual events; like it or not, they happen once per year. The Annual
Event lookup tracks them all down regardless of the year. You fellows out
there will be happy to know that you need only ask a woman her birthday
because the year is optional. (I show you how to perform a mail merge in
Chapter 11.)

Here’s all you need to do to create an Annual Event lookup:

1. From the Contact Detail window, choose Lookup=>Annual Events.
The Annual Events Search dialog box opens, as shown in Figure 6-6.
2. Select an annual event from the Search For drop-down list.

If you've added more than one annual event field to your database, you
can search for more than one of them at a time by selecting each one or
by selecting the All option to search through all your annual event fields.
For example, you might want to find everyone who has either a birthday
or an anniversary in the month of June.
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3. Choose a Time Range option in which you want to search.
Your options are the current week or month, or a selected date range.
4. Click the Find Now button.

The results appear in the lower half of the Annual Events Search dialog
box. Your results vary, depending on the number of contacts that meet
your search criteria. And, as you might notice in Figure 6-6, the results
are based on the day and month but not on the year. If no contacts meet
your search criteria, you receive a message nicely telling you so.

5. Select one of the following option buttons:
* Go To Contact: Go to the contact record of the selected contact.

e Create Lookup: Create a lookup of all the contacts. Now that you
have a list of all the contacts that match your date range, you can
easily print out a set of labels (Chapter 10) or send out personal-
ized birthday e-mails (Chapter 11) based on this lookup.

e Schedule To-Do: Schedule an activity for the selected contacts.
Unfortunately, you can schedule an activity for only one contact at
a time.

e Print List: Print a list of the contacts.

Searching by contact activity

I've often estimated that at least 20 percent of the average database consists
of long-lost contact information. You can either ignore these forlorn contacts,
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|
Figure 6-7:
The Contact
Activity
dialog box.
|

or you might realize that there’s gold in them thar hills! What if you could find
all the contacts that you haven’t contacted in, say, the last two years?
Chances are that many of those contacts will be glad to hear from you.
Maybe they lost your contact information or chose a company other than
yours that they weren’t happy with. Suddenly those “lost” contacts have
become a virtual treasure trove.

You can create a lookup of contacts based on the last time that you made any
changes to their record or contacted them through a meeting, call, or to-do.
You can look for the contacts that either have or have not been changed
within a specified date range. You can also narrow the search according to
activity or history type.

To create a lookup by contact activity, follow these steps:

1. Choose Lookupr>Contact Activity.

The Contact Activity dialog box opens, as shown in Figure 6-7.

Contact Activity
Look for Contacts that have:
(%) Not Changed
() Changed
Since Date
| 1112007 w
Search In
Contact fields
Mootes
Opportunities
Histaries
Al »
Activities
Al »

2. Select either Not Changed or Changed in the Look for Contacts That
Have area.

The neat thing about using the Contact Activity lookup is that you can
look for “touched” or “untouched” contacts. In other words, you can
search for all the contacts that you contacted in a certain time frame or
for all the contacts that you haven’t contacted in a certain time frame.

3. Select a date.

The date tells ACT! to look for records that have been changed — or
have not been changed — since that date. In Figure 6-7, I'm looking for
contacts that [ haven’t changed since January 1, 2007.
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4. Select one or more options in the Search In area to narrow your
search.

You can search in the Contact fields, Notes, Opportunities, Histories, or
Activities areas of ACT!.

If you decide to search through your History and/or Activities tabs, you
can even indicate which specific types of histories or activities you want
to include in your search.

Many users make the mistake of using only a portion of ACT! — and then
find out later that they can’t take advantage of some of its coolest features.
In order for this search to work, you have to input information in the
appropriate spots. For example, you can’t look for modified Opportunities
if you never created them!

5. Click OK.

ACT! searches for the selected field or activity that was/was not modi-
fied within the specified date range. The Contact List appears and dis-
plays your selection.

ACT! searches through all your contact fields, notes, histories, and oppor-
tunities, so it might take a moment or two to create your search results.
Relax and practice a few deep-breathing exercises while you wait.

In Chapter 4,  mention some of the system fields; these are the fields that
ACT! fills in for you automatically. These fields are easily identifiable because
they’re grayed out. Although you can’t change the information in these fields,
you're free to create lookups on them. For example, every time you change
any of the information for a contact, ACT! automatically updates the Edit Date
field. Feel free to give any of the system fields a right-click and search on
them. For example, if you're looking for all the contacts that have been cre-
ated since before or after a given date, give the Create Date field a right-click!

Creating Advanced Queries

You might want to consider the two lookup options in this section to be
“powerful” but not “advanced;” many of you might associate advanced with
difficult, and that’s certainly not the case here.

If you need to base your lookup on multiple criteria, you can perform a basic
lookup and then use the Narrow or Add to Lookup options in the For the
Current Lookup drop-down list (refer to Figure 6-2) in the Lookup Contacts
dialog box to create a more specific search. This option works fine if you're
willing to create several lookups until you reach the desired results. A better
alternative is to use a query to create a lookup. In ACT!, a query searches all
the contacts in your database based on the multiple criteria that you specify
and then creates a lookup of contacts that match those criteria.



Chapter 6: The ACT! Lookup: Searching for Your Contacts 89

Looking up by example

The Lookup by Example function allows you to create an exact profile for the
contacts you’re hoping to find. For example, you might want to have a look at
all customers in the state of Arizona who originally found out about you
through a phone book advertisement. When you create a Lookup by
Example, ACT! responds by presenting you with a blank contact record and
lets you specify the fields and values that define the query.

This is what you do:

1. Choose Lookup~>By Example.

The Lookup By Example window opens. The Lookup By Example
window, as shown in Figure 6-8, looks just like any other contact record
with one major difference — all the fields are blank.

Lookup By Example =]
Lookup By Example
Type one kepword et field to perfom a lookup. To use more than one keyword per field, click the Sdvanced Quety button
Company Address ID/Status  Customer | 2
Conkact Referved By Phone Book. |
Salutation Key Contact ’j Customer 1D
Title oy Fity | First Purchase Teel
Department ™ State A7 1| Last YearsPurchases
Phone [ Ent ZIP Code Trivia
Mabile D Touritry |
Fax D WebSite |
Bl ) E-mail
Last Results - | Last Edited by -
Mokes | History | ctvkies | Oppertuntes | sroups | Secandaty Contacts | Docunents | ContectInfo | e Fiskds | Home Adhess |
E— Record Manager vl Recordcrestor  [Karen Fredricks
£ furs Create Date v
Figure 6-8: bl
The Lookup Fifate
imit=d Access
By Example SR
window is
similarto a
contact
record, but
it's blank.
[Advanced Query| | mlear Seaich | Eancel
|
2. Click in the field that you want to query.
. . . 9
<® You can create a query on virtually any field in your database. Don’t

forget to check out some of those neat fields that might be located on
your various layout tabs. For example, the Contact Info tab contains the
Record Manager and Create Date fields, which are common things to
query.



9() Partil: Putting the ACT! Database to Work

3. Fill in any criteria on which you want to search.

Fill in as many criteria as you need. The whole purpose of doing a
Lookup by Example is that you're looking for contacts that fit more than
one criterion. If you're looking for all customers who are located in
Arizona, type customer in the ID/Status field and AZ in the State field.

4. Click the Search button when you’re ready to put ACT! to work dig-
ging through all your contact records.

ACT! happily displays a list of all the contacts that match your search
\BE criteria in the Contact List.
R
\‘&
& [ mention various query tools in the “Build a better query” sidebar. Those
tools work in the Lookup By Example dialog box.

The Advanced Query

After you use your database for a while and it slowly but surely fills up with
more and more contacts, you might feel the need to add a little more power
to your lookups. You also might find yourself constantly creating the same
lookup and wish to save it to save yourself a little time later on. In fact, you
might even start using the term query, which is computer-speak for fancy
lookup. Fortunately for you, although an Advanced Query packs a lot of
power, it’s still a piece of cake to run. Just follow these steps:

1. Choose Lookup->Advanced~>Advanced Query.

The Contact Criteria window opens, as shown in Figure 6-9.
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If you want to really speed your way through creating an Advanced
Query, you can start by entering your basic criteria into the Lookup By
Example dialog box (refer to Figure 6-8) and then clicking the Advanced
Query button in the lower-left corner.

. Select Contact, Company, or Group from the Search For drop-down list.

You can create a query based on your contact, company, or group
records.

. (Optional) If you select Contact in Step 2, choose Contact or

Opportunity from the Type drop-down list.

Because you associate an Opportunity with a contact record, the
Advanced Query allows you to query on both Opportunity and Contact
fields at the same time.

. Select one of the available fields from the Field Name drop-down list.

To make life easy for you, you find all your fields listed in the Field Name
drop-down list.

. Select one of the operators in the Operator field.

Knock yourself out! Indicate whether you’re looking for a specific word,
a field that contains a part of a word, or even a range of figures or dates.
You can search for fields that contain some data, or for fields that are
blank and don’t contain any data.

. In the Value field, select one of the available items that corresponds to

the selected Field Name item.

If the Field has a drop-down list, you’ll be happy to discover that it’s also
available in the Advanced Query window.

. Click the Add to List button.

The query criteria appear in the columns in the middle part of the
Advanced Query window.

8. To select more than one criterion, repeat Steps 3-7.

9. (Optional) Click in the And/Or column for the item and select an

10.

option if necessary.

When you build the query, you might want to make use of the And/Or
column to help you group your criteria to indicate the relationship
between each set of criteria. In Figure 6-9, notice that the three state cri-
teria are bracketed together and joined by the word or, indicating that
you’re looking for contacts from Florida or Oregon or California.

(Optional) Use the parenthesis column if necessary.

The example in Figure 6-9 groups the three state criteria together with
parentheses so that these queries are carried out together. This is a partic-
ularly important step if your query contains both “and” and “or” criteria.
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11.

12.

13.
14.

Click Preview.

For those of you in need of instant gratification, you can see a list of all
the contacts that match your specification. If you goofed and no con-
tacts show up, you have several options available to you on the right
side of the screen:

e Edit: Use this to tweak any of the criteria.

* Move Up/Move Down: Use this to easily squeeze in another crite-
rion or two if you initially left one out.

e Remove: You can quickly remove a few of your criteria by selecting
them and then clicking the Remove button.

Choose Fileo>Save As if you want to use your query later.

The next time you want to run the same Advanced Query, you can
return to the File menu, choose Open, and open your saved query.
Contact queries have the . gry extension, group queries have the .gry
extension, and company queries have the . cry extension.

When you finish selecting criteria, click OK.

At the Run Query Options message, select the Replace Lookup option
and click OK.

The results of the query display in the Contact List or Opportunity List.

Although the process of saving and reusing an Advanced Query is relatively
easy, you can combine this process with the Menu Customization techniques
I outline in Chapter 3 to really save yourself oodles of time. Yes, Virginia, you
can most definitely add saved Queries to the Lookup menu so that you can
find all those Customers in Oregon and Florida who love red widgets!



Chapter 7
Stamping Out the Sticky Note

In This Chapter
Using notes in ACT!

Creating ACT! notes
Understanding ACT! histories

Reviewing your notes

Look around your desk. If you have more than one sticky note attached to
it, you need to use ACT!. Look at your computer monitor; if it’s decorated
with sticky notes, you need to use ACT!. Does a wall of sticky notes obscure
your file folders? Do you panic when you can’t find your pad of sticky notes?
Do you have small sticky notes clinging to larger sticky notes? You need to
use ACT!!

In this chapter, I show you how to make a note in ACT!. I also tell you all
about the notes or histories that ACT! creates for you automatically, and then
[ give you a short course in reviewing your notes.

Getting to Know ACT! Notes

What if one of your best clients calls requesting a price quote? You jot down
some information on a piece of paper, only to have the paper disappear in the
mountain of clutter that you call your desk.

Or imagine that one of your more high-maintenance customers calls you on
March 1 in immediate need of an imported Italian widget. You check with
your distributors and guarantee him one by March 15. On March 10, he calls
you, totally irate that he hasn’t yet received his widget.

Sound familiar? The ACT! note is one of the easiest features to master but one
that too many users overlook. A simple note in ACT! provides you with several
benefits. Your entire office can operate on the same page by having access

to the same client data. You have a record, down to the date and time, of all
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communications that you have with each of your contacts. You won’t forget
what you said to your customer — or what your customer said to you. You
have pertinent information at your fingertips without having to strip-search
your office looking for a lost sticky note.

Adding a note

Considering the importance of notes to the overall scheme of your business,
they are amazingly easy to add. Here’s all you have to do to add a note to a
contact record:

1. Make sure that you’re viewing the contact for which you’re creating a
note.

If you need help here, see Chapter 6 to help you look up the contact and
land in the Contacts view.

2. On the Notes tab (middle of the screen), click the Insert Note icon.

The Insert Note window appears, date- and time-stamped with the cur-
rent date and time. Your name even appears as the Record Manager (cre-
ator) of the note. Take a look at Figure 7-1.

[} Edit Note
Contac Parker, Lance [Yelow Jersay Bike Shop] ] [ Contact..
Date 519/2007 ~ Time: | 327 PM v]
Attachment
Group/Company: () RecordManager: | Karen Fredicks -
FRegarding:
= & 5| Microsoft Sans Serif|v| 16 ~A-B|7|U|F =
This is a REALLY important note. | don't want to rely on & sticky note that | might 105€ somenhere along the way!
|
Figure 7-1:
Create a
note in ACT!
here.
[ Prvate i3
|

3. Start typing your note in the Regarding area.

Your note can be as long or short as you want. You can use the format-
ting options exactly as you do in any word processor to emphasize any
portion of your note.

4. Click OK to record your note.

That was almost too easy for you; now you can move on to a few tricks that [
have up my sleeve.
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|
Figure 7-2:
A contact’s
Notes tab.
|

Working with notes

After you create a note (see the preceding section), it appears on the con-
tact’s Notes tab. If you've read Chapter 5, you're already an old hat at cus-
tomizing this tab. Being the astute reader that you are, you might notice that
the name of the person who created the note appears in the Record Manager
column. This becomes particularly important if you're using ACT! in a multi-
user environment and want to avoid playing the “he said, she said” game.

The Notes tab has an extra, added attraction to it; Figure 7-2 shows you what
[ mean.

Notes | History | Activities | Cpportunities | GroupsfComparies | Secondary Contacts | Documents | Contact Info | User Fislds | Home Address

Dates: All Dates v| .4 Select Users [-F Options ~

Date [ Time Fiegarding U |E [RecodManager Group/Campany This is a REALLY impanant note. |

5/19/2007 327PM Thisis & REALLY important note. | dan't Karen Frediicks EbiietiniEvon ol
want to rely on a sticky note that | might that | might JOS @ somewihere
1058 somewhers dlong the wayl along the wayl

EA/2006 B0 P Got his name and number from Frank. Chris Huffman

2/13/2006 443PM Heed to vistt ACT! Add-Ons website Chis Huffman
{www. act comjaddons)

2/8/2006 360 P Idea: wine basket sampler Chris Huffman

Although you can virtually write a book — or at least a relatively large note —
ACT! shows only a portion of the note on the Notes tab. The Notes tab is
designed this way to squeeze multiple notes on the tab. However, this becomes
somewhat annoying because you need to open the note in order to display its
entire contents. The extra screen on the right side of the Notes tab serves as a
viewer that allows you to see the note in its entirety without having to reopen
the note. If you select a note from the tab, you'll see that it instantly appears in
this view screen.

After you create a note, you might need to change it. To edit a note, just
double-click it to get back to the Insert Note window. After you open it, here
are a few things you can change:

v Change the note information. Start typing in the Regarding area exactly
as you do with any word processor.

v+ Change the date on a note. No matter how much you depend on your
computer, sometimes you still rely on good old-fashioned paper. Maybe
you jotted down a note after you turned off your computer for the day
or made notes — both mental and on paper — at a trade show. When
you start to input those notes into ACT!, they all have the current date
rather than the date when you actually created them. To change the
date on a note, simply click the date and choose a new date from the
calendar that appears.
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Not all notes are created equal; some of your notes might be more
important than others. As your list of notes becomes longer, various key
notes can get lost in the shulffle. A real low-tech solution is to postdate
the note by giving it a date several years into the future so that your
note always appears at the top of the Notes tab.

v~ Attach files to a contact record. In Chapter 5, I talk about adding files to

the Documents tab so that you can view and edit them right from the
Contact Detail window. In addition, you can attach a file to a note in a
contact record. To attach a file to a note, follow these steps:

a. Click the Insert New Note icon on the Notes tab.

b. Click the Attach button in the Insert Note window.

c¢. Navigate to the file that you want fo attach and then click Open.
d. Click OK to record the note.

To view the attached file, simply open the note and click the attached file.

v~ Spell-check a note. If you're like me, you type notes while doing a hun-

dred other things and end up with a lot of typos. Don’t fret; just run a
spell check by clicking the Spell Check icon in the Insert Note window.
ACT! opens the spell checker and locates any misspellings. Unfortunately,
you can check the spelling for only one note at a time.

v+ Add Group/Company info. If the note you’'re adding is specific to a

group or company, a click of this button allows you to attach your note
to a specific group or company. Later, when viewing the group or com-
pany, you can filter your notes to include just the ones that are associ-
ated with that group or company. You might want to head over to
Chapter 20 to glean insight into Groups and Chapter 21 to comprehend
Companies.

Discovering ACT! Histories

If you insist on doing things the hard way, feel free to skip this section. If you
love the thought of having someone else doing your work for you, read on!

Maybe you've noticed that the History tab is called, well, the History tab. In the
earlier sections of this chapter, I show you how to add and modify notes. ACT!'s
history entries are items that magically appear on the History tab after you

 Delete a contact (Chapter 4).

v Complete a scheduled activity (Chapter 8).

1 Write a letter, fax, or mail merge (Chapter 11).

v Create, close, or change stage in an opportunity (Chapter 19).

1 Change information in a field designated to create history (Chapter 13).
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Figure 7-3:
Change the
sales step in
the Last
Results

field.
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When you perform one of these tasks, ACT! commemorates the occasion by
creating a history entry on the contact’s History tab of the person associated
with the task. ACT! even goes so far as to include the date and time the task
took place as well as the person who did the deed. You can edit or add activ-
ity details to the history, such as adding information about the decisions
made during the meeting. View these histories again later or create reports
based on activities with your contacts.

Creating field histories

ACT! provides you with a very powerful tool when you combine the use of
drop-down lists with the ability to create a history based on the changed
information in the field. By default, ACT! automatically creates a history when
you change the information in either the ID/Status or Last Results field. When
you enter information into either of these fields, it’s automatically saved on
the contact’s History tab.

Suppose that you create a ten-step sales process to coincide with the average
progression of one of your prospects into a customer. You can change the
Last Results field’s drop-down list to reflect those ten stages. When you
progress through the sales cycle and change the content of the Last Results
field, ACT! automatically creates a history indicating when the change took
place. Figure 7-3 shows both the content of the Last Results field and the
automatic histories that are created when the contact progresses through the
sales stages.

Notes | History | Activities | Opportunities | GroupsfCompanies | Secondary Contacts | Documents | Contact Info | User Fields | Home Address
Dates: |All Dates ~ | Types: | All v |2 Select Users & 17 4l Options ~
Date Time Result Fiegarding & Details [0 TE [RecordManager Growp/Company 1|~
5/19/2007 448 PM Field Changed  Field Last Results changed Chiis Huffman Arcacia Ave. Flaiist il
Field Last Aesuilts changed fram "Fallowed up" o !
“Bualified, 0K to pursue” !
5/10/2007 947 M Field Changed  Field Last Results changed Chis Huffman Arcacia Ave. Florist i
Field Las! Resils changed from "Has a great looking
irvstore display of CH Gourmet Gt products” to ;
“Followed up" |
E/27/2006 2435M FieldChanged  Field Last Resulis changed fiom " (o "Has a great Chiis Huffman Arcacia Ave. Florist 1
looking inrstore display af CH Gourmet Gift products™ i
1/10/2008 519PM Field Changed  Last Results - Has a reat looking in-store display of Chiis Huffman :
CH Gourmet Gift products ;
|
v

By relying on the field’s drop-down list to create new content information,
you ensure that your information remains consistent. You can then create
reports on the various sales stages by creating a lookup based on the notes
and histories.

In Chapter 6, I show you everything you need to know about creating lookups —
and then some! Chapter 10 explains the various ACT! reports and shows you
how to filter them by date range.
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Clearing activity histories

In Chapter 8, I explain how to use ACT! to plan your busy schedule. After you
hold or attend a meeting, place a call, or complete something on your to-do
list, clearing the activity is important. Figure 7-4 shows you the Clear Activity
dialog box that opens each time you clear an activity.

Clear Activity
Type: To-do
Organizer: Chiiz Huffman
Participants: Jackie Jorgensen [Arcadia Ave. Florist]
Asgsociate Wwith:
Arcadia dve. Florist D
Date: Time: Diuration;
5/19/2007 | 950 AM | |5 minutes »
Regarding:
Send follow-up Letter
Results
(& Clear | To-doDone v
O Erase
Add Activity Details to History
[~ - ) = | =
= = Microsoft Sans Ser |v| 8 " A-B T UT|=
Letter sent via Express Mail
Attachment: Altach  »
[ Private Follow-up...

Select the Add Activity Details to History check box, and ACT! automatically
inserts your notes as well as the history of the event on the History tab.

ACT! provides you with the same option when you get in touch with a contact
through a letter, an e-mail, or a fax. Figure 7-5 shows the Create History dialog
box that appears after you create a letter in ACT!. Of course, you can always
choose not to include a history, but you’ll probably find recording one more
useful. You can even add more details in the Regarding area.
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Create History

Documnent Printed; Document]

Record Histary
‘Would wou lke to recard a history for this contact?
(&) ez, record history

Regarding

Sent brochures to Alyssa

[] &ttach document to histary
() N, do not record histary
Frint Ervelope
‘would you lke to print an envelope?
O)'es
& No

Cancel

Manually recording a history

Situations arise when recording a history of an event just isn’t practical. You
can create a history record for a contact without scheduling and clearing an
activity for that person. You can even add a history for someone who isn’t
yet in your database. For example, you might have called a potential new
client from your car and found juggling the steering wheel, your phone, and
your lunch while typing on your laptop a bit too daunting. However, when
you return to the office, you still need to record the calls that you made and
the tasks that you completed.

You can also record one history for an entire group of people. For example, you
might have attended a meeting at your local Chamber of Commerce and want
to record a few details about the meeting for each of the attendees. Regardless
of why you need to do it, here’s how you create a history after the fact:

1. Find the contact(s) for whom you want to record a history.

If you're creating a history for an entire group of people, create a lookup
of the contacts for whom you want to add a note and then click the Tag
All button on the Contact List.

2. Choose Contacts>Record History.

If you prefer, you can press H while holding down the Ctrl key on your
keyboard. Either way, the Record History window opens, as shown in
Figure 7-6.
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&) Record History
Type: Marketing Call M Result: | Marketing Call Completed |
Cortact Jorgensen, Jackie [Arcadis Ave, Florist] v @
Date: B/14/2007 b | Time: | 354 AM - Duratior: | 15 minutes -
Bltschment
Group/Company: Arcadia Ave. Florist; D Fiecord Manager. | Karen Fredicks
Regarding: Follow up per email v
Details:
(= = " Microsoft Sans Serif|v| 8 ~A-BJT UTF =

[+ianted to make surs thal he had recefved the sampies and that he was pleased with the qually.

I
Figure 7-6:
Record a
history here.
y [CErivate Follow-up. Cancel
I
3. Select an activity type from the Type list.
If you need more activity types, don’t worry. I show you in Chapter 13
how to increase your selection of activity types.
4. Select a Result option.
5. Click the Contact button if you're creating a history for multiple con-
tacts.
The Select Contacts window, as shown in Figure 7-7, opens.
Select Contacts
Select from
Al Contacts b
Look for:
Fredricks, Alyzsa [Mickey World]
Contacts to select from: Selected contacts:
AL Name Company |~ L Name Company
Elmendorf, Kristi Black Forest Baking Burpelson Think Tank
Federici, Anthary MiniSaft 5| Anderson. Emst CH Gourmet Gifts
3, Fenderline, Fred CH Gourmet Gifts Associations, Chocola| Chocolate Trade Association
Fiemas, Chriz Interactive Gifts Barett, Theodore erge Records
L Finch, Jean Finch Legal Aid
. . Finlay, James “widget Corporation
Flg“re 7-7' Farm, Amanda A1 Services-US Operatic
Francis, Emma Prospect Boutique
Se|ECt the Fredicks, Alyssa ickey world E
contacts fOI’ 2, Frediicks, Karen Tech Benders
amanual Lotk vy
history.
I
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This step isn’t necessary if you're creating a history for just one contact
because that contact’s name would already appear in the Contact text
box of the Record History window. Alternatively, any names you had
already tagged in the Contact List would appear as well. However, if
you're trying to record a history for the multiple contacts that aren’t
included in the lookup that you created in Step 1, you have to do a little
extra footwork.

a. Select a name from the Contacts to Select From dialog box.

You can select multiple names by holding down the Ctrl key while
you select the names.

b. Click the right-pointing arrows to move the name to the Selected
Contacts area.

¢. Click OK to return to the Record History window.
6. Enter date, time, and duration information.

7. Enter activity information in the Regarding field or select a descrip-
tion from the drop-down list.

8. (Optional) Click the Group/Company ellipsis button if you want to
associate the history with one of your Groups or Companies.

9. Add additional information in the Details area.

The information that you enter here is added to the Regarding field on
the History tab.

10. Click OK to record the history.

Your note is recorded in the contact’s record. If you created a history for
an entire group of contacts, the note appears in the contact record of
each individual in the group.

If you click the Follow-up button rather than OK, you can schedule a
new, follow-up activity in the same way that you scheduled your original
activity. Talk about one-stop shopping! The result of a call might be that
you scheduled a follow-up meeting for the next week. By scheduling a
follow-up activity, you have the results of your original meeting as well
as a reminder of the meeting scheduled in the future. You can also
schedule follow-up activities for the next step in your sales process.

Two of the most popular ACT! reports — the History Summary and the
History Summary Classic — are based directly on the history created by
ACT!. If you never create a history manually, clear a scheduled activity, or opt
to create a history after a mail merge, you're rendering these reports useless.
Find out more about these reports in Chapter 10.
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Working with Vour Notes and Histories

The Notes and History tabs are very similar; consequently, you can use them
in similar ways. They're so similar, in fact, that in previous versions of ACT!,
they’re actually combined into one single tab. Here are a few things that you
can do to edit your notes and histories:

v Delete a note or history. To delete a note or history, you must first
select it and then press Delete. You can also right-click the selected note
and choose Delete Selected from the contextual menu. Either way, ACT!
presents you with a warning before you remove the note permanently.

v Delete several notes and/or histories. Eventually, you want to delete
certain notes or even histories. To delete several notes in one fell
swoop, just select the notes that you want to delete and then press
Delete.

e [f you're selecting several contiguous notes, click the first note and
then press Shift while clicking the last note that you want to delete.

e [f the entries aren’t contiguous, press Ctrl while clicking each note
individually.

V?‘“‘NG! Now that you know how easy deleting a history is, you might want to
S prevent other users of your database from deleting them. If you're the
database Administrator, choose Tools=>Preferences. Then on the
General tab, remove the check mark next to the Allow History Editing
option.

1 Copy a note. When you find duplicate contacts in your database, you
probably want to delete them — but not any notes attached to them. Or,
maybe you want a note from one contact record also attached to
another record. Luckily, ACT! gives you the ability to copy or move
notes from one contact to another contact with a simple copy or cut-
and-paste procedure:

a. Highlight the notes or histories that you want to copy or move and
then press Ctrl+C to copy or Ctrl+X to cut.

b. Find the contact where you want to insert the copied notes. Then on
the Notes or History tab, press Ctri+V.

If you're feeling somewhat artistic, in need of a change, or just plain having
trouble with your 40-something eyesight, you might want to either add grid-
lines around your notes or change the color and/or font style. Or, you might
just decide to walk on the wild side and change the whole ball of wax. Take a
stroll down preference lane to accomplish this:
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. Choose Tools=>Preferences from any ACT! screen.

The Preferences dialog box opens.

. Click the Colors and Fonts tab.

. Click the Notes tab.

. Click the Font button to select a different font, style, or size.

. Click OK to close the Font window.

. Choose a text color and background color from the Appearance area.

. To have gridlines appear on the Notes tab, select the Show Grid Lines

check box.

The ACT! gridlines are just like the gridlines you see in Excel. If you
change your preference to show gridlines, horizontal lines appear
between each of your notes and vertical lines between columns.

8. Repeat Steps 3-7 for the History tab.
9. Click OK.

Your Notes and History tabs are now modified according to the prefer-
ence settings that you selected.
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Chapter 8
Playing the Dating Game

In This Chapter

Scheduling activities

Viewing ACT! calendars
Putting the Task List to work
Sharing your activities with others

Creating an activity series in ACT!

n this chapter, I show you how to schedule activities with your contacts,

how to view those activities and modify them if necessary, and even how
to find out whether you completed a scheduled activity. You also discover
the intricacies of navigating through the various ACT! calendars, how to use
your Task List to keep you on top of your activities, and the joy of sharing a
list of your scheduled activities with others.

Scheduling Your Activities

One of the most useful of ACT!’s features is its ability to tie an activity to a con-
tact. Most basic calendaring programs allow you to view your appointments
and tasks on your calendar, but they don'’t offer a way of cross-referencing an
appointment to a contact. For example, if you schedule an appointment with
me and forget when that appointment is, you have to flip through your calendar
until you see my name. Plus, you can’t easily see a list of all appointments that
you’ve ever scheduled with me. However, ACT! offers these helpful features.

In ACT!, every activity is scheduled with a specific contact. If the contact
doesn’t exist in your database, you must add the person to your database —
or schedule the appointment with yourself.
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Figure 8-1:
Schedule an
activity in
ACT! here.

Here’s what you do to add an activity to your busy schedule:

1. Go to the contact with whom you’re scheduling an activity.

Here’s the drill. You create a lookup (I show you how in Chapter 6) to
find a prospect’s phone number. You call the guy, and afterward, you
want to schedule a meeting. At this point, you're already on the contact
record of the person with whom you’re scheduling an activity.

. Schedule a call, meeting, or to-do in one of three ways:

e Click the Call, Meeting, or To-Do icon on the toolbar in the Contact
Detail window or the Contact List.

¢ Choose Call, Meeting, or To-Do from the Schedule menu in just about
any ACT! view.

e Double-click the appropriate time slot on any ACT! daily or monthly
calendar.

Using different methods to schedule different activities is a smart plan of
action. For example, | recommend scheduling meetings through the cal-
endars to make sure that you don’t have a conflict for a specific time
slot. When you’re scheduling calls and to-dos, however, which are gener-
ally “timeless” activities that don’t have to be set for a specific time, you
can simply click the corresponding icon on the toolbar.

In any case, all roads lead to the Schedule Activity dialog box, as shown

in Figure 8-1.

Schedule Activity
Options ~
General | Details | Recurence | Availabilty |
Achivity Type: Start Date: Start Time: Duration:
Meeting w | | B/20/2007 s | [12:00PM | |1haur |
End Date: ) End Time: )
£/20/2007 v| [T00PM v| []UseBanner
Scheduls With
e, Gary e
Azsociate WWith:
CH Gourmet Gifts; El
Regarding:
Conkract Negotiations '3
Resources: Location:
Mone ~
Priarity: Color: Ring Alarm:
High | .D 15 minutes |+] Schedule For..
fise
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3. On the General tab, fill in the various options.

If options is your name, ACT! is your game! The Schedule Activity dialog
box offers a myriad of scheduling options from which to pick, and ACT!
has thoughtfully filled in many of these options based on your default
scheduling preferences. (Chapter 3 walks you through changing some of
these preferences.) You can leave the information in the following fields
as is or override the default preferences:

¢ Activity Type: Choose Call, Meeting, To-Do, Personal Activity, or
Vacation from the drop-down list.

e Start Date: Click the arrow to the right of the field to display the cal-
endar and select the date of the big event.

e Start Time: Enter a start time for the event. Choose Timeless for the
Start Time if you're scheduling a call or to-do that doesn’t need to
occur at a specific time.

¢ Duration: Click the arrow to the right of the field to choose the
duration for the activity. You can also manually specify a time
range; an hour-and-a-half-long meeting can be entered as either 90
mor 1.5 h.

The End Date and End Time are set automatically based on the
starting date and time you specify. If you change the duration, ACT!
automatically adjusts the end date and time.

e Use Banner: This option lets you display a banner on the monthly
calendar if an activity involves one or more full days.

e Schedule With: The name of the current contact automatically
appears here. Select a different contact by typing the first few let-
ters of a contact’s last name to locate the contact in the list.

If you click the Schedule With drop-down list, you’ll notice that the
names appear alphabetically by last name. If you're having trouble
remembering someone’s last name, simply click the Company
column heading to arrange those contacts alphabetically by com-
pany. You can then type the first few letters of a company name in
the Schedule With box.

e Contacts: Click the Contacts button and then choose Select
Contacts to select more than one contact, New Contact to add a
new contact, or My Record to schedule a personal appointment.

¢ Regarding: You'll want to give a brief description of the activity
because it’s later reflected on the contact’s History tab. Type it
here or choose an item from the drop-down list.
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<® The Regarding drop-down list reflects the Activity Type that you
choose, so scheduling a Call gives you different options from
scheduling a Meeting. Don’t like the items in the drop-down? As
usual, you'll find the Edit List Values options button. Click it to
create your very own customized drop-down list for each one of
the activity types.

® Resources: If you're using ACT! Premium 2008, you can place first
dibs on shared commodities, such as the conference room, LCD
projector, or the office stash of candy bars.

e Location: It never hurts to let everyone know, including yourself,
where the big event will take place.
W e Priority: Choose High, Medium-High, Medium, Medium-Low, or Low.
Don’t see the Medium-High and Medium-Low options? Chapter 13
shows you how to customize your Priorities list.

e Color: Click the arrow to the right of this field to display a color palette
and then choose the color that you want to assign to the activity. Feel
free to design your own system of color-coding your calendar.

* Ring Alarm: Enabling this sets an alarm to remind you of a sched-
uled activity at a specified interval before the event.

e Schedule For/By: Click this button to assign a task to one of your co-
workers (as if ACT! hasn’t made life easy enough for you already?).

4. (Optional) Click the Options button.

Click the Options button (top-right of this window) and select one of
these options:

e Confirm the activity with the contact(s) involved by selecting the
Send Activity E-mail to Contacts option. ACT! automatically opens an
e-mail message filled in with the critical details in the body of the
e-mail, like the one shown in Figure 8-2, and includes an attach-
ment in ACT! format. When the e-mail recipient receives the e-mail,
he can double-click the attachment (the instructions for this are
also included in the body of the e-mail) and have the activity auto-
matically placed in his ACT! calendar.

¢ Create a separate activity for each participant if you're scheduling
your activity with more than one contact.

5. (Optional) On the Details tab, add additional details and print the
details.

These are two relatively important tasks:

¢ Details: Add additional information regarding an activity. For exam-
ple, you might want to add special instructions about the items
that you need to bring to a meeting.

e Print: This is where you can print the activity details.
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6. On the Recurrence tab, designate the activity as recurring if that’s the
case; otherwise, go to Step 7.

If the activity that you're scheduling repeats on a regular basis, you can des-
ignate it as a recurring activity rather than setting up several separate activi-
ties. For example, if you're taking a class that meets once a week for the
next 12 weeks, you can designate the class as a meeting with a weekly recur-
rence. Be sure to specify the date on which the activity stops recurring.

Here are the recurring option settings:

¢ Daily: Select to schedule an activity that occurs daily and the date
on which the activity stops.

e Weekly: Select to schedule an activity that occurs weekly, on which
day or days of the week the activity is scheduled, and the date on
which the activity stops.

e Monthly: Select to schedule an activity that occurs monthly by indi-
cating the week in the month, the day of the week, or the specific
day of the month on which the activity will be occurring and the
date on which the activity stops.

e Yearly: Select to schedule an activity that occurs every year, and
the date on which the activity stops.

\P
) The Annual Event field can eliminate the need to set reminders for

activities, such as birthdays, anniversaries, and renewal dates.
Find out how to set up an Annual Event field in Chapter 13.
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7. Click OK.

You have a real, live scheduled activity!

After you create activities, ACT! is a worse nag than your mother! You can see
your activities — and ACT! reminds you to complete them — in a number of
ways:

v Alarm: If you asked ACT! to ring the alarm when scheduling an activity,
the ACT! Alarms window appears at the specified time before the activ-
ity is due. It also appears each time that you open ACT!.

v Per contact: The Activities tab for a selected contact enables you to see
what specific activities you scheduled with that particular contact.

v All contacts: The Task List shows a listing of everything you scheduled
for all your contacts during a specified time period.

v Calendar: All ACT! calendars — including the monthly, weekly, and daily
views — show a listing of the current day’s activities.

Later in this chapter, in the section “Exploring Activities,” I show you how to
view, edit, clear, and share your scheduled activities.

s@N\BEH Regardless of your method of viewing your activities, remember this tip: When
& frustrated, check your filters. If you're just not seeing everything that you know
is supposed to be showing in your calendar, check your filters! Not seeing any-
thing scheduled for the future? Maybe your date range is set to show the
activities for today only. Seeing too much? Perhaps your filters are set to show
everyone’s Task List or calendar. Not seeing any of your activities at all?
Perhaps your filters are set to include everything except your own activities!
Flip to Chapter 5 if you want a refresher course in those frustrating filters!

Working with the ACT! Calendar

The various ACT! calendars are great for viewing scheduled tasks. Here are a
couple of ways to get to your calendars:

v+ From any ACT! screen, choose Viewr>Calendar and specify the type of
calendar that you want to view.
v Click the calendar icon on the Navigation (Nav) bar.

You can view your calendar in any one of four different ways, depending on
which way you feel the most comfortable:

v+~ Daily calendar: Shows you the time-specific activities of the selected
day as well as a listing of the day’s tasks. (See Figure 8-3.) The day is
divided into half-hour intervals.
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Not happy with half-hour intervals? No problem; you can change that
default setting in ACT!’s preference settings. Not sure how to do that?
Take a peek at Chapter 3 to tweak your preferences.

+* Work Week calendar: Shows you the time-specific activities of the selected
week as well as a listing of the day’s tasks. Each day is represented by a
single column and divided into half-hour intervals. (See Figure 84.)

v Weekly calendar: Shows the entire week, including Saturday and
Sunday.

v Monthly calendar: Shows you the time-specific activities of the selected
month as well as a listing of the day’s tasks.

The mini-calendar

A mini-calendar appears to the right of any of the ACT! calendars. The mini-
calendars work a little differently from the daily, weekly, and monthly calen-
dars in that they’re used to change a date and not to just schedule an
appointment. You can access a three months’ supply of mini-calendars by
pressing F4 from any ACT! view. (See Figure 8-5.) Right-click the day that you
want to check and a small window appears, displaying all activities sched-
uled for that day.
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After you access any of the ACT! calendars, you can navigate to a different
date in one of the following ways:
1 View today’s activities by pressing Ctrl+Home.
1 Switch to a different day by clicking any day on the mini-calendar.
v Get a daily synopsis by right-clicking any day on the mini-calendar.
v Go to a different year by clicking the double arrows.

» Go to a different month by clicking the single arrows.

The Recap List

If you take a peek at any of the calendars, you notice a mini-calendar in the
top-right corner. As I mention earlier, this calendar provides you with a quick
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way to view a different calendar date by clicking it. A miniature to-do list —
the Recap List — appears right below the calendar. The Recap List lists all
your scheduled activities on a specific day.

You can view the Recap List of only one user at a time, but you can have
access to multiple users’ Recap Lists. When you select multiple users, but-
tons with each user’s name appear in the Recap List. Click the user’s name to
open or close his Recap List. If a selected user has no scheduled activities for
the selected date, her name doesn’t display in the Recap List. To view
another user’s Recap List, follow these steps:

1. Click the Calendars icon on the Nav bar.
2. Click the Select Users button.
The Select Users dialog box appears.
3. Select the users whose Recap Lists you want to view and then click OK.

When you select multiple users, their tasks all appear on both the calen-
dar and the Recap List. This can get confusing — not to mention make you
feel that you have too much to do if you forget you’re viewing everyone
else’s activities. This is where a bit of color-coding can come into play.
Gary’s activities might all be in blue, and Alyssa’s might be in magenta.
That way, you’ll be sure to know which activities belong to whom.

4. From the calendar, select the date for the Recap List you want to view.

The user’s tasks display in the Recap List. If you selected multiple users,
you can click the button with the user’s name to view that user’s tasks,
as you see in Figure 8-4.

Using the Task List

Like the Honey-Do list hanging from your husband’s workbench, the ACT!
Task List gives you a listing of all the activities for all your contacts.

The Task List is readily accessible by clicking the Task List icon on the ACT!
Nav bar. Figure 8-6 shows a sample Task List.

You can filter the Task List by using different criteria, such as the date range,
type, priority, and the users whose activities you want to view.

You can also include a few more activity options by clicking the Options
button and opting to add Private, Timeless, Cleared, and/or Outlook activities
to the Task List.
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Creating a lookup from the Task List

Here’s the scenario. You wake up bright-eyed and bushy-tailed, ready to face
another new day. You get to the office, view your Task List, and stop dead in
your tracks: The length of your Task List is so long that you don’t even know
where to begin. Consider creating a lookup directly from the Task List. By
spending the first hour of your day sending out all those faxes and brochures
that you promised — and then the next hour returning your phone calls —
you get everything done.

When you break down your tasks into manageable pieces — instead of
having a breakdown yourself — the Task List becomes less intimidating.

Q&N\Bfﬂ Having said all that, I feel compelled to add that Rome wasn’t built in a day,
& and you might not be able to complete all your tasks in a single day, either.
ACT! has a preference that enables you to roll over your tasks to the next day.
Check out Chapter 3 for a quick refresher on changing ACT! preferences.

1. To open your Task List, click the Task List icon on the ACT! Nav bar.

2. Select the date range of the activities for which you want to create a
lookup.

3. Select the activity types in the Types area to indicate the activities
that you want to work with.



Chapter 8: Playing the Dating Game ’ ’5

When you select these options, your Task List hopefully becomes a bit
shorter. You can filter your Task List even further by selecting the prior-
ity types you want to include and making sure that your tasks are the
only ones visible in the Task List.

4. Right-click the Task List and select Create Lookup.

ACT! creates a lookup based on the selected activities. You can now scroll
through your contacts and work on all similar tasks at the same time.

Ouickly printing the Task List

As great as ACT! is, it can be totally useless if you don’t have access to a com-
puter or handheld device. Or maybe you work with a technically challenged co-
worker (your boss?) who prefers to have a copy of his or her Task List printed
on a daily basis. No need to fret; ACT! can easily perform this task for you:

1. Click the Task List icon on the Nav bar.

2. Choose File=>Quick Print Current Window.
The Print dialog box opens.

3. Click OK to print the Task List.

Whatever columns you have displayed on the Task List appear in the
Quick Print report.

Exploring Activities

In the first section of this chapter, “Scheduling Your Activities,” [ show you
how to do exactly that. After scheduling an activity, you might want to review
it. Or edit it. Or clear it. Or maybe even share it with others. So in this sec-
tion, I show you how to do all these things.

Viewing the Activities tab

If you click the Activities tab at the bottom of the Contact Detail window, ACT!
displays all the activities scheduled with the current contact. This is a great
way to have a list of all the activities that you've scheduled with a contact.

You can see the Activities tab in Figure 8-7.
You can filter your activities so that only certain activities show on the

Activities tab. Your choices include dates range, activity type and priority,
users, as well as private, timeless, cleared, and Outlook activities.
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Can'’t find the filter options for Private, Timeless, Cleared, and Outlook activi-
ties? Click the Options button, and you’ll find them.

After you set your filters, you can also determine the columns that you want
to appear on the Activities tab. Chapter 5 explains all the possibilities.

After you determine the columns that you want to view onscreen, you can
easily print a down-and-dirty report. In Chapter 5, I give you all the juicy
details for rearranging the columns on the Activities tab — or on any other
ACT! list for that matter — and turning it into a Quick Print report.

Editing your activities

Like all the best-laid plans of mice and men, your activities will change, and
you need a way to make note of these changes in ACT!. Changing an activity
is all in the click — or in this case, the double-click — of the mouse. If you
can see an activity, you can edit it. That means you can edit your activities
from the Activities tab, the Task List, or from any of the ACT! calendars. The
only activities that you can’t change are those that you've already cleared.

Resist the urge to simply change the date for rescheduled activities. Although
this is easy enough to do, you might end up losing some key information. Say,
for instance, that a particularly high-maintenance customer stands you up
four times — and then complains to your boss about your lack of service. If
you had simply edited the original activity, you wouldn’t be able to document
the dates of all four activities. You might like to think of this as CYA (um,
cover your ACT!) technology!

Clearing activities

After you complete a task, clearing the task is very important because then ACT!

v Stops reminding you about the activity
v~ Allows you to add some additional details about the activity

1 Lets you schedule a follow-up activity if necessary
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Clearing an alarm isn’t the same as clearing an activity. You might clear an
alarm when you first open ACT! or when the activity is scheduled to occur, and
not actually clear the activity. Eventually, your Task List grows dangerously
long — in which case, you’ll probably start ignoring it all together. Worse, you
won’t have a history of the activity because theoretically, if never occurred!

To clear an activity, follow these steps:

1. Select the activity that you want to clear by doing one of the following:

¢ In any Calendar view, select the check box next to the activity in the
Recap List.

¢ In the Task List or on the Activities tab, click the check mark column.
e Right-click the activity and choose Clear Activity.

Using any method, the Clear Activity dialog box appears (see Figure 8-8).
The current date and time appear automatically. The Regarding informa-
tion that you had originally entered for the activity appears as well. This
information later appears in the Regarding column of the history that’s
automatically created when you clear an activity.

Clear Activity
Type: Meeting
Organizer, Chris Huffman
Patticipants: Charles Foster Kane [Rosebud Publications)
Associate With:
=
Date: Time: DCiuration:
9/20/2008 ~| [1o00am | [thour v
Regarding:
Prospect Call
Results
(%) Clear | Meeting Held ~
i Erase

Add Activity Details to Histony

= = ‘D |Microsoft Sans Ser || 8 v A-B T UTF

Meeting went really well. | think they will be placing future orders.

Attachment:

[ Private
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The Clear Activity dialog box enables you to clear just one activity at a
time. You can clear multiple activities from the Activities tab or the Task
List:

a. Hold down the Ctrl key while selecting additional activities to clear.

b. Right-click the selected activities and then choose Clear Multiple
Activities from the shortcut menu.

. Select a Result option.

The result determines the type of note that’s added to the History tab as
well as the system field that is affected. For example, if you indicate that
a call was completed, two things happen:

e A history is added to the History tab with Call Completed showing in
the Results column.

e The Last Reach field is changed to include today’s date.

The results vary according to the type of activity that you scheduled. If
you schedule a meeting, the results are either Meeting Held or Meeting
Not Held. If you schedule a call, you see different result options, includ-
ing Call Attempted, Call Completed, and Call Left Message.

. Select the Add Activity Details to History check box if you want to edit

or add activity details.

Changes that you make to the Add Details area appear in the Regarding
field on the History tab for the contact.

. (Optional) Click the Follow-Up Activity button to schedule a follow-up

activity.

This is a very cool concept. When you clear an activity, ACT! gives you
the option of scheduling a follow-up activity. Schedule a follow-up
exactly like you schedule an original activity.

. Schedule the follow-up activity in the Schedule Activity dialog box

and then click OK to return to the Clear Activity dialog box.

. Click OK again, and you’re done.

Creating an Activity Series

Quite simply, an activity series is a series of steps that you might want to
follow to achieve a specific goal. For example, you might have a six-step plan
of action for every prospect that heads your way, or seven things you need to
do during each of your customer-related projects. Every time you meet a new
prospect, you might want to lure him into using your services with a specific
plan of action: send a brochure, follow it up with a phone call, send out a
letter explaining some of the things you discussed in the phone call, and then
finally send an e-mail further explaining your business. After the prospect
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becomes a customer, you might want to routinely send a welcoming letter,
send out a proposal, wait for approval, and then wait for the deposit check to
slide into your mailbox.

ACT! allows you to group these steps into one list in order for you to auto-
mate your process. With an activity series, you can stick to your game plan.
And, hopefully, some of those hot prospects turn into customers because you
don’t allow any of them to fall through the cracks.

Using the Activity Series Template
Creation Wizard

Before you can schedule an activity series, you must create one via the
Activity Series Template Creation Wizard. Here’s where you develop the
series by naming it, setting it as public or private, and adding activities. The
wizard also allows you to edit or delete an existing activity series template.
Follow these steps to start the wizard:

1. Choose Scheduler>Manager>Activity Series Templates from any ACT!
screen.

2. In the Activity Series Template Creation Wizard, select the Create a
New Activity Series radio button and then click Next.

The wizard walks you through the next three steps.

3. Fill in the name of your new Activity Series, indicate whether it’s public
or private, give it a description (if necessary), and then click Next.

The third window of the Activity Series Template Creation Wizard, as
shown in Figure 8-9, is where you assign the individual activities to the

S€ries.

Activity Series Template Creation Wizard (3 of 4)
Activity Series Template Creation Wizard - Series 4

Activities in this series l—_'—.—l

Activities In the Series

Type From Anchor Date | Regarding Schedule For Add...

Zall |0 day Follow-up Scheduling User

Zall 1 week Confirm Shipment | Scheduling User

To-da 1 manth Request Updated F Scheduling User

Marketing Call & maonths & maonth Follow up | Scheduling User

119
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Figure 8-10:
Add a new
activity to

an activity
series.
|

4. Click the Add button to add all the steps you want to include in your
activity series.

The Add Activity dialog box opens; you can take a peek at it in Figure 8-10.

Add Activity

Ativity information

Activity Type:

Meeting N
Starts; Duration:

3 1% |Months | | After éinchor Date |a¢] |1 hour v

Regarding:

MNew Customer followup meeting |
Priority: Color, Ring &lam:

High ~| L) |1oay v

IF activity falls on a non-working day, schedule on the following waork day

Schedule for

Activities must have a specified organizer. The oiganizer is the user who will own the adivty o
activities in the series.

() User scheduling the activity series

(&) Chiis Huffman Schedule Far..

5. Fill in the Add Activity dialog box and click OK.

Here’s where you indicate all the pertinent details for each and every
step of your activity series. You have to enter several key pieces of infor-
mation; don’t worry if you make a mistake because you can always go
back and edit these steps if you don’t get them right the first time.

e Activity Type: Indicate whether you're scheduling a call, meeting,
to-do, or a custom activity. (Skip to Chapter 13 for more info about
custom activities.)

e Starts: Activity series are based on an anchor date. You can either
schedule an activity that occurs after the anchor date (which is
generally the day you begin the series) or activities that must be
completed before the anchor date.

¢ Regarding, Priority, Color, and Ring Alarm: These fields are the exact
same ones you encounter when scheduling a regular, run-of-the-
mill activity.

e [f Activity Falls on a Non-Working Day, Schedule on the Following
Work Day: Select this check box to prevent an activity from being
scheduled on a Saturday or Sunday.

e Schedule For: 1If you're like me, you like nothing better than delegat-
ing work to another person. Here’s where you can assign each
Activity Series step to a poor, unsuspecting co-worker!
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6. Repeat Steps 4 and 5 as often as you need and then click Next.

7. Indicate Yes if you want to schedule the series now or No if you want
to start it later and then click Finish.

Scheduling an activity series

After you create the template, you can schedule the series with one of your
contacts and set the anchor date. All the activities link together so that if one
activity changes to another date, you have the option to change only that
activity to another date or to reschedule all the remaining activities.

1. Create a lookup to find the contact or contacts with whom you want to
schedule the activity series.

[ warn you repeatedly that ACT! saves you lots and lots of time. If sched-
uling an activity series with one person saves you time, just think of
what scheduling one with a bunch of people does for you!

2. Choose Scheduler>Activity Series.
The Schedule Activity Series dialog box appears.

3. Select the activity series template that you want to use and indicate
the anchor date.

4. (Optional) Click the Contacts button and choose Select Contacts if
you’re scheduling the Activity Series for more than one contact.

e Select Current Lookup from the Select from drop-down list and
then click the double-pointing right arrows to schedule the Activity
Series for the Current Lookup.

e If you forget to create a lookup or if you want to include a few more
contacts, select your contact(s) from the Contacts to Select From
dialog box and then click the right-pointing arrow to move the con-
tact(s) to the Selected Contacts dialog box.

5. Click Schedule.

The activities are scheduled and appear on the appropriate spots on the
contact’s Activities tab, the Task List, and on the calendars. No time is
yet associated with any of the activities because activities scheduled as
an activity series are automatically timeless.

No conflict checking is performed when the activities are scheduled via an
activity series. Your tasks are scheduled regardless of whether you're already
scheduled to be on vacation or off attending a conference in Kalamazoo.
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Before scheduling the series with a large number of contacts, test the series
by scheduling it with just one contact. Then take a gander at that contact’s
Activities tab to make sure that the activities appear in a logical sequence. If
something appears amiss, delete all the scheduled activities from the con-
tact’s Activities tab and read on.

Modifying an activity series

Mistakes happen, and you might make one when initially setting up your
activity series. Or you might want to assign another employee to one of the
steps in the series. Not to worry; here’s all you need to do to modify the

series:

1. Choose Schedule->Manage=>Activity Series Templates.

2. Select the Edit an Existing Activity Series radio button in the first
screen of the Activity Series Template Creation Wizard and then click
Next.

3. Select the activity series template that you want to edit and then click
Next.

4. (Optional) Give the Activity Series a new name, indicate whether it’s
public or private, and then click Next.

The fourth screen of the Activity Series Template Creation Wizard
opens.

5. Select the activity step that you wish to edit and then click the Edit
button.

6. Make the appropriate changes in the Add Activity dialog box and then
click OK.

7. Click Next in the Schedule Activity Series window when you finish
modifying all the activities.

8. Indicate whether you want to run the activity series and then click

Finish.
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Dashing Through the Dashboards

In This Chapter

Knowing the default Dashboards
Working with a Dashboard
Using Dashboard Designer

0ne of the coolest new features of ACT! 2008 is the addition of the
Dashboard. A Dashboard allows you to access key information in a
single snapshot view. The fun part is that you can filter the Dashboards so
that they contain just the information you need, or the database Administrators
and Managers can create new Dashboards. You can create new tasks directly
from a Dashboard, and even copy a Dashboard or one of its components to
other applications. Additionally, if you want more details about the informa-
tion you see in a Dashboard, you can drill-down through a Dashboard to
access all the juicy details.

Dashboarding 101

gMBER
oy

Quite simply, a Dashboard is a graphic that gives you a visual snapshot of a
part of your business. ACT! Dashboards let you view and work with important
information in one location. Dashboards can take the form of a neat graphical
chart; others come in the form of a list. Dashboards are associated with a data-
base and not a user; therefore all users share the same Dashboards. However,
you can select your own Dashboard view in much the same way that you can
select a layout.

You can change the default start-up preference so that the Dashboards are
the first thing you see when you open ACT. Chapter 3 shows you how to
change that start-up option.

The ACT! Dashboards are on the Dashboard page, which you can access by
clicking the Dashboard icon on ACT!’s Navigation bar. Figure 9-1 shows you
an example of the default Dashboard page.
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Figure 9-1:
The ACT!
Dashboards.
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A Dashboard consists of two parts:

v Dashboard layouts: The Dashboard layout determines which Dashboard
components you see and how the filters are set. ACT! comes with a
default, Activities, and, Opportunities Dashboard layout. However,
Managers and Administrators can create additional Dashboard layouts
using the Dashboard Designer that users can then select in the
Dashboard view.

v Dashboard components: Each Dashboard layout includes one or more
components. A component displays different types of data from the ACT!
database. You can navigate to different areas of the ACT! application,
perform tasks like scheduling activities, and filter each component to
control the data that it displays directly from the component. Each com-
ponent displays information differently and allows different actions.

ACT! offers six Dashboard components (all visible in Figure 9-1):

e My Schedule At-A-Glance: Displays your activities for the specified
day in a calendar view

e Activities by User: Displays a bar chart showing your activities for
the current month

¢ Opportunity Pipeline by Stage: Displays your open opportunities
in a pie chart sorted by stage of the ACT! Sales Process for the cur-
rent month
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e Opportunities by User: Displays a bar chart of your open opportuni-
ties in the ACT! Sales Process for the current month

e Top 10 Opportunities: Displays a list of your top ten open opportu-
nities in the ACT! Sales Process for the current month

¢ Closed Sales to Date: Displays a gauge chart showing the number of
opportunities in the ACT! Sales Process you closed and won for the
current month

Selecting a Dashboard layout

The first thing you probably want to do is to familiarize yourself with the
three out-of-the-box Dashboard layouts. You’'ll have no trouble mastering that
task if you follow these steps:

1. Click the Dashboard icon on the Navigation bar to access the
Dashboard view.

2. Choose the Dashboard layout you want from the Dashboard drop-
down list at the top right side of the Dashboard.

Although each layout consists of a combination of the six components I
mention earlier in this chapter, the components in each of the layouts
are filtered differently making the components look slightly different.

Like what you see in one of the Dashboard components? You might want to
share it with others by pasting the component into a PowerPoint presenta-
tion or Word document. Give the component a right-click and choose Copy to
Clipboard from the contextual menu. You can now paste the component into
the program of your choice. Or, if you prefer to copy the entire Dashboard,
choose Edit=>Copy in the ACT! menu, and all the components of the currently
displayed Dashboard will copy into the clipboard.

Want to save the Dashboard for future generations — or at least print a copy
that you can post on the company bulletin board? Choose Filer>Quick Print=>
OK while viewing a Dashboard and then snatch the hard copy of your
Dashboard that the printer spits out.

Filtering a Dashboard

You can filter the data in each of the components in a Dashboard to deter-
mine what information will appear. Each component has different filtering
options based on the types of data that component displays. For example, an
Opportunity component lets you filter according to the stage of your sales
process, and an Activity component lets you filter according to the type of
tasks that you want to display.
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Figure 9-2:
Filtering a
Dashboard
component.
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The filter options that you set for each component are sticky, which means a
component retains its filter settings the next time you fire up ACT!. However,
if an ACT! Manager or Administrator changes the filters in the Dashboard
Designer or changes the data security rules in your database, your filters are
overridden.

Filtered data is limited by what you can access. If you can’t access the data
for a user you select, you can’t see the data in the component.

To filter a Dashboard component:

1. Click the Dashboard icon on the Navigation bar to access the
Dashboard view.
2. Click the Filter button on the component you want to filter data for.

A Filter dialog box opens, like the one you see in Figure 9-2.

Filter

Users

) &l users
Statys; | Closed -‘Won » () Selected users:

Allizon Mikola
Process/Stage Bty Browser
Frocess: |ACT! Sales Cycle | % Chris Huffman
Ernst Anderson
[an Fred Fenderline
Jonathan Sommer
Juligtte Rosseux
Faren Fredricks
Prabahility Melissa Pearce
@l Sarah ‘whiting

Diates: | Current Manth W

Stage:

) Single Value: %
() Greater Than: %
(O Less Than: %

Tatal Optiohs

@Al Show Private
O Single Value:

() Greater Than

(O Less Than:

The dialog box varies, depending on whether you're filtering an
Opportunity or Activity Dashboard component.

3. Change the filter settings and click OK.

The filter options vary depending on which component you're tweaking.
Some of the components let you choose a date range, or select the users
whose information you want to appear in the component.

The data in the component reflects the information that you specify.
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Figure 9-3:
Working
with an
Opportunity
Dashboard
component.
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A Dashboard component takes up a little less than a sixth of your computer
screen. Consequently, don’t try to include foo much information in a compo-
nent or you won'’t be able to see all the information in a component without
having to mess with your scroll bars. For example, displaying all the opportu-
nities for the last year is probably a bit of overkill.

Working from a Dashboard

One of the things you might find particularly appealing about Dashboards is

that you can work directly from them. The options for each Dashboard com-

ponent vary slightly. For example, you can schedule a new appointment from
the My Schedule-At-A-Glance component but not from the Activities by User

component.

Accessing the menu to create a new Opportunity or Activity is easy; simply
right-click a list component and choose Schedule if you're working from an
Activity Component or one of the Opportunity options (see Figure 9-3) if
you’re working on an Opportunity component.

New Opportunity
Edit Opportunity
Delete Opportunity

Edit Estimated Close Date
Close Opportunity

Show Contacts...
Show Products...

Go To Contact
Create Lookup

(E ~

Copy To Cliphoard

Filter...

Customize Columns...

In addition, if a component displays the information in the form of a list, you
can double-click any of the listed items to zoom in to the original form for
editing purposes. You can even clear any activities that you see.

Creating Dazzling Dashboards
with Dashboard Designer

ACT! users with Manager or Administrator privileges can use Dashboard
Designer to edit the default Dashboard or to create new ones. The same
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component can be added multiple times to a Dashboard but set to show the
information in a different way. For example, you might include the Activities
by User component both as a Vertical Bar Chart and as a list display, or you
might include the Opportunity Pipeline by Stage filtered for each member of
your sales force.

Changes a Manager or Administrator makes to the filters for a component in
Dashboard Designer change the default filters for all users. However, the users
are free to change the filters for their own purposes directly from Dashboard.

Creating or modifying a Dashboard layout

You can create a new Dashboard layout from scratch if you have an abun-
dance of time and energy on your hands. However, you’ll probably find it a
whole lot easier to save one of the default Dashboards under a new name and
then start the tweaking process. This method is not only a whole lot easier
than starting from scratch — it’s also a whole lot safer should you manage to
totally mangle Dashboard beyond use.

Opening Dashboard Designer is so easy even a caveman can do it:

1. Click the Dashboard icon on the Navigation bar to access the
Dashboard view.

2. Select the Dashboard you want to modify from the Dashboard drop-
down list and then click the Edit button.

Alternatively, if you're feeling very adventurous, you can click the New
Dashboard button to open a new, blank Dashboard layout. In either case,
Dashboard Designer opens, like the one you see in Figure 9-4.

3. Add, resize, or delete any of the cells in the layout.

The default Dashboard layouts contain six cells divided into three rows
and two columns. With Dashboard Designer, you can

® Resize a cell: Hover your cursor over the edge or a cell until it
turns into a double-pointing arrow and then drag the edge to the
desired location.

You can resize cells by changing the height or width of a cell.
However, all cells in each row must be the same height. However,
the width of a cell can be different from the cells above or below it.

e Add a column or row: Right-click a cell, choose Insert, and then
choose Column to the Right or Row at the Bottom from the contex-
tual menu.

e Delete columns or row: Right-click a cell, choose Delete, and then
choose Column to the Right or Row at the Bottom from the contex-
tual menu.
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4. Move or delete existing Dashboard components.

After you determine the size and number of cells, you're probably antsy
to start adding in a few new components. First, however, you might want
to rearrange the existing components:

¢ Delete a component: Click the component and then press the
Delete key on the keyboard.

e Move a component: Drag a component to any empty cell.

5. Select a cell and then choose Tools=>Add Component from the
Dashboard Designer menu bar.

You can choose to add an Activity, Opportunity, or Custom component.
The Custom components include custom Dashboard components cre-
ated by third-party vendors.

Each cell can contain any of the six Dashboard components that [ men-
tion in the beginning of this chapter. You can add a component multiple
times to a Dashboard and configure each instance differently.

\BER Choose Filer>Save As to save your Dashboard layout.
\’

Changes you make to the layout and components of a Dashboard are
only for that Dashboard and don’t affect the other Dashboards in your
database. However, the changes do affect all ACT! users who use that
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particular Dashboard. If you don’t want to impact other users, save the
Dashboard with a different name.

7. Click the Close button (the red X) in the upper-right corner of
Dashboard Designer.

Customizing a Dashboard component

Creating a new Dashboard layout is only half your fun. The other half comes
in customizing each of the individual layout components. You can configure
the components to display different information based on default filters, use
different chart styles, add a header and/or footer, and even change the way
that totals appear on the component.

I know. You're probably thinking that this all sounds a bit complicated. Just
remember that all this customization is optional — and probably a lot easier
than you think.

Follow these steps to get started on your component customizations:
1. Click the Dashboard icon on the Navigation bar to access the
Dashboard view.

You're customizing a Dashboard, so this is a pretty logical place to start.

2. Select the Dashboard you want to modify from the Dashboard drop-
down list and then click the Edit button.

If you follow the steps in the preceding section, you have a brand-new
Dashboard layout to work with, which is a safer choice than attempting
to customize an existing layout.

3. Double-click the component on the Dashboard that you want to tweak
and change but hopefully not mangle.

The Component Configuration wizard opens, like the one you see in
Figure 9-5.

4. Select a Component task from the Component Tasks area of the
Component Configuration wizard.

The tasks listed vary, depending on the component that you're editing.
For example, some of the components allow you to set targets to see
how close you are to reaching your goals. When you select a task, it
opens in a new dialog window.

Depending on the component that you're editing, your choices include

e Select Display Type: You can display your data as a Bar Chart, Pie
Chart, or List View. Figure 9-6 shows you the various choices.

e Edit Default Filters: Indicate the date range, type of data, and the
Record Manager of the data you want to display.
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e Edit Header/Footer: Here’s where you can give the component

a header and a footer — and even decide the font and color
you prefer.

¢ Change Legend: If the component includes a legend, you can place
it at the top, bottom, left, or right side of the component.

¢ Change Totals: Indicate whether you want to have a head count at
the bottom of the component. For example, you can have a count
of all the activities that are displayed.

Activities by User =]
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Component tasks Z
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e Specify Targets: Dashboards are particularly popular among the
sales crowd. And most sales people use quotas as an indicator of
how well they’re doing. Including a target on a component gives
you visual proof of how close you’re to reaching your goal.

e Scale/Limits: Indicate the scale in hundreds, thousands, millions,
or even billions for your charts.

\P
) You'll notice that each of the component task screens includes a preview

button. Click it to get a preview of what the component will look like if
you decide to go with that particular option.

5. Click Next to move on to the next component task or Finish if you're
done working with the component tasks.

6. Click Close to close the Component Configuration wizard and then
Close again (the red X in the upper-right corner) to close Dashboard
Designer.
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In this part . . .

Entering contacts into ACT! is only half the fun. The
other half consists of communicating with the outside
world. In this part, you find out how to run and create
reports for your internal purposes and also how to reach
an audience of one or thousands through the use of snail
mail or e-mail. You’ll even find a large collection of com-
mercial forms for printing (buried deep inside ACTY).




Chapter 10

Using the ACT! Reports and Labels

In This Chapter
Getting to know the ACT! reports

Running ACT! reports

Printing calendars, address books, and labels

Making a Quick Report

A fter you build your database, the fun part is sitting back and using it. If
paper’s your game, ACT!’s surely the name — at least of the software
that you should use for any type of reporting. In this chapter, | discuss the
various ACT! reports that are available.

You might feel that ACT! uses somewhat of a fuzzy logic when it comes to
reports. Basically, ACT! has three types of reports: reports, labels, and envel-
opes. All three items are edited in pretty much the same way and stored in
the same ACT! folder. You find the actual reports in the ACT! Reports menu,
which seems like a pretty logical place to find them. However, you have to
search in the File menu to find labels and envelopes, which for most of us
seems to be fairly illogical. To further complicate the issue, ACT! throws in a
bunch of address books and calendars with labels and envelopes; these cal-
endars can’t be edited. Finally, ACT! throws in a bunch of Quick Print reports,
which are based on the contents of your various list and tab views.

Knowing the Basic ACT! Reports

A\

ACT! comes with a menu of 40 basic reports right out of the box. Chances are
good that at least one of the basic ACT! reports gives you exactly the informa-
tion that you’re looking for without having to go through the bother of creat-
ing a new one.

If you really want to see firsthand what each ACT! report looks like, open the
ACTDemo database and print the first page of each report. Then stick all the
reports in a notebook. That way, if you ever need to run a report, you can go
back to your sample printouts for a quick reference before you start running
a lot of unnecessary reports.
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The first three reports in the ACT! Reports menu are probably among the
most useful because they supply you with information for each of your con-
tacts. You can determine which one best suits your needs by deciding
whether you want to view a page, a paragraph, or simply one line of informa-
tion about your contact:

v Contact Report: A one-page report showing all a contact’s information,
including the notes, history, activities, and opportunities.

1 Contact Directory: Both the primary and home address for each contact
in paragraph form.

v Phone List: The company name, contact name, company phone number,
and phone extension for each contact; the report displays one line of
content for each contact.

The next several reports display information about your notes and activities:

v Activities: Shows you the scheduled and completed calls, meetings, and
to-do’s scheduled with each contact during a specified date range. This
report is sorted by contact so that you can see a listing of all the time
that you spent — or are scheduled to spend — with any given contact.

1 Notes/History: Lists the notes and history items for each contact during
a specified date range.

v~ History Summary: Produces a tally of the number of attempted calls,
completed calls, meetings held, letters sent, and fields changed for each
contact during a specified date range sorted by contact. Figure 10-1
shows you the History Summary report.

Chris Huffman, CH Gurmet
13East 54th St
l History Su mmary Plew Vork, MY 10008
DateRange: AlDates
‘Chocolste Trade Associations, Chocolate Trade Associsticrs
Meeting Held Fotak 1
‘George Bally, Liberty Savings BLoan
Meeting Held Fotab 1
Wary Baley, Lberty Savings &Loan
Field Changed Fotat 2
Meeting Held Fotat 1
Hew Opportunity Fotab 1
iz Briton, Qualty Matars
Call Completed rotab 1
To-da Dane Fotat 2
— Opportunity Wen Fotak 1
Figure 10_1: Hew Opportunity Fotat 1
Jerathan Jerkins, Crcle Phatoray
The ACT! FekdChanged orat 1
Histo ry Opporturity Wen Fotat 2
S umma ry Hew Oppartunity Fotak 3
Opportunity Stage Updae Fotak 1
report. P ——————.
—— Call Completed Fotab 1
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v~ History Summary Classic: Shows the numerical total of attempted calls,
completed calls, meetings held, and letters sent for each contact during
a specified date range, sorted by contact.

v~ History Time Spent: Shows the date, time, duration, and information
regarding activities scheduled with each contact during a specified date
range. You get a subtotal of the time that you spend with each contact as
well as of the time that you're still scheduled to spend with them — if
you assign a time duration to your meetings, calls, and to-do’s.

The next two reports are based on information in two of the key ACT! fields:

1 Contact Status: Shows you the ID/Status, last reach, last meeting, and
last results for each contact during a specified date range. You likely
want to create a Contact Activity lookup before running this report to
avoid having a lot of empty contact information in your final report.

v Source of Referrals: The Source of Referrals report relies on the infor-
mation in the Referred By field. Figure 10-2 shows you an example of the
Source of Referrals report as well as what happens if you don’t enter
data consistently. Dave Davis and David Davis are probably the same
person, yet they show up in two different spots in the report.

r Chris Huffman, CH Gourmet Gifts
1: Source of Referrals 13 East SRS,
Hew York, N 10008
Rdvertisemert TotalRerarah, &
Comparny Contact Title Phone
Verge Records Paul Henderson Assistart Engineer
Siméern Bruce Baker chiefDesigner (480) 5552144
Sewing Room; The: Danielle Midcliebury Owner (415)555-2242
Brushy's Goffing World Paul Brushman ChieF Galf Sales Manager (455)555-2221
Goldfish Records Arngtke Sharkey New Media Manager (S55)555-2145
Coffee Producers of Australa Margan Kennedy Manager 0789911234
Anthony Federid TotalRererat 3
Company Contart Title Phone
Hare's Tavern Phoenix Steven Marsh (07) 466 9 1100
Great Northern Coffes Lauis Hil Presidert 509-838-2711
Paity Perfexion Ine. Melanie Thompsan CEQ (732) 5595-5627
DaveDaris TotRErer ik 4
| _— Fanist itk o
Fi g ure 1 0_2: Boomer's Artworc Emily Dunn Sales Representatie (602) 555-4874
I Boamer's Artwor: Bettiz James Sales Representative
ACT 'S Corleone's Pasta Compary arky Manicatki Director of Manufacturing (480)555-4512
S ource Of Tiny Town Productions Ashley Allan VP of Sales (480) 555-2451
Referrals [Referred By [EEEEEH TotalRatarak 3
Company Contact. Title Phone
re p 0 rt Arcadia Ave. Florist Jim Curtis Manager (B02)555-+412
I Arcadia Ave, Florist Jackis Jorgensen Propristor 01742676234

You can find the Group reports in a subsection of the main Reports menu.
These reports give you different ways to view the information in your groups.
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If you don’t use groups (which I explain fully in Chapter 20), these reports
aren’t any benefit to you:

+* Group Membership: Lists all groups and their members

v Group Summary: Lists the notes, histories, and activities for all groups
or for specific groups

+* Group Comprehensive: Lists all information (including notes, histories,
and activities) for each group, subgroup, and their respective members

v Group List: Lists all groups and their descriptions from the Group
Description field

You find the Company reports in a subsection of the main Reports menu.
These reports give you different ways to view the information in your compa-
nies. If [ sound like a broken record, it’s because the four Group reports that |
mention earlier all come in a “company version.” Also, included is a Company
Directory report that’s similar to the Contact Directory report.

ACT! provides you with a variety of Opportunity reports, pipelines, and graphs.
The Opportunity reports use information entered on the Opportunities tab. If
you don’t use the Opportunities feature (head to Chapter 19 for the lowdown),
you can’t use these reports. All the Opportunity reports are housed in a sepa-
rate Opportunity section in the Reports menu:

v~ Sales Analysis by Record Manager: Shows the total sales by Record
Manager, including everything from the average dollar amount of his
sales to the average number of days it takes to close a sale

1 Totals by Status: Garners totals of all sales opportunities and sorts them
by Closed/Won Sales and Lost Sales

v Adjusted for Probability: Lists all sales opportunities showing a
weighted sales total

v~ Pipeline Report: Gives information about sales opportunities at each
stage in the sales process

v Opportunities by Record Manager: Lists sales opportunities,
Closed/Won Sales, and Lost Sales sorted by Record Manager

v Opportunities by Contact: Provides complete sales information for each
contact with a sales opportunity or a closed sale

1 Opportunities Graph: Gives forecasted or closed sales, in a bar or line
graph

v Opportunities Pipeline: Gives the number of sales opportunities at each
stage of the sales process, in a graphical form

Unfortunately, more than a dozen more ACT! reports are buried. The Report
menus include several “other report” options, which would lead you to believe
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that they would lead you to, well, some of the “other” reports. Not so. If you
click any of the “other report” menu options, you land in a folder that con-
tains all the ACT! reports. If you look carefully, you find the following reports:

v Birthday List: Shows contact name, company name, and birth date for
each contact

v E-mail List: Lists contact names and their primary e-mail addresses

v Fax List: Lists contact names and their fax numbers

v Task List: Gives the 411 about the activities scheduled with each contact
and the status of each activity

v Lost Opportunities by Competitor: Shows subtotals of lost opportuni-
ties by competitor

v Lost Opportunities by Reason: Shows subtotals of lost opportunities
by reason

v Lost Opportunities by Record Manager: Shows subtotals of lost oppor-
tunities by Record Manager

v Opportunities by Company: Shows information for each company and
any open opportunities

v Opportunities by Group: Shows information for each group and any
open opportunities

v Opportunities Referred By: Shows opportunities subtotaled by who
referred the opportunity

1 Gross Margin by Contact: Shows the gross margin by contact

v Gross Margin by Product: Lists each product and gross margin for each
product

v Gross Margin by Record Manager: Shows the total sales, total cost,
average discount, and gross margin as a percentage of sales by Record
Manager

1~ Sales Analysis by Record Manager: Lists Record Manager and total sales
v~ Sales by Reason: Closed/Won opportunities listed by reason

Running an ACT! Report

The following steps apply to all ACT! reports. The dialog box is the same for
all reports. Depending on the report that you're running, however, some of
the options might be unavailable — and thus, appear grayed out.
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|
Figure 10-3:
The Define
Filters

dialog box.

To run an ACT! report, just follow these steps:

1. Perform a lookup or display the contact record or records that you
want to include in the report.

All roads in ACT! lead — or at least pass by — the lookup. Before run-
ning a report, decide which contact’s or group’s data you want to include
in your report. For example, you might run a History Summary report
for all your hot prospects or a Contact report for all contacts in a state
or region. You can include data from the current contact or group record,
the current contact or group lookup, or all contacts or groups.

2. Choose the Reports menu and then select the name of the report that
you want to run. To run a report that doesn’t appear in the menu,

choose Reports—>Other Contact Reports and select the appropriate
report.

The Define Filters dialog box opens, as shown in Figure 10-3. The General
tab is identical for any and all ACT! reports that you create.

All reports come equipped with a General tab. However, all reports are
not created equally when it comes to the other tabs. Depending on the
report you run, different tabs are available.

Define Filters

General Activity | Noke | History | Opportunity

Send the report output ta: Use data managed by
Presview | (& alusers

Create peport for () Selected users:

() Current Contact
(%) Current Lookup

O il Contacts

[C1Exclude My Record'

3. In the Send the Report Output To drop-down list, select an output for
the report.

As usual, ACT! provides you with a plethora of choices. In addition to
printing or previewing a report, you can also opt to save the report in
rich text (RTF), HTML, PDF, or text (TXT) format. You can even e-mail
the report if you so desire.
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. In the Create Report For area, specify the contacts to include in the

report.

The choices are self-explanatory. You run a report for the current con-
tact, the current lookup, or all contacts.

. Select the Exclude ‘My Record’ check box if you don’t want to include

information from your My Record in the report.

This option isn’t available for all reports.

. In the Use Data Managed By area, select the Record Manager of the

contacts that you're including in your report.

e All Users: Includes contact records managed by all users of the
database.

e Selected Users: Includes contact records managed by selected
users of the database. If you're the only user of the database, only
your name appears in the list.

. Click the Activity, Note, and/or History tabs, if you’re running any of

those reports and then make the appropriate selections.

¢ On the Activity tab, select the type of activities and the correspond-
ing date range of the activities to include in your report.

¢ On the Note tab, select the date range that you're including in your
report.

¢ On the History tab, select the type of histories and the correspond-
ing date range that you’re including in your report.

¢ In the Use Data Managed By area, select the users who imputed the
data that you want to include in the report.

By default, any of the activity, notes, history, or opportunities reports
show you data for the current month. If you don’t change those date
ranges, your report might not give you the information that you're
expecting to see.

. Click the Opportunity tab, if you see one, when running a Sales report.

Seems a bit hokey, but sometimes the Opportunity options appear on
the General tab, and sometimes they appear on their very own tab, as
illustrated in Figure 10-4.

Regardless of where you find the Opportunity options, you still have the
same choices:

e In the Opportunities area, select whether you want to include Open,
Closed-Won, Closed-Lost, and/or Inactive sales in your report.

¢ In the Date Range drop-down list, specify the date range of the Sales
Opportunities to include in the report.

¢ In the Use Data Managed By area, choose to include the opportunity
information from All Users or Selected Users of your database.

141
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Figure 10-4:
Using a
report’s

Define
Filter's
Opportunity
tab.
|

Define Filters
General | Activity | Mote | History | Opportunity
Opportunities Use data managed by
Open (&) all users
Closed - Wan () Selected users:
Closed - Lost
Inactive
Date Range:
Current Month ~
Custom...

9. Click OK.

ACT! runs the report. If you aren’t happy with the results, run the
same report a second time using different criteria or try running a differ-
ent report.

Creating Labels and Envelopes

All right. You create a brochure that’s guaranteed to knock the socks right off
your customers — and potential customers. Now all you have to do is send
out those puppies in the mail. No easier method exists to do this than by cre-
ating mailing labels or envelopes with ACT!.

Some of you might be snickering about now because you’re much too sophis-
ticated to be using snail mail. You probably already raced over to Chapter 11
to find out how to create e-mail blasts. But you might still want to use the
ACT! labels to create everything from file tabs to name badges.

If you're printing envelopes, I suggest limiting the number of envelopes that you
print at any one time. If you're just printing a single envelope for one person to
go with a letter that you just created with a document template, using your
word processor to create the envelope is probably easier than using ACT!. ACT!
automatically asks whether you want to print an envelope after you create a
letter when using a document template. (See Chapter 11 for the details.)

You print labels and envelopes in ACT! exactly the same way. I focus on creat-
ing labels, but these directions also work for envelopes. Just substitute the
word envelope for the word label in any of the directions.
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To create labels or envelopes with ACT!, just follow these steps:

1. Create a lookup of the contacts for whom you want to create labels or
envelopes.

If you're creating a personalized mailing, I'd guess that you already cre-
ated a lookup of the contacts that get the mailing. By creating the corre-
sponding labels using the existing lookup, you’re guaranteed to have the
same number of contacts and to have your labels print in the same sort
order.

2. Choose File>Print from any ACT! window.

Okay, [ know you’re probably scratching your head wondering why I'm
asking you to print when you haven’t created anything yet. That’s the
concept with these non-reports: They aren’t actually reports by defini-
tion, so ACT! just threw them into the Print menu. Go figure!

3. Choose either Labels or Envelopes from the Printout Type list.
4. Select a template from the list and then click Print.

The available label templates are listed on the Paper Type area of the
dialog box.

Notice that all the labels are Avery labels. Chances are that even if
you’re using a generic label, you find the magic words Same as Avery
Label #XX printed on the side of the box.

The Define Filters dialog box appears, which is a simplified version of
the Report Define Filters window you saw in Figure 10-3.

5. In the Send the Report Output To drop-down list, choose your print
option.

You find all the same printing options that you have when you print
reports. Theoretically, you could save your labels in HTML format or
e-mail them to someone. Previewing the labels before printing them is
always a good idea. You can then print them directly from the Preview
screen if everything looks hunky-dory:.

6. In the Create Report For area, specify whether you want to create
labels for the Current Contact, the Current Lookup, or All Contacts.

If you've sorted your database, select the Current Lookup option to
retain the sorting, even if you're printing your entire database.

7. Select either All Users or Selected Users from the Use Data Managed
By area.

This option refers to the Record Manager of each contact. You might
want to print labels for just your own contacts.

8. Click the Position tab.

This is how you’ll make your first million dollars. According to the rules
of probability — or just your dumb luck — chances are that if you use



1 44 Part lll: Sharing Your Information with Others

labels that come 30 to a page, you end up needing 32 labels. This leaves
you with a sheet of 28 unusable labels — unless you use ACT!, that is.
The Position tab allows you to start printing your labels on the appropri-
ate spot on your page.

9. Click OK.

You’re the proud owner of a beautiful set of labels.

Printing Address Books

Printing an address book is probably one of the more common tasks used
by ACT! users, and ACT! makes this chore extremely simple. The following
steps include all the down-and-dirty details for creating your own printed

address book:

1. Create a lookup if you intend to print only a portion of your address
book that I show you how to create at the beginning of this section.

Refer to Chapter 6 if you need a refresher course in creating an ACT!
lookup.

2. From any ACT! window, choose File>Print.
The Print dialog box opens.
3. Choose Address Book from the Printout Type area.

You notice that the Edit Template button is grayed out because unfortu-
nately, you can’t edit any of the address book formats.

4. Select the paper type for printing the address book.

You can print all your ACT! information onto preformatted, addressing
systems. ACT! provides you with the most popular, commercially avail-
able addressing systems, including Day-Timer and Franklin. The
preprinted forms are available at any of the large office supply ware-
house stores. If you use an address system from one of these manufac-
turers, choose it from the Paper Type list.

Figure 10-5 shows you some of your choices.

Of course, if you don’t want to spend the money on preprinted forms or
you just want a printout of your address book on a plain sheet of paper,
you can always use my particular favorite form for printing an address
book: plain paper.

When you select the Enable Preview check box, a preview of the
selected printout appears in the Preview pane on the right.
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Figure 10-6:
The Options
dialog box.
|
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i Print =
Pintout {jpe: Paper type: Preview Enable Freview @1
3 | Dap-Timer Desk
e | Day-Timer Folio [2 Coll
Addiess Book | DayTimer Portable
— =
| Franklin Classic
| Franklin Compact
Day Calendar | Franklin Monarch (2 Cal)
— | Franklin Packet
¢ | Plain 4 Full Page [L] (2 Col
Wepkelenda | Plain A4 Full Page |L] g
I I Plin A4 Full Pags (F) 12 Col)
Kt [ Plein A Full Page 7)
= | Plain A5 5.5 % 85 (L) 2 Call
= | Plin A5 5.5 % B5IL)
Bets " Plain A5 5.5 4 85 ()12 Col
| Plain 555 x BE[P)
] L Plain Letter 3.75 2 .75 (L) i
Labets | Plain Letter 3.75 1 .75 [F)
| Plain Leter 55 85 (L] (2 Col)
I Plain Latter 55685 (L)
Envelopes | Plain Letter 55 8.5 (P (2 Cal)

PlainLetter5.5x8.5(F)

Plain Letter Full Page (L1 12 Call

Dpticrs.

Furt || Cancel

5. Click the Options button to specify the information to include in the

address book.

The Options dialog box opens, as shown in Figure 10-6.

COptions

Address Book

Frint:
Primary Address
Altemnate Address
Fhone Mumbers
[[] Secondary Contacts
[] E-ail Address

Frint Sethings

[[] Break page on new lstter

[[] Letter at the tap of each page
[] European postal format

Addtional fields
| Bitth Date

Last *rs Purchases

Key Contact

Sort order
Company hame
Create printaut for:
Current Lookup

Font size:

g |

Cancel

6. In the Print area, select the fields to include in your address book.

7. (Optional) In the Additional Fields drop-down lists, you can add up to
three additional fields.

The choices in Step 6 are based on the default fields that come with ACT!.
If you add several new phone number fields, they don’t appear in the
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10.

11.
12.

printout of your address book, but ACT! allows you to add up to three
additional fields.

. In the Print Settings area, select your printing options.

Here’s where you determine how your address book prints.

. From the Sort Order drop-down list, select the order in which you

want entries to appear in your address book — alphabetically either
by company name or contact last name.

From the Create Printout For drop-down list, specify whether to
include the Current Contact, the Current Lookup, or All Contacts.

(Optional) Change the Font Size option.
Click OK.

Checking Out the Calendars

Printing a calendar is another chore that ACT! makes as easy as pie. You follow
pretty much the same steps that you follow when printing an address book.

1.

From any ACT! window, choose File=>Print.

By now you're getting used to looking in the File menu for the non-reports.

. Choose the Day, Week, or Month Calendar from the Printout Type area.

You'll notice that once again the Edit Template button is grayed out
because unfortunately, you can’t edit any of the calendars.

. Select your preferred calendar type.

Here’s where you want to make sure that the Enable Preview option is
selected so that you can see what the various calendars look like.

. Click the Options button to specify the information to include in the

calendar.

The Options dialog box opens. The Day Calendar Options are shown in
Figure 10-7.

As cool as those options look, you might want to have someone hand-
cuff you to prevent you from clicking too many of them. The more
options you select, the more difficult you might find it is to read your
calendar when it prints.

. Click the Filter button to select more calendar options and then

click OK.

Here’s where you can indicate the users, the date range, and the type of
activities that you want to appear on your calendar.
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6. Click OK to close the Options dialog box and then click Print.

You can now scurry over to your printer and pick up your calendar, hot
off the presses. You can even print out an extra copy to hang on your
refrigerator if you want!

Options |

Calendars

Frint:

Caripary Ner_rrg
[ Activity Details
Calumn for Fricrities

Stait houp [day calendar oaly]: .00 Akd =

‘ Filtzs,.. |

I Printbept ity Hlack

|

Figure 10-7:

The Options

dialog box. [ ok |[ Concel
|

Working with Quick Reports

[ like to think of the ability to print the various ACT! lists and tabs as some-
what of a secret weapon. By being able to print these lists, you can report
quickly on just about anything that you can view throughout your database.
This ability enables you to quickly create a report based on the specifications
and criteria that you need immediately.

Basically, if you're viewing a list, such as the Task List or Contact List, ACT!
can print the list. If you're viewing a fab that contains a list of items, such as
the Notes, History, or Opportunities tab, ACT! can print those items as well.

Follow these steps to create a report:

1. Display the list view or tab that you want to print.

e To display a list, such as the Task List or Contact List, choose View
and then the appropriate list.

¢ To display a tab, click the tab from the Contact, Group, or Company
Detail window.



1 48 Part lll: Sharing Your Information with Others

2. Arrange the columns exactly as you want them to appear on your
printout.

If you need help adding/removing columns or changing the order or size
&‘?’“\BE” of existing columns, check out Chapter 5.
¢

All the lists and tabs that you see in ACT! are customized in the same way.
3. Choose Filer>Quick Print Current Window.

The Windows Print dialog box opens.
4. Click OK.

Some of you might be thinking that you can print a Quick Report pretty
quickly. You're right! Guess that’s why they’re called Quick Reports!



Chapter 11

Merging Your Information
Into a Document

In This Chapter

Understanding mail merge
Choosing your word processor
Making a document template
Converting existing templates
Using the Mail Merge Wizard

A particularly useful ACT! feature enables you to create customized docu-
ment templates: forms in which ACT! fills in your selected data fields.
You can send these forms to a thousand people as easily as you can send
them to just one person. You can send out routine documents one at a time
on a continual basis, or you can send out the document one time to all or
part of your database. After you create a form, you can send it out via snail
mail, e-mail, fax, or Pony Express.

Mail Merge Isn’t Just about Mailing

Poor mail merge! Folks often have two common misconceptions about mail
merge. Some people think that mail merge is synonymous with junk mail. Also,
the word mail makes some folks think postage stamps are involved. However,
neither of these common misconceptions are true. A mail merge simply takes
the content of one or more fields and puts that content into a template or form.

A good way to understand the concept of mail merge is to visualize this
simple equation:

template + data field(s) = personalized document

Note the (s) at the end of data field, suggesting that you can use either one
name or many names. Some of you might think that you’ll never perform a
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mail merge because you have no desire to send out a mass mailing. Others of
you might have already perfected the art of mass mailing but never realized
that a mail merge can be directed to one person or to thousands of people. |
hate to be the one to break your bubble, but if you have any kind of routine
documents that you're generating repetitively, you should be using ACT!’s
mail merge to do it.

The three things necessary to create a mail merge are

»* A name or a list of names: If you've followed this book to this point,
you’re the happy owner of a database and know how to create a lookup.
(Don’t know how to create a lookup? Better check out Chapter 6.) You
can merge a document with your current contact, your current lookup,
or the entire database.

v A program that can combine the names into the template: After you
have a list of names and a document template, you need something to
combine them. You could try to use your food processor, but I prefer to
use the mail merge feature in ACT!.

v A document template: A document template is a letter or form that sub-
stitutes field names in place of names and addresses or whatever other
information comes directly from your database. ACT! comes with a number
of document templates that you can either use as is or modify. You can
also create your own document templates by using a word processor.

Picking Your Word Processor

ACT! can use either its own word processor or Microsoft Word to create doc-
ument templates. By default, ACT! is set to use its own word processor. Most
ACT! users prefer using Word as their word processor, and [ assume that
you’re no different. Although the ACT! word processor gets the job done,
chances are that you're already using Word — and using an application that
you're already familiar with is preferable. You'll also find that the ACT! word
processor offers a far smaller array of features than Word.

If your word processing preferences inside ACT! aren’t set to use Microsoft
Word as your default word processor, you can’t use existing Word templates
or any templates that you created by using Word. To change your word
processor settings, follow these handy-dandy directions:

1. Choose Tools=>Preferences from the Contact Detail window.

2. On the Communication tab, select a word processor from the Word
Processor list.

In this case, you're choosing Microsoft Word.
3. Click OK.
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Using the out-of-the-box templates

For those of you all set to write The Great
American Novel, you might want to create all
your own original documents. That's great, and
| recommend that you skip to the section
“Creating a Document Template.” The rest of
you might be interested in perusing some of the
great templates that come prepackaged in
ACT!. Even if you decide that these templates
aren’t exactly what you're looking for, you can
use them as a starting point for developing your
own unique document templates.

You might want to run each of the templates one
time to determine which ones you think will
be most useful to you. Later in the section enti-
tled “Creating a Document Template,” you find
out how to modify them to your heart’s content.
Right now, | want to point out two of my
favorites that you might want to focus on. These
two document templates are listed for you on
the ACT! Write menu because you'll probably
use these two templates the most often.

1~ Letter: The Letter (Let ter . adt)template
is a great template to use when you need to
create a letter on the fly to one of your con-
tacts. It automatically dates a letter and

addresses it to your current contact. It even
includes your name, company, and title on
the bottom (the closing). All you need to
doisfillin the body of the letter and stick on
the stamp! You can also use this template
as a boilerplate for creating the rest of your
form letters.

Fax cover page: If you feel that you have
no need for ACT!’s fax cover page because
you already created something rather spiffy
with Word, you can convert that Word
document into an ACT! template to have
ACT! automatically fill in all the necessary
fields for you. You'll want to name that
template Fax Cover Page.adt and
replace the current Fax Cover Page.
adt template.

You'll notice the Other Document (From
Template) choice on the Write menu. Click
it and you'll find all the ACT! templates. You
might want to hold off using the Quote
template — it's designed for use with the
opportunities you create. Flip to Chapter 19
for more details.

Creating a Document Template

Before you can win friends and influence prospects with your dazzling dis-
play of personalized documents, you need two basic elements: the data and
the document template.

You're creating a template, not a document, to perform your mail merge. A
document is a plain old file that you create and use in Word. You use it once,
save it, and store it away for posterity or delete it as soon as you're done with
it. Comparatively, a template is a form that merges with your contact informa-
tion. The convenience of templates is that you use them over and over again.

WMBER
\‘&
&

With your data tucked away nicely in your database, all you have left to do is
to create the document template, which involves creating a form document.
Your document template contains placeholders that are then filled in with

151
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Figure 11-1:
The Add
Mail Merge
Fields

dialog box.
|

s

information from your database after you perform a merge. Create a docu-
ment template by following these steps:

1.

Choose Writer>New Letter/E-Mail Template.

If you chose Word as your word processor of choice, try not to look too
surprised when Word opens. (To review how to set this preference, see
the preceding section.)

. Resist the urge to close the Add Mail Merge Fields dialog box that’s

obscuring a portion of Word.

The Add Mail Merge Fields dialog box, as shown in Figure 11-1, is the
main event of this little procedure. If you scroll through the Add Mail
Merge Fields list, the various field names should ring a bell. After all —
they’re all your database fields.

Add Mail Merge Fields

Select Field Type:

JEontact

Arncess Level S

City

Address 1

Address 2

Address 3
Alternate Extension
Alternate Phone
Bith Date

Company

Cortact

Country

Create Date b

Add

Close

You can drag those pesky fields out of your way by placing your mouse
pointer on the Add Mail Merge Fields title bar and dragging this dialog
box out of the way.

. Change all your document settings.

Go ahead and change your font, margins, and other formatting items
exactly as if you’re working in a regular oI’ Word document.

. Create the body of your letter or form.

Nothing new under the sun here. You can backspace, delete, and type
just like you do in any Word document.

5. Click the spot in your document where you want to insert a field.

6. Determine what type of field you want to insert into your template.

The Add Mail Merge Fields dialog box allows you to insert three different
types of field information.

e Contact: If you want your contacts’ information to appear when you
perform a mail merge, you need to insert a Contact field into your
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template. In a letter, the name at the top that you're sending the
letter to is the Contact field.

Whatever information you’ve entered into a field appears in the
merged document. If any of the fields in the contact record are
empty, ACT! skips that field; you don’t see a blank line. In Figure
11-2, I inserted the Company field; however, if your contact isn’t
associated with a company, that line is skipped.

e Field Label: Selecting the Field Label option inserts the name of the
field, not the information contained in that field. You might wonder
why you want to go through the effort of scrolling through the list
of field names to insert a label when you could just as easily type
in the field label. I wonder the same thing!

My Record: If you want your own contact information to appear,
select the My Record field option. If you're creating a letter docu-
ment template, the name that appears at the bottom (in the clos-
ing) is your name and is represented by the My Record field option.

Your My Record information resides on the first contact record
that appears when you open an ACT! database.

7. Insert fields where you want contact information to appear.

Here’s where the fun begins. Every time you get to a part that could be
populated with ACT! information, you must scroll down that long list of
fields, select the one to insert into your template, and then click Add.

O \ d9-5 7 Lefter.adf [Campetitliy Modz] - Micro
= Pagelayout  Refersnices  Malings  Revis  View  Adddns -
= AU - (R e e [E S A A ‘AaBchD( asmnce: AaBbCe, ‘A B
T BT gk s YA EE || S ) TNormal | TMoSpacing  Headingl - 5;-‘*255 Edfhg
Cliphisard Font = h &
= L X B e S e i Aabil Wil Maige Flslis

Select Field Type:

|Cortact

Access Level
Adrhess 1
dchess 2
Adchess 3
<Contact> ﬁllemele E;Iens\un
hermiate Phone:
<Campany> Bith Date
<Business Line 1> Cily
<Business Line 2> Compary

<Business City>, <Business State> <Business Postal Code> Egﬁﬁfj

Create Date

July 15, 2007

Dear <Salutation>:

It has been a pleasure working with you during the recent ACT! implementation. Iknow that
you'llbe amazed by how efficiently your business will run, and how quickly your bottom line will
increasel

Fincerely,

e & ==l

Pagelofl | WordstSE o
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The field name appears in your document set off by a set of lovely angle
brackets. Treat these field names exactly as you do any other words in
your template. For example, if you want to see them set in bold, bold the
field name. You’ll also want to place the appropriate punctuation next to
an inserted field if necessary; for example, if you place the <Salutation>
field in the greeting line, you’ll want to follow it with a colon.

8. Check your document for accuracy and edit as necessary.
9. Choose File>Save As.

Okay, [ know that you probably already know how to save a document in
Word, but [ want to draw your attention to an interesting phenomenon
that occurs when saving an ACT! document template in Word. Your doc-
ument is automatically saved with the .adt extension. And, unless you
specify otherwise, your template is saved to your default template folder.
In Chapter 3, I show you how to determine the location in which to save
your templates and also how to add a document template to the Write
menu.

Document templates created with the ACT! word processor end in the
extension . tpl.

After you create a template, you can change it whenever the need arises. For
example, you might discover a spelling or grammar mistake. Or the contact
fields that you're using might not work correctly. You might even want to
make changes to the wording in some of the templates, including the out-of-
the-box templates. The procedure for editing your document template varies
only slightly from that of creating the document:

1. Choose Write->Edit Template.

2. When the Open dialog box appears, select the document template that
you want to open and then click Open.

The template opens in Word, and the Add Mail Merge Fields dialog box
automatically appears (refer to Figure 11-2).

When you edit an existing template, you see your field names in angle
brackets within the document rather than your data. If you see actual
data, you aren’t editing the template, and the changes that you make
affect only the current document that you're in; your document template
remains unchanged.

3. Make the appropriate changes to the template.

4. Click Save when you finish editing.
In general, using an existing template is easier than creating a new template
from scratch. Basically, to create a new template, you simply open a similar tem-

plate and follow the same procedure as if you're editing an existing template —
but save the file with a different name. Or, if the document already exists in
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Word, you might want to first open the existing document in Word, highlight
the information that you want to appear in your template, copy it to the
Clipboard, and then paste it into the new template.

Grappling with Graphics

So far I've been discussing your basic “vanilla” template. Any of the templates
that you create following the techniques in the preceding section can be trans-
mitted with either snail mail or e-mail. These templates can all contain merge
fields so that your written letters and your e-mail can be personalized to con-
tain any of the information found on a contact’s record. They can be created
using any of your font attributes including font type, size, color, bolding, ital-
ics, and underlining.

If you want to use ACT! as an e-marketing tool, you probably need to under-
stand a little more about the technology that’s involved in sending e-mail.

Basically, the two kinds of e-mail templates that you can create are

v+~ Plain text: These templates consist of plain old, black-and-white verbiage.

v HTML: These templates are colorful and very often contain graphics.

So, what’s the hang-up? In a word — graphics. Those company logos that you
want to include in your templates and send via e-mail can prove to be quite
annoying, troublesome, and just downright exasperating. Graphics need to be
properly embedded into the body of your template or linked to graphics that
are hosted on your Web site in order to avoid being sent as an attachment.

Think about it — have you ever received an e-mail from someone with a
graphic attached to it? You open that e-mail and see a big white box with a
tiny red X somewhere in it. Puzzled, you open the attachment and see a logo.
This is a perfect example of someone who forayed into the exciting world of
graphics and lost the battle. Here are a few tips to consider before sticking a
graphic into one of your templates:

»* You need to insert the proper HyperText Markup Language (HTML) code
into your template. The best way to accomplish this is to create the con-
tents of your e-mail in a program that can save it as HTML code, such as
Microsoft FrontPage. You can then insert the HTML-coded file into your
template.

v~ Still feeling dazed and confused when it comes to sending HTML e-mail?
Consider using an add-on product to help you create those templates.
You can read about one of my favorites, SwiftPage Email, in Chapter 24.
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Don’t lull yourself into thinking that your e-mail will properly transmit just
because it looks perfect when you edit or preview your template. Consider
creating a free Yahoo! or Hotmail e-mail account and send a trial e-mail there
to make sure the graphics display properly before sending them off to the
outside world!

Reaching an Audience of One

Now that you've created a document template — or edited one of the existing
ACT! templates — you're ready to fill in your template with contact information.
Don’t assume that creating a mail merge implies sending out a single message
to thousands of people at one time. A mail merge can also be used to automate
the most mundane and routine of tasks. You can use ACT!’s document tem-
plates to write a thank-you letter every time that you land a new client or to
write an inquiry letter each time that you receive a new lead. After you dis-
cover this timesaver, I guarantee that you’ll never go back to your old way of
creating documents again!

To send a document to a single member of your database, follow these steps:

1. Create a lookup to find the contact to whom you want to send a letter.
Feel free to turn to Chapter 6 if you need help creating a lookup.

The current contact record that you have displayed is the one whose
information fills in your template.

2. Choose Write and then choose Letter, Memo, Fax Cover Page, E-Mail
Message (From Template) or Other Document.

You can modify any of the ACT! menus. You might want to modify the
Write menu to include some of your own templates. Flip over to Chapter
3 if you need a little refresher course in adding new items to an ACT!
menu. When you start creating new templates, you can add correspond-
ing menu items to the Write menu.

You use the same templates for both snail mail and e-mail. When you
choose to write an e-mail from a template, ACT! will automatically open
the content of your template as an e-mail message. When you choose
any other option, ACT! will open your template in your word processor.

3. Complete the body of the document.

Depending on the type of document that you chose to create and the
modifications that you made to the document template, you're looking
at the start of a document. For example, by choosing to create a letter,
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Figure 11-3:
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history for a
written
document.
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the name, address, salutation, and closing are already provided. You just
need to add the body of the letter to complete it. If you choose Other
Document, you can choose either one of the other ACT!’s templates or
one of your own. These, of course, already include the body as well.

If you choose to create a fax cover sheet, you need merely to add the
number of pages in the transmittal and an optional comment to proceed.
If you choose to create an e-mail message from a template, you just need
to fill in the subject line and send it.

. (Optional) Save your document.

After you complete your document, you can save it to the location of
your choice. If you don’t think that it’s necessary to save the document
that you create from a template (because you can so easily re-create
them), you aren’t required to.

5. Print, fax, or e-mail your document.

If you use Word as the default word processor to create your ACT! docu-
ments, you can now print, fax, and e-mail exactly like you're already
used to doing in Word.

If you choose to print, the Create History dialog box appears after print-
ing is complete (see Figure 11-3). Now this is cool. I like to refer to this as
the “Would you like fries with that?” step. After you create a document
from a document template, ACT! creates a record of the document on
the History tab. You now have a history of the date on which you sent a
document. Better yet, other people in your organization are also aware
of your interactions with the contact. If you don’t want to record a his-
tory, select the No, Do Not Record History radio button.

Create History

Docurnent Printed; Frediicks Needs Assessment. docx

Record Histary
‘would wou like to recard a history for this contact?
(=) "Yes, record history

Regarding

Send Needs Assessment Lether

[ &ttach document to histary

() No, do not record histony

Frint Erwelope
‘would wou lke to print an envelope?
(=) Yes

O No
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¢ To have additional information appear in the note that’s added to the
History tab: Enter a description of the document in the Regarding
field. This description appears on the History tab regardless of
whether you saved the document.

¢ To attach the document to a note on the History tab: Select the
Attach Document to History check box. When you enable this
option, a shortcut to the document is automatically added to the
History tab; you can access the document by double-clicking the
attachment.

If you don’t want to create a history for the document: Select the No,
Do Not Record History radio button.

¢ To specify whether to print an envelope for the contact: You have
to hand it to ACT!: The program really tries to be as accommodat-
ing as possible. After you work your fingers to the bone creating
your latest tome, ACT! gently asks you whether you want to print
an envelope. If you select No, you're done with the letter-writing
process.

After you complete the special order for your mail merge, all that’s
left to do is to click the OK button, close your word processor, and
return to ACT!. If you select Yes to print the envelope, the Print
dialog box appears.

We're Off to See the Mail Merge Wizard

As easy as it is to create a templated message to a single contact, ACT! pro-
vides you with the Mail Merge Wizard to take the guesswork out of sending
your message to a whole bunch of people at a time. When you create a mass
merge to one or more contacts, follow these four basic steps:

1. Select the contacts to whom you’re sending the letter.

2. Select the template that includes both the contact fields that you want
to merge into the letter and the body of the letter itself.

3. Choose to send the output to your word processor, printer, fax machine,
or e-mail program.

4. Perform the mail merge.

Not surprisingly, ACT! takes the laborious task of mail merging and simplifies
it via the Mail Merge Wizard. Throughout the process, you encounter just a
few easy-to-navigate windows. Trust me — there’s no chance of losing your
way because ACT! holds your hand during the entire journey.
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To perform a mail merge, follow these steps:

1. Select the contacts to be the recipients of your mail merge.

To do so, either use a lookup to select certain contacts (such as all con-
tacts in a specific state, city, or company) or select contacts from the
Contact List.

If you're creating one of those charming Christmas newsletters telling all
about your two kids who just graduated from Harvard Medical School
and your recent month-long excursion to purchase two Mercedes —
leave me off the list!

2. From any ACT! view, choose Writec>Mail Merge.

ACT! acts a bit theatrical here, what with all the talk about wizards and
all. The Mail Merge Wizard opens with a screen that announces that
you're starting the Mail Merge Wizard. Like the coming attractions, you
can skip the first screen (just click Next) to go directly to the second
wizard screen.

3. Decide how you want to send the merge and click Next.
Decisions, decisions! The four choices on today’s menu are

e Word Processor saves all the merged documents into a single word
processor document. This choice is good if you want to review
your merged documents before printing them.

¢ F-mail sends all the merged documents as e-mail messages.

Q&N\BER This is a true merging process. If you choose to send out a mail

Y merge via e-mail, each recipient receives an e-mail specifically
addressed to that person. No one sees a list of the other recipients,
and you don’t have to mess with blind carbon copy (Bcc) options.
Best of all, the body of each e-mail is customized to the recipient.

e Printer is a good choice if you're sure that your contact information
and your template is perfect, as in error-free. This choice is also
popular if you like to chop down trees in the Amazon. This option
sends all the merged documents directly to the printer.

¢ Fax sends all the merged documents as fax transmissions. If this
option is grayed out, you don’t have ACT!-compatible fax software
installed on your computer.

4. Pick your template and click Next.

Indicate the template to use in your mail merge by clicking the Browse
button and selecting the name of the document template that you want
to use.
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The Mail Merge Wizard continues and demands to know, in a loud boom-
ing voice, what contacts you want. All right, you caught me in one of my
Judy Garland flashbacks. You can’t actually hear the question, but it
comes across loud and clear in Step 4 of the Mail Merge Wizard, as
shown in Figure 11-4.

;@eﬂ@g!ﬂe‘l\ﬂzarﬂ A4 of 5)

Select Contact
Select the cantacts to receve the mail merge,

a0

Select zontacts from:

151 Cutent Laokip

) Current Conbact
. Al Contaots

i1 Selectad Rroup:
|

Figure 11-4:
Choose the
contacts to
includeina
mail merge.
|

| Selected Company)

| cBack || Mews | Cancel

5. Choose to whom you want to send the mail merge and then click Next:

e Current Lookup merges your document with the contact records
that you choose in Step 1.

¢ Current Contact sends the merge only to the contact currently
showing in the Contact Detail window.

e All Contacts goes to everyone in your database.

e Selected Group enables you to merge your document with a spe-
cific contact group.

e Selected Company enables you to merge your document with all
the associates of a given company.

Depending on the send choice you pick in Step 3, you're pretty close to
the finish line. You can just click Finish in the recap screen that appears.

e [f you chose the word processor option, you can now spend the next
two hours reviewing 1,001 personalized letters to your dearest
friends and relatives, ensuring that all the information therein is
accurate.

e If you chose the printer option, you hear the happy sound of your
printer spitting out 1,001 personalized letters to your dearest
friends and relatives.
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e If you chose the fax option, your faxing software opens and you're
ready to fax.

6. You have a little more work ahead of you if you choose the e-mail
option.

Try not to be discouraged. Your e-mails will arrive at their intended des-
tination long before those people choosing one of the other options
even finish stuffing envelopes or decipher the new area code rules for a
fax transmittal. Besides, you're treated to the options that you see in
Figure 11-5. You can

¢ Type the subject line of your e-mail.

¢ Create a history of your e-mail by including the subject or the sub-
ject and message of your e-mail on the History tab. You also have
the options of attaching the entire e-mail message to a history or
simply creating no history at all.

¢ Send an attachment along with your e-mail.

¢ Specify that each recipient of your e-mail sends you back a Return
Receipt.

Mail Merge Wizard (5 of 7)

Set E-mail Options
Set the options to use for your e-mail mail merge.

L

Enter subject for e-mail;
September ACT Mewsletter

E-mail record higtory bype

Subject only .v

Altach file[s] to e-mail

Add...

[ Ratum Receipt

7. Click Next to continue and set your options for the contacts that have
missing e-mail addresses.

[ hope you feel appropriately ashamed by the fact that you made ACT!
work so hard while you simply sit back. ACT! now patiently asks you one
final question regarding your handling of those contacts that are missing
an e-mail address. As you can see in Figure 11-6, you have several
choices as to how to handle the MIAs.
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Mail Merge Wizard (6 of 7)

Set Options for Missing E-mail Addresses
You may have selected contact records that do not have e-mail addresses. Select an
optian for handling missing e-mail addresses.

Select an option:
(%) Omit those records from the e-mail mail merge.

(2 Omit the contacts) from the e-mail mail merge and record kistory as "not sent®

o Omit the contact(z] from the e-mail mail merge, but create a lookup of omitted contacts to
~ display when the merge i complete.
|

Figure 11-6:
Determine
the recip-

ients of your
mail merge.

|

() Cancel the e-mail mail merge. and create a lookup of contacts with missing e-mail addresses.

8. After you choose all your options, click Finish.

Congratulations! You have now completed in a very short time what used to
take hours and hours of work. Well done!
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ACT! E-Mail

In This Chapter

Choosing your e-mail preferences
Working with your contacts’ e-mail addresses
Sending e-mail

In this chapter, I show you how to integrate ACT! with your existing e-mail
client. ACT! enables you to send e-mail through it to an individual contact
in your database, to a selected group of contacts in your database, and to
people who are not in your database. You also discover the various prefer-
ence settings that are crucial in order to e-mail successfully.

Getting Started with ACT! E-Mail

To fully understand the e-mail portion of ACT!, you must understand the con-
cept of the e-mail client. An e-mail client is an application that runs on a per-
sonal computer or workstation and enables you to send, receive, and
organize e-mail. A senior executive at Sage Software once told me, “ACT! is
not in the business of designing e-mail clients.” What that means is that ACT!
doesn’t have to necessarily replace your existing e-mail client; rather, ACT!
can work on top of it. It also means that if you really want to send out a lot of
e-mail using ACT!, you probably want to investigate one of the add-on prod-
ucts that I mention in Chapter 24.

As of this writing, ACT! 2008 supports the following e-mail systems:

v Internet Mail (an internal standalone e-mail client that supports the use
of your SMTP and POP3 settings)

v Outlook
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v Outlook Express
v Eudora
v Lotus Notes

For years, ACT! users could not use America Online (AOL) as their e-mail
client if they wanted to integrate with ACT!. Programs, such as Yahoo!, Hotmail,
and AOL, use the IMAP protocol. ACT!, like most e-mail clients, requires the
SMTP/POP protocol favored by most Internet service providers (ISPs). (Don’t
sweat all the acronyms; just stick with me here.) However, I know a work-
around for those of you who can’t — or won’t — give up your AOL. Outlook
lets you configure an IMAP e-mail account. When prompted, set the Incoming
mail server (IMAP) to imap.aol.com and the Outgoing mail server (SMTP)
to smtp.aol.com. You can then configure ACT! to work with Outlook —
which is working with AOL.

“&N\BER The two most commonly used e-mail systems are Outlook and Outlook
& Express in the Windows environment. For the purposes of this book, I

assume that you have Outlook configured on your computer and that you
want to integrate ACT! to work with Outlook. For business purposes, Outlook
is probably the e-mail client of choice. With more features than Outlook
Express, it’s more attuned to the business environment. Outlook comes bun-
dled with most versions of Microsoft Office and is a common fixture on most
office computers. Outlook Express comes as part of the Windows operating
system. Because it’s a much more basic program, Outlook Express isn’t as
often used for business e-mailing.

Setting Vour E-Mail Preferences

If you initially set up your database with the Getting Started Wizard (see
Chapter 3, where I show you how to work your way through the wizard), you
already specified your e-mail system. If you’re working on an existing data-
base, here’s what you must do to configure ACT! for e-mail:

1. Test to make sure that your e-mail is functioning correctly outside ACT!.

Before you configure your e-mail preferences in ACT!, I recommend test-
ing your e-mail to make sure that it’s working correctly. Send a test e-mail
to your significant other via Outlook or Outlook Express. Doing so helps
eliminate problems if you have trouble e-mailing in ACT! for some reason.

2. Choose Tools->Preferences and then click the E-Mail tab.

The E-mail Preferences dialog box appears, as shown in Figure 12-1.
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3. Click the E-mail System Setup button and click Next.

The E-mail Setup Wizard opens, as shown in Figure 12-2.

E-mail Setup Wizard (2 of 4)

Select E-mail System

Select e-mail systems to use with ACT!

It pou choose to skip e-mail setup now, pou can set it up later in Preferences.

(%) Set up e-mail
Select one or more e-mail systems.
| Internet ai

Micrasaft Outlook
[[] Dutlack Express

() Restore transferred e-mail

(3 Skip e-mail setup

Cancel

4. Select your preferred e-mail client and then click Next.

e Internet Mail: If you select Internet Mail, you have a bit of work to
do. You're prompted to fill in several screens full of information,
including your user name, e-mail address, password, and the SMTP
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and POP3 assigned to you by your e-mail service provider. (You
might also be asked for your shoe size and blood type.) If you
don’t have this information, you have to call your ISP to get it.

e Microsoft Outlook: If you select Outlook, you're asked whether you
want to use the ACT! e-mail client or Outlook to view, compose,
and send your e-mail. If you choose the Outlook option, which I
highly recommend, Outlook opens every time that you initiate an
e-mail through ACT!. You can see the choices in Figure 12-3.

E-mail Setup Wizard (3 of 4)

Outlook Settings B
: B
Create or change your Dutlook. settings

Wwhen viewing, composing, and sending e-mails
() Uge the ACT! e-mail program
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Figure 12-3:
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the Outlook
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|
Vg‘\\\NG! If you're using Outlook Express, you can select that as your e-mail
N option. However, due to the limitations of Outlook Express, some of

ACT!s e-mail features aren’t available. If you're currently using Outlook
Express, consider using the ACT! Internet Mail option instead.

5. (Optional) If you opt to use Outlook in Step 4, you have a few more
steps:

a. Choose your e-mail client and then click Next.

This might seem a bit confusing but here’s the deal on the two
choices:

¢ Use the ACT! e-mail program: ACT!’s e-mail client is a mirror
image of Outlook. It opens when you send e-mail through ACT!;
however, the folders and all sent and received e-mail are identical
to the Outlook folders.

¢ Use the Outlook e-mail program: A new Outlook e-mail message
opens when you send e-mail through ACT!.

b. Click Yes to the prompt asking you to set up your Outlook address
book (see Figure 124).
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c. Click Add in the Address Books dialog box (see Figure 12-5).

Address Books
Add up to three ACT! databases o use as address books in
Outlook. Adding a database allows Outlook integration features to
wiork with that database.
Address books
Database tdachine Name Add
— ACT10Demo.PAD AMlocal]
Figure 12-5; Fencee
The
Address
Books
dialog box.
Cloze
|
d. Click the Browse button in the Add/Edit Address Book dialog box
(see Figure 12-6) to navigate to your database, fill in your user name
and password, click OK, and then click Close.
I | Add/Edit Address Book
Figure 12-6: | ~Datsbase
The Add/ ALT! Database:
. C:\My DocumentsMCT 10D emo PAD
Ed it Address User name: Password.
B OOk karen fredricks
dialog box.
S =3
|

6. On the final screen of the E-mail Setup Wizard, click the Finish button.
7. (Optional) On the E-Mail tab, click the Composing Options button.

Don’t worry if the button is grayed out — you’ll see this option only if
you're using the ACT! e-mail client. If you're using Outlook, you don’t
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have to set any composing options because you set them in Outlook, not
in ACT!.

8. Click OK after you configure your composing options to return to the
Preferences dialog box.

9. Click OK to close the Preferences window.

E-Mailing Your Contacts

MBER
“&
&

A benefit of sending e-mail from within ACT! is that a history of the event is
added to your contact’s History tab each and every time that you send an
e-mail. There’s even a Last E-mail address system field that automatically
inserts the date each time you send an e-mail. E-mail is an increasingly popu-
lar form of communication, so having a record of all the e-mail that you send
to each of your contacts helps you keep track of it all. You can send e-mail
messages to one or more contacts and attach contact records, group records,
or files to your messages.

Depending on how you like to reach your contacts, you can send e-mail to them
via ACT! in a variety of ways. You might send a one-time e-mail to an individ-
ual contact, or you might send a form e-mail to either an individual or a whole
group of your contacts. You might also want to send a spur-of-the-moment
message to one contact — or even thousands of your contacts. Explore the
possibilities.

E-mailing an individual contact
To send an e-mail to the current contact, follow these steps:

1. Create a new e-mail message using one of the following methods:
e Click in the contact’s E-Mail field.
e Choose Writew>E-Mail Message.
e Click the Write E-Mail Message icon on the icon bar.

These methods all result in a new message (see Figure 12-7). You'll
notice that the contact’s name already appears in the To field.

These methods all bring up the e-mail message in the Outlook e-mail
client. After you select Outlook as your e-mail system and choose to
compose your e-mail via ACT!’s e-mail client, your e-mail opens in ACT!’s
e-mail client.

2. Fill in the Subject field and create your message.

At this point, you’re composing your e-mail message exactly as if you
were using Outlook because you are using Outlook!
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3. Click the Add-Ins tab.
Feel free to attach the e-mail to an ACT! contact, pick an ACT! History
option, or make the history public or private by selecting the corre-
sponding options from the Add-Ins toolbar.
3

In Chapter 18, I explain the ACT! history preferences that you can set
from within Outlook. You can choose to record — or not record — a
history each and every time you send an e-mail.

4. Click Send.

Off your e-mail goes. Depending on the History option that you choose, a
message appears on the contact’s History tab.

Sending mass e-mails

ACT! makes a distinction between sending e-mail and sending merged e-mail.
Merged e-mails all share the following characteristics:

» When you send a merged e-mail, ACT! relies on a template.

v When you send a merged e-mail, you must include at least one contact
field in your template.

v E-mail merging in ACT! allows each individual contact name to appear in
the To line rather than having to send the mail via the Bcc (blind carbon
copy) field.
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Important things to consider when sending a mass e-mail

Before jumping headfirst into the world of mass e-mailing, consider the fol-
lowing important points:

v Test your e-mail preferences. You should test your e-mail preferences
before sending your missive out to thousands of people. If you don'’t,
you might find yourself with a thousand e-mails in your outbox that
can’t be sent. Try sending a sample e-mail to a friend or colleague.

v~ Test your e-mail template. Again, testing your message before sending it
across the universe is always a good idea. Try sending the message to a
co-worker or colleague first. Having correct spelling and punctuation
isn’t a bad idea, either. Make sure the graphics can be viewed correctly,
as I mention in Chapter 11.

You might discover that although your templates look picture perfect
when you first create them in Word, they look a bit spacey when you
attempt to use them as e-mail templates. You might find that your mes-
sage now appears to be double-spaced. Basically, something was lost in
the translation from Word to HTML. You can correct this quite simply by
returning to the scene of the crime — or in this case, the original tem-
plate — and holding down Shift each time that you press Enter to create
anew line.

v Check with your ISP. Many ISPs have implemented safeguards against
spam. Before you send an e-mail to all the contacts in your database, call
your ISP to find out how many e-mails you can send at a time. If your ISP
limits the number of e-mails you can send at one time, you need to send
your mailings in smaller groups or purchase an add-on product that
sends your e-mail in batches. You can discover more about these prod-
ucts in Chapter 24.

1 Read up on the Can Spam laws. Laws are in place that require your
e-mail to contain various elements, including your correct contact infor-
mation and a way for recipients to opt out should they not want to hear
from you.

Sending non-merged mass e-mails

If you're not entirely comfortable with the concepts of e-mail blasting, you
might want to start out by sending a non-templated e-mail to your contacts
rather than attempting an actual e-mail merge. This way is great for less
computer-oriented ACT! users to reach a large number of contacts.

You can send non-merged e-mail at the spur of the moment because it doesn’t
involve the creation of a template. However, you can’t customize the To or
Subject portions of the e-mail with any of your contact’s specific information.
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To send an e-mail to any number of your contacts, here’s all you have to do:

1. Create a lookup (Chapter 6 shows you how) to find the contacts to
whom you want to send the e-mail.

The Contact List opens with your contacts. For example, if you want to
send an e-mail to all customers in the Southeastern region, create the
lookup and then narrow it to include only those contacts that have an
e-mail address.

Narrow your lookup by choosing Lookup=>E-Mail Address. Next, select
Narrow Lookup for the current lookup and then click Non-empty Fields.
Voila! Your lookup is narrowed to include only those contacts with an
e-mail address.

2. Click the Tag All button on the top of the contact list.

All the contacts in your current lookup are now magically highlighted in
a stunning shade of gray.

3. Right-click the selected contacts and choose Write=>E-Mail from the
contextual menu.

As quick as a speeding bullet, a new message opens with all your
selected contacts appearing in the To field. If the mood hits you, feel free
to cut all those addresses and then paste them into the Bcc field.

4. Fill in the subject field and compose your masterpiece.
5. Choose your ACT! history option and click send.

ACT!isn’t perfect — although it comes pretty darned close! The e-mail
checker finds contacts with blank e-mail addresses as well as those missing
key pieces of information, such as the @ character. If you don’t know some-
one’s e-mail address, leaving it blank is better than inserting something
cute like N/A that can confuse — or at least slow down — the checker.

Don’t know whether an e-mail address is correct? Right-click any under-
lined name and choose Properties to sneak a peek at the e-mail address
you have on record for that contact.

Sending a templated e-mail to a party of one

Using ACT! to create an e-mail merge enables you to send personalized tem-
plates for each recipient. The cool thing about ACT! templates is that you can
use them for either snail mailing or e-mailing. In Chapter 11, [ show you how
to produce a mass mailing. The Mail Merge Wizard provides you with the
option to snail mail as well as e-mail.

If you want to send a thank-you e-mail to just one of your contacts and don’t
want to go through the entire wizard again, here’s a shortcut. From any ACT!

171
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screen, choose Write>E-Mail Message (From Template) and then select the
template that you want to use for the body of your e-mail. Voila — your tem-
plate appears in the form of an outgoing e-mail, which you’re now ready to
send as soon as you enter in the subject line.

Mail merge must include at least one mail merge field. If you aren’t personal-
izing your e-mails, you need to choose a different method of e-mailing. Also
keep in mind that you’ll probably want to create a lookup of the contacts you
want to e-mail before starting the e-mail merge so that your e-mail will reach
the correct recipients!

Editing e-mail addresses

The one critical ingredient of sending an e-mail is having an e-mail address.
No doubt you've already added many e-mail addresses to your ACT! data-
base, but I'm guessing that you haven’t yet discovered a good way to correct
or change existing e-mail addresses.

ACT! is designed to launch the e-mail window when you click the E-Mail field
in the Contact Detail window. This feature allows you to easily send e-mail in
ACT! but makes editing existing addresses difficult.

To edit an E-Mail address, try one of these methods:
v Use the Tab key to move the cursor to the E-Mail field. After the cursor

is in an E-Mail field, you can edit it just like you would do in any field.

v Right-click the E-Mail field and choose Edit E-Mail. You can now edit the
E-Mail field.

v Hold the cursor over the E-Mail field and wait a few seconds; the cursor
changes from a hand to a vertical line, which is ACT!"’s way of telling you
that you can now edit the field.
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In this part . . .

0r1 the surface, ACT! is a deceptively easy program to
master. However, those of you who are so inclined —
or didn’t run fast enough — might want to add ACT! data-
base Administrator to your current job description. The
database Administrator is in charge of adding new fields
to the database and making sure that they are artistically
placed onto your layout. Need to take your database with
you? You'll be able to synchronize your database with a
little help from this section. Need to make sure you data-
base is safe and secure? This section has your back cov-
ered! Best of all, when things go wrong, guess whom every-
one will turn to? Not to worry, though — just turn to this
section for help.




Chapter 13

Creating and Editing
Contact Fields

In This Chapter

Understanding the field concept
Thinking before adding fields
Adding a custom field

Deleting fields

Limiting access to fields

Managing the ACT! drop-down lists

In this chapter, I show you (that is, all of you who have Administrator- or
Manager-level rights to your databases) not only how to add new fields to
an ACT! database, but also how to set the various field parameters to help
users use the database more effectively and efficiently. [ show you how to
delete fields — or if you have ACT! Premium 2008, how to limit the access to
a field. Finally, I show you how to maintain consistency in your database
through the use of drop-down lists.

Understanding the Concept of Fields

[ am a firm believer that a little knowledge is a dangerous thing. Although
adding a field to your ACT! database isn’t hard, it is something that should be
well thought out and planned in advance. This is particularly true if you plan
to share your database with other users. Planning is important because you
usually have a goal in mind for your database. For example, if your goal is to
create a report with three columns — contact name, birthday, and Social
Security number — you need to make sure that all those fields exist in your
database. Planning also prevents you from adding thousands of contacts to
your database, only to find that you have to modify each record to include
information that was omitted the first time around!
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To add a field to your database, you must be a database Administrator or
Manager; the makers of ACT! made this a requirement so that you understand
the importance of this responsibility. So unless you have those rights to the
database, you don’t even have to read this chapter! [ suppose you still could
just for curiosity’s sake, but it isn’t necessary.

Before getting started, I want to briefly outline the three steps involved with
adding fields to a database:

1. Understand why you want to add fields and what purpose these fields
will serve.

2. Determine what fields you’re going to add and what drop-down lists will
be available in each and what type of data will be stored in them (dates,
numbers, drop-down items)

[ can’t stress enough the importance of this step. Plan ahead! Or you
might end up with a big mess. . ..

3. Add the fields.

And, voila! You're done. (Okay, this one has a whole bunch of steps, but
you get what I mean.)

For most of you, adding a field to your database will be easy. After all, you're
good at following directions. However, for some of you, knowing why to enter
a field can prove to be more challenging.

To explore the question of why, I first want to reiterate the basic concept of
fields. What the heck is a field? A field is a single piece of information. In gen-
eral, a field contains just one piece of information. For example, you have
only one business ZIP code; therefore, you have one business Zip Code field.
Alternatively, you probably have several phone numbers: home, business,
toll-free, cellular, fax, beeper . . . and the list goes on. Each of these phone
numbers requires a separate field.

A good field holds one fairly specific piece of information. A bad field con-
tains too much information. For example, having a separate field for your
street address, city, state, and ZIP code is a good thing. These separate fields
allow you to perform a lookup based on any of the criteria: You could find
clients by ZIP code, city, or state. An example of a bad field is lumping all the
address information into a single field; in this example, you’d then lose your
ability to perform a lookup by ZIP code, city, or state. (Need a refresher on
performing lookups? Head to Chapter 6.)

Consider the following basic rules when determining the criteria for adding a
field to your database:
1 A field contains an important tidbit of information.

v A field can be used to perform a query or sort. For example, you might
want to send a mailing to all your customers in New York and sort your
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mailing by ZIP code. To do this sort, you need separate fields for contact
type, state, and ZIP code. You also need a field to distinguish your cus-
tomer contact records from your vendor and prospect records.

v~ A field can be used to insert information into a report or template. If
you want to create letters thanking one person for buying a purple
polka-dot vase and another for buying a leopard-print vase, you need a
vase type field.

Do Vour Homework!

Okay, | admit it — I'm a former secondary school teacher, and I guess that
background just naturally spills over into my ACT! consulting. Well, class,
pretend you’re back in school because you’re going to be assigned some
homework. I consider it important homework that you must complete prior
to jumping in and adding new fields to your database, so your assignment is
as follows:

1. Jot down all the fields that you want to see in your database.

Most of the fields you want to see, such as company, name, phone
number, and address, are already included in ACT!. What you need to
decide here is what fields, if any, are specific to your business.

2. Scurry around the office and collect any documents that you want
ACT! to create for you. This includes both forms and form letters.

You'll have to get a little high-tech here, but I think you can handle it. Get
out your trusty highlighter and highlight any of the information in each
document that is contact specific. For example, each contact has its own
unique address. Maybe you're thanking particular contacts for purchas-
ing widgets (as opposed to gadgets, which you also sell). This means
that you need a Product field.

3. Think how to populate the fields with drop-down lists. Then on the
list that you started in Step 1, jot them down to the side of each of the
fields.

For example, if you run a modeling agency, you might need a field for
hair color. The drop-down choices could contain red, blonde, black, and
punk pink.

4. Sketch out any reports that you want to create from ACT! and add the
column headings to the now rather long list that you created in Step 1.

The idea here is to get your thoughts down on paper so that you can
visualize how you want your ACT! report to look. If you already have a
sample of your report in Excel, you can use that. If not, get out your
trusty pencil and outline on a piece of paper what you want your report
to actually look like.

177
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5. Get out a red pen. At the top of your paper, write 100%, Well Done
and then draw a smiley face. Hang your list on your refrigerator.

Okay, that last step isn’t really necessary, but now you're well on your
way to having the database of your dreams!

Dust off your thinking cap while you create your list. Sometimes one field will
do the job, and other times you might need multiple fields. For example, sup-
pose you sell widgets that are red, white, or blue. In one scenario, a customer
needs to buy only one widget; in this case, you create a product field with
three choices in the drop-down list — red, white, or blue. Or perhaps you
manufacture a different kind of widget; in this case, a customer would hope-
fully buy one of each color. This time, your purposes would be better served
by creating three fields — one for each type of widget.

Adding a New Field to Your Database

\\3

Believe it or not, after completing your homework (see the preceding sec-
tion), you're done with the hard part of the task. The actual addition of fields
is relatively easy; just follow the steps.

Only an ACT! user with Administrator or Manager privileges can add new
fields to an ACT! database. If the Define Fields option is grayed out in Step 1,
you aren’t logged in as one.

1. In any ACT! view, choose Tools=>Define Fields.

The Contact Detail window is generally a good place to start for most of
your customization projects. The Define Fields dialog box appears, as
shown in Figure 13-1. The View Fields For drop-down list indicates that
you're editing or adding new contact fields to the database. You can also
add new group and company fields and edit opportunity fields in your
database by switching the View Fields For list to the appropriate choice.

ACT! doesn’t allow you to add new fields or edit existing fields while
other users are logged on to the database. If other users are logged on to
the database, a warning appears that lists those users’ names and the
names of their computers. What to do? Storm over to their workstations
in a huff and demand that they exit ACT! immediately. If that doesn’t
work, consider bribery. Conversely, as long as you're editing fields, other
users can’t access the database. To avoid frustration on everyone’s part,
you might want to explain this concept to the users of your database.

2. Start by renaming one of the ten user fields. You find all your fields
listed alphabetically by field name. Select one of them.

This is where you need to drag your homework off the refrigerator and
type in one of the fields that you had planned to create in the Field Name
box. ACT! supplies you with ten user fields that you can customize to
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better serve the needs of your business. After all, Social Security Number
is a lot more meaningful than User 2.
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3. Click the Edit Field option in the Field Tasks section.

As usual, you can do this in more than one way. If you prefer to double-
click one of the existing field names — go for it! Either way, you're

rewarded with the first screen of the Define Fields wizard that looks like
the one shown in Figure 13-2.
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Field name:

Dummies
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[ Primary Field - Copy this field when dupiicating the record

[ Use diop-down st

<Back | [ MNet»

Cancel

| E_Frish |

When you run out of user fields to rename, feel free to click the Create
New Field option in the Field Tasks area.

ACT! rewards you with a blank, new field in the Field Name box and assigns
it the name New Field until you can think of something better to call it.

At that point, the following steps are identical to the steps you follow for
editing a field.
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4. Type a field name.

Try not to get too fancy or long-winded when naming your fields. Using
special characters, such as % or #, can cause problems when creating
queries, mail merges, or reports, so [ recommend that you not use them.
You can use spaces in the field name, but don’t end a field name with a
space. And because long field names can be hard to place into mail
merge templates and layouts, you're better off keeping field names as
short as possible.

5. From the Field Data Type drop-down menu (refer to Figure 13-2),
choose a field type for the field that you're adding.

You can create a variety of different types of fields. Actually, 18 different
field types are available, but who’s counting? If you're renaming one of
the user fields, your choices include

e Annual Event: Like it or not, some events take place once a year.
Use this field to find birthdays, anniversaries, and yearly renewals
regardless of the year.

e Character: This is probably the most common of the field type
choices; a character field can contain both numbers and charac-
ters.

e Currency: This field comes equipped with a dollar sign, appropriate
commas, optional decimal places, and a sunroof (optional).

¢ Date: When the time comes for you to enter information into a Date
field, you see a tiny little calendar that enables you to select a date.
The calendar supplies a useful purpose. If you create a field for a
birthday and make it a character field, the other local yokels using
the database might get creative and input anything from Jan 1 and
January 1* to 01/01 and 1/1. Finding all birth dates in the month of
January would become an exercise in futility.

¢ Date/Time: When you want to be really exacting, create a
Date/Time field to record the exact date and time of an event.

e Decimal: This field accepts only numbers, a decimal point, and
more numbers.

e Jnitial-Caps: The idea behind the Initial Capitals option is that you
can turn KAREN FREDRICKS into Karen Fredricks. Seems like a great
idea on paper. In reality, however, you end up with /bm Corporation
and Mcdonalds.

¢ Lowercase: i suppose you might want to type in all lowercase. i just
can’t imagine why:.

e Memo: This is where you can store a large amount of information
that you don’t want to risk burying away amidst your other notes.
For example, you might want to include your driving directions in
this area.
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e Number: This option enables you to enter only numbers into a
field. Say you want to find all your customers that have more than
30 employees. You can easily search for a number greater than 30,
whereas you can’t possibly search for a number greater than thirty.

e Time: If time is of the essence, this is where you can input a time.

e Upper Case: I NEVER TYPE IN ALL UPPERCASE BECAUSE I FEEL
LIKE I'M SCREAMING. BESIDES, I'M AFRAID I MIGHT DEVELOP
POLYPS ON MY FINGERTIPS.

e URL Address: Use this field type if you need to associate another
Web address with your contacts.

If you're creating a brand-new field, ACT! gives you all the choices on the
menu above plus a couple of brand-new ones:

e Address: Talk about a timesaver! When you designate a field as an
address field, ACT! automatically creates seven fields: three for the
street address, and another four for the city, state, ZIP, and country.

e F-mail: It used to be that everyone you know had several phone
numbers. Now, the chances are pretty good that your contacts
have numerous e-mail addresses. Here’s your opportunity to
include as many as you like.

e Phone: In Chapter 4, I show you all those nifty things that ACT!
does to speed up the data input process. If you designate a field to
be a Phone field, you automatically get a year’s supply of dashes.

e Picture: A picture is worth a 1,000 words, and here’s where you can
stick a picture of each client or a picture of each product that they
bought.

¢ Yes/No: This actually creates a check box field that you can mark.
Call me old-fashioned, but I think Check Box would’ve been a more
appropriate name. To further confuse the issue, a query on this
field looks for True or False values.

6. Assign any of the four optional attributes for the field being added
and click Next. Feel free to choose several attributes if you wish.

Depending on the field type you select, all these features might not be
available. For example, if you choose the Date field with the cute little
calendar, you won’t have the drop-down list option.

e Allow Blank: If you want to require that a field must be filled in, you
need to remove the check mark from this field. Use this option if
you want to require a user to enter information into a certain field.

¢ Generate History: This neat little feature generates a history on the
History tab when you change the contents of the field.

e Primary Field: When you duplicate a contact record, the primary
fields are the fields that are duplicated.
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e Use Drop-Down List: When you choose this feature, you can pick an
existing drop-down list or create a new, unique drop-down list. I
cover creating drop-down lists later in this chapter in the “Creating
a drop-down list” section.

7. Customize your field further by choosing from the following optional
selections and then click Next.

The next screen of the Define Fields wizard opens, offering you a few
more choices for your editing pleasure.

¢ Default Value: If 80 percent of your database consists of customers,
you might assign Customer as the default value of the ID/Status field.

e Field Format: If you want dashes or another symbol to appear auto-
matically in a field, here’s the place to do it by inserting the symbol
where you want data to go. For example, a Social Security number
looks like ###-##-###4#.

¢ Field Length: You might want to limit the number of characters that
a user can enter into a given field; for example, you can limit a field
looking for values of Yes or No to three characters.

<® Trim the field length whenever possible. If the longest value in a
field is Yes and the field length is 75, you've created a lot of dead
space. Cutting down the field length helps reduce the size of your
database, which ultimately increases performance.

e Link to company field: Check this box and select a company field
from the drop-down box if you want to link a contact field to a com-
pany field. Consequently, when you update information in the com-
pany record, you're given the option to update all the associated
contact records as well.

8. Set optional triggers.

Adding a trigger to a field causes something magical to happen when
entering data into a field. For example, you might want an Excel spread-
sheet to open when you move your cursor into the field, and an activity
series to start when you leave the field. In Figure 13-3, you see three
ways to start a trigger: when changing a field, when entering a field, and
when leaving a field.

For each type of trigger, you can assign one of three possibilities:
e None: If you want nothing to occur, choose this option.

¢ Programs: Clicking the Browse button allows you to navigate to vir-
tually any file in your computer. You can browse to a program, a
URL, or even to a specific file.

¢ Activity Series: Clicking the Browse button takes you to a list of the
activity series that you created. If you haven’t created any activity
series, pay a visit to Chapter 8 to find out how.

9. Click Finish.
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Deleting a Field

If you delete a field from a database, all data in that field is deleted. Forever.
Permanently. Delete a field only if you're sure that you no longer need that data.
The core fields — including Company, Contact, Address, and ID/Status — are
so important that ACT! won'’t allow you to delete them. As an alternative, you
can delete those fields from your layout so that they can’t be accessed.

Ironically, the monumental task of deleting a field is ridiculously easy to ful-

fill. To do so, just follow these steps:

1. From any ACT! window, choose Tools~>Define Fields.

The Define Fields dialog box appears.

. From the View Fields For drop-down list, select the record type

(Companies, Contacts, or Groups). Then from the list, select the field
to delete.

[ don’t think [ need to mention how important it is that you click the field
you want to delete and not one that you mean to keep.

3. In the Field Tasks list (upper left), click Delete Field.

4. Click Yes to confirm the deletion.

That’s all, folks. If you're waiting for a second reminder asking whether
you're really, positively, 100 percent sure that you want to delete the
field, you’ll be waiting for a very long time because it’s not going to
happen. Any information associated with the field will be gone perma-
nently. However, a ghost of the field will still appear on your layout,
which you’ll discover can’t be edited. To remove the last vestiges of
your deleted field, flip to Chapter 14 where you can read how to delete
fields and field labels from a layout.
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Securing Access to Fields
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In Chapter 16, you can read how to secure access to specific contacts so that
some users can see a contact and others can’t. ACT! Premium 2008 has a
brand-new, long-awaited feature — field level security.

A credit card number is a great example of a field that you might want to
secure. The bookkeeper might have full access to the field because he needs
to be able to add or change credit card numbers. The order takers might
need to see the numbers but not change them. Finally, the fulfillment center
might not have any reason to access those numbers; in fact, management
would probably rest a bit easier knowing that the fulfillment center can’t see
those numbers!

Field level security is a Premium feature. If you're using ACT! 2008, feel free to
skip to the next section — or upgrade to Premium.

What you see is what you get

Before securing a field, you need to understand exactly what happens when
you limit access to a field. The following are the three levels of access rights
to a field:

v~ Full Access: Users can see and modify the data in a field.

+ Read-Only: Users can see data in a field but can’t change it. The fields
appear to be grayed out in the same manner as a system field.

1 No Access: Users can neither see nor modify the data. In essence, they
don’t even know that the field exists.

You can’t limit the access to certain types of fields. These include

v System fields that are populated by ACT!, including Record Creator,
Creation Date, and Edit Date.

v Fields, such as Last Results, that are set to record a history can’t be set
to No Access because obviously a user could find out what was in the
field by reading the contact’s History tab!

v Fields that appear in the basic Lookup menu, including company, last
name, and e-mail address.

v Contact fields that are linked to Company fields.

If your access to a field is set to read-only, you can’t import information into
your database — even if you're a database Administrator or Manager. If you
don’t have access to a field, you’ll find that you're limited in a number of
other ways as well:



Figure 13-4:
Globally
limiting
access to
a field.
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v With the exception of the Define Fields dialog box, you can’t see the
restricted field name in any of the field lists found throughout ACT!. That

means you can’t add that field to a report template or even have it show
up on the Contact List.

v The information won’t appear on a report or template.
v The field can’t be used as a duplicate scan criterion.

v The field won’t sync to your handheld device.

Battening down the hatches

As usual, understanding the concept is the difficult part; securing your fields,
however, is quite easy. To secure access to a field, follow these steps:
1. From any ACT! window, choose Tools =>Define Fields.

The Define Fields dialog box appears.

2. From the View Fields For drop-down list, select the record type

(Companies, Contacts, or Groups). Then from the list, select the field
that you want to secure.

3. In the Field Tasks area, click Field Security.

The Field Security window, as shown in Figure 13-4, opens for your edit-
ing enjoyment.

Define Fields
(® Back % Home
Details [ 2]
Name: Department Deefault permission i+ applied to all users. Edit the user or team permission to ovenide the
Type: Character defaul
Fecord Type: Contacts
Cieated: 5/24/2006 Default access for all users
Spstem Field Field Default Permissior
Full Access [v
Users | Teams
User pemmissian takes precedence over team and defaull permissions.
Users Acoess Based On
Alison Mikola Full Access Default Permission
Betty Browser Ful Access Default Pemission
Chris Huffman Full Access Default Pemission
Ermst Andersan Full Access Default Pemission
Fred Fendsting Full Access Default Pemission
Jonathan Sommer Ful Access Default Permission
Julistte Rosseus Ful Access Default Pemission
Karen Frediicks Ful Access Default Permission
Melissa Pearce Full Access Default Permission
Sarah whiing Full Access Default Pemission
< Back c Finish

4. Select a Default Permission from the drop-down list.

The concept is that you select a default permission from the menu
choices — No Access, Read Only, or Full Access. That choice determines
how all users in the database view — or not view — the field unless you
then change the permission on a user-by-user basis.
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5. Select all the users that you want to give a different access right (other
than the default permission).

\
You can highlight several users at a time by holding down Ctrl while
selecting the desired users with your mouse.
6. Click the Edit button.
The Edit Users dialog box opens, just like the one in Figure 13-5.
Edit Users
Select one or more users and choose the desired access level for: Contact
Field: Diepartment
Users ficcess
Allison Mikola Full Access
Betty Browser Full fccess
Chriz Huffman Full &ccess
Emst Andersan Full Access
Fred Fenderling Full Access
Janathan Sommer Full Access
Juliette Roszeus Full Access
E— Karen Fredricks Read Only
telizza Pearce Full Access
Figure 13 5. Sarah ‘Whiting Full ccess
Editing the
access for
fl c Access Level:
SpBCI Read Only ~
users. [ Ok J [ Cancel ] [ Apply
I
7. Choose the desired access level for the selected users and click OK.
You find yourself once again in the Define Fields dialog box; refer to
Figure 13-4. You'll notice that the access level of each user is listed.
8. Click Finish when you’re done and then click Close from the main
Define Fields dialog box.
\\3

Not sure which fields you have limited? Sneak a peek at Figure 13-1 to see the
little padlock icon next to the Customer ID field. That cute little picture is
there to remind you which fields have limited access rights.

Working with Drop-Down Lists

The sure-fire way to destroy a database is by adding information in an inconsis-
tent manner. Drop-down lists help ensure that users input data in a uniform
way. As an added bonus, drop-down lists also save you time; when you type
in the first several letters of an item in your drop-down list, ACT! responds by
completing the word for you.

In ACT!, you find three major list types. Two of them, the Product List and
the Process List, are associated with your Opportunities. The other list type,
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|
Figure 13-6:
Configuring
a drop-
down list.
|

Drop-Down, is associated with your contact, group, company, and opportunity
fields. Although you can add new items to a list while you’re using it, manag-
ing your lists in one central location — the define fields area — is easier.

Creating a drop-down list

Associating an existing drop-down list with a field requires two things:

v Creating a drop-down list

v Specifying that the field is to contain a drop-down list
Although which one comes first doesn’t matter — the field or the drop-down
list — I start by creating the drop-down list:

1. From any ACT! screen, choose Tools=>Define Fields.

If you just created the drop-down field (see the preceding section), you
can skip this step because you're already there!

2. Select Manage Drop-Down Lists from the List Tasks area.
The Create, Edit, or Delete Drop-Down Lists window appears.

e To create a drop-down list: Click Create Drop-Down List from the
Drop-Down List Tasks area.

¢ To edit a drop-down list: Select the drop-down list and then click
Edit Drop-Down List from the Drop-Down List Tasks area.

The Enter Drop-Down List Name and Type window opens, as shown in
Figure 13-6.

Define Fields
(®) Back (% { Home

Drop-down list name:
Credit Card Types

Tope:
Character v

Description {optional);
Do you accept Amex, Visa or MC?

Allow users to edit items in this list

] Automatically add new items users enter to the list

<Back | [ Mew» ][ Fwsh [ Cancel
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3. Configure the following drop-down list options and then click Next:

® Drop-Down List Name: Use a name that very closely resembles the
name of the field that will be associated with the drop-down list.

e Type: Choose what type of field goes in the list — for example,
character.

e Description: If you have a lot of drop-down lists, you might need to
give your list a bit further explanation.

e Allow Users to Edit Items in This List: Users have the ability to edit
the drop-down list while they enter contact information.

e Automatically Add New Items Users Enter to the List: This lets your
users define the items that will be used in a drop-down list by auto-
matically adding each item they enter into the drop-down list.

Be very cautious about including those last two options. Allowing users
to edit items in the drop-down list can carve away at the standardization
that you've strived so hard to maintain. If you decide to allow users to
automatically add new items to a drop-down list, you might want to do
so only temporarily. Although this option is a great way to build a drop-
down list from scratch, you run the chance of creating a mess. Make
sure that all users have a good idea of the kind of items that should —
and shouldn’t — be added to the drop-down lists. And, more impor-
tantly, make sure they peruse the existing entries in the drop-down list
before adding new items to avoid duplication.

. In the Enter Drop-Down List Values window, as shown in Figure 13-7,

click one of the following buttons:

e Add: When you click the Add button, your cursor jumps down to
the bottom of your list of drop-down items; proceed to Step 5.

¢ Delete: This permanently removes the selected item from the drop-
down list. However, previously entered information based on the
removed drop-down item still remains in your database.

. After clicking Add, type in the drop-down list item and an optional

description.

Chances are that you don’t need to include descriptions in your drop-
down list. Once in a while, though, they can prove to be priceless. For
example, the State drop-down list consists of the two-letter state abbre-
viations; the description includes the full name of the state for those of
us who can never remember whether MA stands for Maine, Maryland, or
Massachusetts!

. Click Finish when you finish adding all the items you want to your

drop-down list.
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Define Fields
(® Back % Home

Import diop-down list items

Expart drop-daun lst items i Description Add

|
Figure 13-7:
Adding
items to

a drop-
down list.
|

Com) | e | o] e

Adding the drop-down list to a field

This might seem like a case of “Which came first, the chicken or the egg?” In
the preceding section, I tell you how to create a drop-down list. Typically,
your next step is to create a field and associate the drop-down list with it. In
other cases, you might create a field, create the drop-down list, and then edit
the field to associate the drop-down list with the field.

Here’s what you need to do to edit an existing field and associate it with a
drop-down list:
1. From any ACT! window, choose Tools~>Define Fields.
The Define Fields dialog box opens in all its glory (refer to Figure 13-1).

2. Click the field name that you want to contain a drop-down list and
then click the Edit Field option in the Field Tasks area.

The first of the Define Fields dialog box windows opens.
3. Select the Use Drop-Down List check box.

If you want to use an existing drop-down list, here’s your golden oppor-
tunity. For example, the 50 U.S. states are the same for mailing, business,
and home addresses. You could have one State drop-down list and asso-
ciate it with the mailing, business, and home state fields.

4. Click Finish.

Whew! That was easy.
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Figure 13-8:
Editing the
Product List.
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Managing the Product List

In Chapter 19, you can find almost everything you need to know about the
exciting world of Opportunities — and believe me, there are a bunch of cool
things. However, in this chapter, you discover how to modify your opportu-
nity fields — and the drop-down lists associated with them. You’ll also find
out how to input a list of the products or services that you routinely sell to
your customers or clients.

Don’t think that because your company doesn’t sell widgets — or some simi-
lar item — that you can’t use the Product List. Perhaps a better name for
this field would’ve been Products/Services. At any rate, if you're gaining
financially from your customers, use the Product List to help you analyze
your profit centers.

To modify or create your Product List, follow these steps:

1. From any ACT! screen, choose Tools=>Define Fields.
The Define Fields dialog box opens.
2. Click Manage Product List.

The Manage Product List dialog box opens, as shown in Figure 13-8.

3] Manage Product List
Enter product list items:
MHame Itern Number Cast Price Add
Bulk Chocalats BCH-112001 $6.49 $28.00
Bulk Coffes BCF-012002 $375 $1450
Chocolate Gift Basket CGR-232004 $10.90 $3299
Chosolsts Trifles CT-016783 $1273 $45.00
Coffes Basket CB-3212000 $12.25 $35.00
Fruit Basket FB-BR7Z22 $16.60 $62.00
Sunday Park Basket SPB-534582 $42.60 $36.00
‘wine Gift Basket WGEBM22002  415.00 $75.00
0K Cancel

3. Click the Add button.

A New Product item appears at the bottom of the list of your product
names.
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4. Fill in the appropriate fields.
You can move through the various fields by pressing Tab.
a. Assign a name to your product.
b. (Optional) Enter an item number if you use them.
c. Add the cost that you pay for the item if applicable.

d. Include the price you'll charge your customers for the item if you
adhere to a set price structure.

a\\J

If your costs and prices fluctuate, feel free to leave those fields blank. You
can always change them each time you enter a new sales opportunity.

5. Click OK to close the Manage Product List dialog box and then click
Close to close the Define Fields dialog box.

You might already have your Product List sitting around in another program,
such as Excel or your accounting software. If this is the case, you can easily
import it into ACT! — and avoid having to input the entire list manually. If
you'’re astute (which [ know you are), you noticed the Import button in Figure
13-8. ACT! can import an item list as long as it is in . csv or . txt format and
contains four columns labeled Name, Item Number, Cost, and Price.

Managing the Process List

The ACT! program was originally developed as a sales tool for busy sales
people. Today, the product has evolved to the point that just about any indus-
try and individual can benefit by using ACT!. However, the tradition of sales
tracking remains, and the Process List is just one of those examples. The ACT!
Process List allows you to set up the steps that everyone in your organization
follows when trying to close a sale. You can even associate a probability with
each step. It’s rumored that you need to contact someone 12 times before
you convert them from a prospect to a customer; here’s where you can be
reminded of where you are in that process.

To edit or create a Process List, follow these steps:
1. From any ACT! screen, choose Tools=>Define Fields=>"Manage
Process List.

The Manage Process Lists dialog box appears. If you already set up a
Process List, you see it listed by name, description, and the current
stage number in the Process List.
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2. Select one of the following three options and then click Next:

¢ Create New Opportunity Process: Creates a brand-spanking new
Process List.

e Edit Opportunity Process: Allows you to edit an existing Process List.

¢ Delete Opportunity Process. Deletes an existing Process List. Instead
of deleting an existing list, you might decide to make it inactive.
You see that option on the next screen.

3. Give the Opportunity Process a name, a brief description, and place a
check mark next to the Active box; then click Next.

If you're editing an existing process list, feel free to change the
Opportunity name and description to better suit your needs.

4. Click the Add or Delete button to further configure your Process List.

If you're editing an existing Process List, modifying an entry by double-
clicking is easy. The steps from the previously created Process List
appear, as shown in Figure 13-9. If you're creating a new Process List,
your processes are empty. Don’t worry though — you can fill them up
easily enough.

2] Manage Process Lists
3 Back 4 Home
Import Tasks
Import Opportunity St
R um‘y e 4 Name | Deseription | Prabability ) Add
IR e 1 Initial Commuricatior 10%
e o
3 Presentation 40%
gama' AEI::TI Sales Cycle 4 Negotiation E5%
lodes, 5 Commitment to Buy 80z
Statug: Acti 2
SRR § Sales Fulflment a0
I
Figure 13-9:
Customizing
the stages
in a sales
process list.
-
I

ACT! automatically numbers the stages in a Process List, saving you the
effort. If you want, you can change the order by choosing one of the
options to move an option either up or down on the list. When you move
an option, all subsequent stages automatically renumber.

5. Click Finish when you’re done.
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In ACT!, you can often skin a cat or solve a problem in more than one way.
You can access the Product and Process Lists from two other areas of ACT!:

+* From any ACT! screen, choose Contacts=>Opportunitiesc=>Manage
Product (or Process) List.

v Scroll down to the bottom of the Product or Process List when creat-

ing a new — or editing an existing — opportunity. From there, you
can select Edit List.

A Few More Customization Options

Administrators and Managers have all the fun when it comes to ACT! because
they can customize several other areas of a database to their heart’s content.

In this section, [ point out a few commonly overlooked areas that can be
customized.

Adding custom activity types

Out of the box, ACT! gives you five activity types: call, meeting, to-do, per-
sonal activity, and vacation. You can modify this list of activity types by creat-

ing a custom activity type. To add a custom activity type, just follow the
bouncing ball:

1. Choose Scheduler>Manager>Activity Types.

The Manage Activity Types dialog box appears, which bears a striking
resemblance to Figure 13-10.

1= Manage Activity Types

x|

Add, or editan activity lvps.

Sniprty Thpes

Image | Mame Aitive
e fkive

- . (=1 Meeting Active

Figure 13-10: e S

Editin g tarketing Call Active

.. Peisonal Achvity Active

existin g Wacation Active
activity
types.

5]

T4 3l st

Clnge:
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Figure 13-11:
Creating a
new activity
type.
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2. Click Add.
The Add Activity Type dialog box appears, as shown in Figure 13-11.

Add Activity Type

Name:
Martketing Call

Active - allow new activities of this type
B Browse...

Result tupes (used when clearing activity]

The results for clearing an activity must include & complsted
walue and a not completed walue,

Result Mame Set as Default Aadd,
Completed
Cancelled by Prospect 4] Edit
Rescheduled []

a. Type the name for the activity type in the Name field.

b. Select the Active - Allow New Activities of This Type check box if you
want to allow users to schedule activities of this type.

3. Create the result options to use when the task is completed.

Every ACT! activity has results associated with it. These result choices
appear when you clear an activity; after you clear the activity, the result
you selected is automatically entered into the History tab of the contact
associated with the activity. When you create an activity type, two types
of results are automatically assigned to it: Completed and Not
Completed. Although you can’t delete these two options, you can edit
them. You can also add new result types. When you add a new result
type, it becomes available as an option when you clear an activity.

¢ To add a new result type: Click the Add button.
¢ To edit a result type: Click the Edit button.
4. Click OK in the Add Activity Type dialog box.
The activity type appears in the Activity Types list the very next time

you schedule an activity.

Don’t ask me why, but for some unknown reason, you can’t delete an activity
type after you create it. However, you can edit the activity type and even
change the name of the activity type. Consequently, you want to think care-
fully before creating a new activity type!
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Figure 13-12:
The

Manage
Priorities
dialog box.
|

Editing priovity types

If there’s a square inch of ACT! that can’t be customized, [ haven’t found it
yet. Even the priorities you use when scheduling activities can be tweaked.
ACT! includes five basic priority types: High, Medium-High, Medium, Medium-
Low, and Low. However, only three of the priority types (High, Medium, and
Low) are active. A priority must have Active status in order for it to appear
when you schedule an activity. And although you can’t add a new priority
type, you can rename an existing one if you so desire.

1. From any of the ACT! screens, choose Schedulez>Manage~ Priorities.

The Manage Priorities dialog box opens, as shown in Figure 13-12.

Manage Priorities

Customize the names of the priority levels by clicking the "Edit" button
below. Usze the checkbowes to activate or deactivate any level,

M anage Pricrities
Mame Active Edit..

High

Pretty Damgd Important

Medium
Just kind of Imparkant
Lo

HEEEE

NEmEE

2. Select the priorities you want to activate by selecting the check box in
the Active column.

3. Highlight a priority and then click the Edit button to change the name
of a priority.

4. Click OK when you finish editing the Priority List.
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Chapter 14
Customizing Layouts

In This Chapter
Exploring the benefits of using ACT! layouts

Moving and deleting fields
Adding new fields to the layout

Beautifying your layout

\NG’
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M any ACT! users are confused about the concept of the layout. In fact,
some of you might have ended up renaming a layout label when you

wanted to rename a field. A field is a place to store information. The layout

is how you actually see those fields. Your layout determines both the order
of the fields and the format of each field. A layout is the name for a file that

determines which fields you see and in what order those fields appear. After
you add new fields to your ACT! database, the next step is to stick them into
an existing layout (or design a new one).

In this chapter, | show you how to use the Layout Designer to modify an
existing layout. Here you master adding or replacing fields and tabs on your
layout, reordering all the fields when you finish, and finally, adding a few
artistic touches to your masterpiece.

Only database users with Administrator-or Manager-level security have
access to the Layout Designer. If you're a Standard, Restricted, or Browse
level user, you get to sit back, put your feet on the desk, and direct the
Administrator or Manager as to how you want to have the layout designed.
Be careful what you wish for, however; if you're an Administrator or Manager,
you get to do all the dirty work, so keep reading!

Modifying an Existing ACT! Layout

Before you begin modifying an existing layout, think about how you want your
fields arranged on your layout. Why not try the layouts that come with ACT!?
This way, you can get a feeling for the one that’s most comfortable for you.
Don’t worry about colors or the names on the tabs — you can change all that.
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Arranging fields the way you want them

Arranging fields the way you want them might sound like a no-brainer, but
many ACT! users never realize the importance of changing the field locations
in their layout. For example, you might choose a layout that has the main
business phone number on the top portion of your layout, the home phone
number on a different tab along the bottom, and the mobile phone number
in a third location. If you're constantly flipping between tabs to find phone
numbers, move them together into one strategic place on your layout. This
organization might not make your layout look better, but you'll certainly
work better! The point is to design your layout in such a way that data input
becomes easy — and possibly even fun!

Here’s what you do to modify an existing layout in terms of field selection and
placement:
1. Choose the layout that’s closest to the one that you want to have.
If you need help with switching layouts, take a peek at Chapter 2.
2. Choose Tools~>Design Layout=>Contact.

You’re also given a choice of group and company. That’s because you
can also design — or redesign — your group and company layouts in
exactly the same way as you do for your contact layout. In this example,
you’ll be working with the contact layout, but feel free to modify your
group and company layouts in exactly the same manner.

The Layout Designer opens (see Figure 14-1).
Each field consists of two elements:

¢ The field label, which is an optional element, usually appears
immediately to the left of a field.

¢ The field itself is identified by the down arrow that appears at the
field’s right edge.

3. (Optional) Maximize the Layout Designer.

Okay, this step isn’t a necessity, but it sure makes your design chores a
whole lot easier!

4. Make sure the toolbox and Properties window are both open.

These are two important elements that you need to have open in order
to create or modify a layout. The toolbox sits on the left side of the
Layout Designer, and the Properties window sits on the right side. If the
toolbox and/or the Properties window are nowhere to be seen, try click-
ing the View menu to open them. You see both of them listed right there.
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| Layout Designer - For Dummies layout G|
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Appearance

If you feel like the toolbox and/or Properties window is cramping your
style — or at least your work space — feel free to move them out of your
way. You can accomplish this feat by simply placing your mouse on the
title bar of either window and dragging it to your desired location. You
can also close them by going back to the View menu and clicking them
again, but trust me — you’re going to need them momentarily!

\P
) If the Properties window gets in your way on occasion but you don’t

want to keep heading up to the View window every time you want to
open or close it, press F4 to speed up the process.

5. Choose Filew>Save As and give your layout a new name.

[ recommend saving and naming your new layout with an easily recog-
nizable name. That way, you can later go back to your original layout
(if you totally annihilate this one) and easily identify your layout.

The name of your layout appears in the Layout Designer title bar (refer
to Figure 14-1).

MBER Save changes to your layout early and often. The Save icon on the

& Layout Designer is represented by the standard floppy disk icon. Click it
to save your work. Relying on the old Undo standby (Edit=>Undo) is an
option, but saving your layout early and often is always a good idea!
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When you save a contact layout, ACT! automatically assigns it the exten-
sion . cly. When you save a group layout, ACT! gives it the .gly exten-
sion. And when you create a company layout, the file is given the .aly
moniker.

. Select the Pointer tool in the toolbox.

The Pointer tool, the tool that you’ll probably use most often, enables
you to select fields so that you can move, change, or remove them.

. With the Pointer tool, select the fields and field labels that you want

to move — or remove — from the layout.

Removing unused fields can simplify a layout and make room for other
fields that you want to add. [ recommend removing what’s unwanted
before moving on to other aspects of the layout design process.

Make your selections by any of these methods:
e Click any field or field label to select it.

e Click any field and then press Shift or Ctrl while clicking additional
fields to select multiple fields and labels.

¢ Create a box around the desired labels and fields by holding down
the left mouse button and then dragging to create a selection box.

When you select a field, a border of small boxes (handles) appears
around the field indicating that it’s selected. In Figure 14-1, the Company
field is selected.

. (Optional) To remove fields, press Delete.

The unwanted fields go away.

Removing a field from the layout doesn’t remove the actual field from
the database. The field remains in your database but isn’t visible in the
layout.

. To move fields, select them with the Pointer and then drag them to a

new location on your layout.

If only rearranging the living room was this easy! The idea is to drag the
selected fields and their corresponding labels to the place on your
layout that seems the most logical to you.

If you need to make only a minor adjustment to the field location, you
might try using your keyboard’s arrow keys for really fine-tuning your
layout.

You can move a group of fields by selecting them and then pressing Ctrl+X.
Move your cursor to the new spot on your layout where you want to place
the cells and press Ctrl+V to paste the fields. Voila/ — you move the group of
fields en masse.
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Adding new fields to the layout

In Chapter 13, you find out how to modify existing fields or to create new
ones from scratch. When you rename an existing field in ACT!, you tweak its
label to reflect the change in field name. Typically, you start by renaming one
or all of the ten user fields. At that point, your work is almost over because
the field is already included in your layout. To change a field label, simply
double-click it; you’ll end up in the label edit mode, at which point you can
type in the new field label.

Make sure that the labels in the Layout Designer match the actual names of
the fields. For example, [ might have a field called Men’s Room but give it the
label Ladies’ Room — and end up with very unexpected results!

Adding a new field from scratch to your ACT! database is a bit more compli-
cated because after you create the new field (see Chapter 13), you now need
to find a place for it on your layout. However, if you follow the upcoming
steps, you'll find that adding the new field to your layout is certainly not an
insurmountable task:

1. Click the Field tool in the Layout Designer toolbox, hold down the
left mouse button, and then drag the cursor to the right to define
the field’s initial size and position on your layout.

The Select Field dialog box opens, presenting a list of all the fields that
don’t currently appear on your existing layout. The fields are listed
alphabetically. If you add an address block, all the related fields appear
together, which allows you to easily add them all to your layout in one
fell swoop. For example, notice in Figure 14-2 that all the credit card
address fields are lined up together.

Select Field

Flease choose a field

Alternate Extension ~

Credit Card Address Address 1 i

Credit Card Address Address 2

Credit Card Address Address 3

Credit Card Address City

Credit Card Address Country

Credit Card Address State

Credit Card Address ZIP Code

Fax Extension

First Mame

Home Address 3

Home Extension

Last Atternpt

Last Mame

Middle Mame

Mobile Extension i
Include a label
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In Chapter 13, I talk about setting up new fields. In general, I recommend
setting up your new fields first and then placing them on the layout.
However, if you add your new fields to your layout and find that you
forgot to add one of your key new fields, don’t worry. Just click the New
Field button, conveniently located at the bottom-left corner of the Select
Field window, to add a new field on the fly.

Clicking the Field button allows you to add the vast majority of new
fields that you've added to your database. However, a few other field
types lurk in the Field section of the toolbox that might be of interest.

The Memo and Picture fields are super-sized fields that need to be made
larger than your other fields. The Yes/No fields are tiny check box fields
that are large enough to hold only a check mark. Don’t worry if you're
having trouble “guesstimating” the size of those fields because ACT!
automatically resizes them for you.

2. Select the field that you want to add to the layout, deselect the Include
a Label check box if you don’t want the field to have a label, and then
click the Add button.

The field is added to your layout. You can add as many fields to your
layout as you like, but you're allowed to use each field only once.

3. When you’re done adding fields, click the Close button in the Select
Field dialog box.

Changing the tabs

Just like you can add, move, or remove the individual fields of your database
on your layout, you can also add, move, or remove the tabs that are on your
layout. Using tabs is a great way to organize the fields in your database. For
example, you might have a Products tab that lists the various products that
you’re tracking — or a Personal tab that includes contact info: birthday,
anniversary, blood type, IQ, and shoe size. The whole point of being able to
customize your layout is to make it comfortable for you. If you find yourself
constantly hunting for a field, chances are that your fields aren’t arranged in
a logical fashion. If that’s the case, consider editing the tabs on your layout:

1. From the Layout Designer, choose Edit=>Tabs.

The Edit Tabs dialog box appears (see Figure 14-3), where ACT! gives
you several tab customization options.

2. Hide any system tabs you no longer want to display in your layout.

The single left- and right-pointing arrows in the Edit Tabs dialog box
allow you to hide a system tab. Although the system tabs — Notes,
History, Activities, Opportunities, Groups, Secondary Contacts, and
Documents — can’t be deleted, you can hide them by moving them into
the Hidden Tabs area on the left side of the Edit Tabs dialog box.
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3. Customize your tabs according to your own sense of design and order.

e Add Tab: Add an additional tab to your layout. Enter a name for the
new tab in the Add Tab Layout dialog box and then click OK. You
now need to go back and add some fields to that shiny new tab.

e Fdit Tab: Give a tab a new name. Unfortunately, you can’t rename
any of the system tabs.

e Delete Tab: Remove a tab other than a system tab from your layout.

When you remove a tab from a layout, all the fields located on that
tab are removed as well. Consider moving — or removing — all the
fields from a tab before you delete the tab itself!

e Move Up: Move a tab so that it appears before another tab.
® Move Down: Arrange a particular tab so that it appears after another.

4. Click Close when you’re happy with the names and order of your tabs.

Changing the order of things

You can — and should — use the Tab key to progress through your fields
while you input contact information into your database. When you start with
an ACT! layout right out of the box, you can tab through the fields in a logical
order — that is, from top to bottom. However, you might prefer to move hori-
zontally across the layout rather than vertically from top to bottom. Or, you
might find that after adding a few fields, you can no longer tab through your
fields with the greatest of ease.

Although having out-of-sequence field ordering doesn’t damage your database,
it does make inputting data difficult. Each time you press the Tab key, your
cursor skips to the next numbered field instead of to the next field that you see
on your layout. This could be a real bummer if not for the fact that you an
reorder your fields when necessary. A tab stop is associated with every field
on your layout; the Tab Stop number determines the order of the fields.
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Although an important step, consider waiting to change the field order until
you’re absolutely, positively, 100 percent certain that you’re happy with how
you placed the fields on your layout. There’s no magic way to simply number
the fields consecutively from 1 to 100; unless you want to waste a lot of your
time by redoing your work, you might save this step until after you live with
your layout for a while.

1. Choose View=>Tab Stops=>Show Tab Stops in ACT!’s Layout Designer.
The tab stops appear in the Layout Designer.

When you enter the Land of Tab Stops, you’ll probably notice two
things: Little red numbers now appear to the right of each field, and you
no longer have the toolbox and Properties window to play with. Those
little red numbers represent the order your cursor will follow while you
tab your way through your layout.

When you add a new field to your layout, ACT! automatically assigns the
field the next available field number. When changing the field number
order, focus on those fields because that’s where the numbering is out of
whack. If you remove a field number and don’t assign it to another field,
ACT! automatically assigns that number to the next field that you add to
your layout.

2. Select any fields for which you want to change the field order by
clicking them.

Unfortunately, you have to click fields one at a time to remove prior
numbering. When you click the fields whose field entry order you want
to change, the number disappears.

3. Select the fields a second time to reassign the field the next available
number.

When you select the field again, the next available number is assigned to
the field. Feel free to select the fields in any order you want. After all,
this is your layout!

4. (Optional) Right-click a field, choose Set Index, and type in a field
number to advance several fields at a time.

This is a great party trick in the event that you need to squeeze a field or
two in among all your existing fields and don’t want to have to click and
re-click each and every field in your layout. Say, for example, that your
fields are numbered sequentially from 1 to 61, and you want to stick a
new field smack under field 1. Whew! You're looking at a lot of click time.
But wait! If you right-click field 2, choose Set Index, and change the field
number to 3, you see all the fields 2-61 magically increase by one digit.

[ wish I had a great tip for decreasing the field numbers in the event that
you remove a field. Unfortunately, I don’t. And, I wish you could undo
the field numbers if you increase them by accident. You can’t. All I can
tell you is to be careful when setting the field index because it can’t
easily be reversed.



Chapter 14: Customizing Layouts 205

5. Choose View=>Tab Stops—>Show Tab Stops to leave the tab stop area.

6. Choose Viewr>Enter Stops—~>Show Enter Stops to begin editing the
enter stops.

Just like the tab stops control the order that your cursor follows while
you tab through your layout, the enter stop controls the path your
cursor takes when you press Enter. Think of the enter stop as a bypass,
allowing you to skip merrily from one area of your layout to the next.

The enter stop looks and feels pretty much like the tab stop with two
major differences: The Enter Stop dialog box is tastefully decorated in
green rather than red, and you use a whole lot fewer of them. In general,
you want to place an enter stop at the beginning of each group of fields.
You might want to have one at the beginning of the address, one at the
start of the phone numbers, and a third one conveniently located on the
first of the personal fields.

7. Choose View~Enter Stops->Show Enter Stops to return to the Layout
Designer.

After you finish reordering your tab and enter stops, you want to make
sure you save that layout by clicking the blue diskette icon on the
Layout Designer toolbar.

Beautifying VYour Layout

I'll admit that I count myself among the artistically challenged of this world.
If you read and assimilate everything in the beginning of this chapter, you're
now pretty much equipped to go forth and design a nifty new layout. But
before tackling that new design project, you might first want to give some
thought to some of the things that can make your layout a bit more artisti-
cally pleasing.

Doing minor touch-up work

At this juncture, you leave the area of function behind you and move on to
some of the more aesthetically pleasing aspects of layout design. You can
also decide whether your layout needs a major or minor makeover. The Edit
Properties dialog box (see Figure 14-4) allows you to make changes to the
font, font size, and other attributes, as well as changes to the basic border
style of the field you click. Right-click the label or field you want to change
and choose Edit Properties. This is great for simple touch-up work but is
rather limiting if your layout needs an extreme makeover. For help with that,
see the following section.
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Creating an extreme makeover

Use the Properties window if you want to create some major changes. There are
two great advantages to using the Properties window over the Edit Properties
dialog box. First, you can edit more than one field at a time. Secondly, you have
a whole lot more choices about which elements you can edit.

If you click around in the Layout Designer, the choices in the Properties
window change accordingly. For example, if you click in a field, you can
change the various color and font attributes; if you click in a label, you can
edit the text of the label.

If you're having trouble reading the various options on the Properties
window, resize it so that you can read it better. Simply place your cursor over
the left edge of the window; when your cursor changes to a double-pointing
vertical line, drag to the left to expand the window.

Changing a field label

In most cases, the field name and the field label are exactly the same. Having
a field label differ too radically from the name of the actual field proves to

be quite confusing when you wander into the area of template and report
creation. However, sometimes you might want to tweak the field label so that
it fits on your layout better. For example, a field named Cellular Telephone
Number might be shortened to a more readable label Cell.

You can change a field label with two different methods:
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v Double-click the label.

The label turns into a text box with a blinking cursor. Delete any unnec-
essary letters and type the new label.

v Type the new field label in the Text section of the Properties window.

Adding color to your drab life

ACT! comes with close to a zillion colors that you can add to your layouts.
Okay, you caught me; there might be a few less than a zillion, but I think just
about every color of the rainbow is represented. To use one of those nifty
colors, follow these steps:

1. Click in the background of your layout in the Layout Designer.

2. Select a color from the Background Color drop-down list in the
Properties window.

You can now change the background color by clicking the Background
Color drop-down arrow and selecting a color that matches your mood —
or the décor of your office. Like magic, your background color changes.
If it doesn’t, it’s probably because a graphic is hiding that beautiful back-
ground color. If that’s the case, go on to the next section.

Some of you may be a little hard to please and find that the colors provided in
ACT! just don’t match the décor of your home or office. If you want to add your
own custom-blended color to your layout, mix your very own custom color via
the Custom Color tab. When you create a custom color, the Properties window
displays the RGB (red, green, and blue) number associated with the custom
color. Feel free to change those numbers if you've worked with graphic pro-
grams in the past and want to match your layout to a specific color.

Changing the colors of your fields and labels is just as easy. Just select the
fields or labels and select a color from the Background Color drop-down list
in the Properties window exactly like you do for the layout background.

You can select as many fields and/or labels as you like and then change the
color for your entire selection at the same time.

Got a few fields that you want to make sure are used by your users whenever
possible? Make a field mandatory by turning off the Allow Blank option in the
Define Fields dialog box. This option can be an annoying one if you just don’t
have the information needed to fill in the field at the time of your data input;
ACT! demands that you supply the missing information before you leave the
record. An alternative might be to highlight the critically important fields in a
stunning shade of yellow so that users recognize their importance without
being asked to supply information that they might not have.

Chapter 14: Customizing Layouts 20 7
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Adding the Finishing Touches

Whew! After you add, delete, move, and color your fields, you're ready to
sally forth into the world and start using your new layout. But wait! If you

look carefully at your layout, things might look a bit, well, cockeyed. (That’s

an official computer term to indicate that your fields seem out of whack

because they consist of various sizes and aren’t aligned properly.) If I didn’t

like you so well, I'd tell you to grab your mouse and start adjusting those
whacko fields by dragging them into submission. Several hours later, after

much dragging, resizing, and probably quite a bit of cursing, you’d probably
end up in pretty much the same place as you started. But because the point

of this whole book is to show you how to do things the easy way, you might
want to read the following sections instead.

Lining up fields and labels

One way to give your layout a truly polished look is to align all fields and
labels. When you move a field to a new location on your layout, there’s a
strong possibility that the field is slightly out of line, both vertically and

horizontally, with the other fields. Of course, you can always try to “eyeball

it” by dragging the field around, trying to get it into just the perfect spot. This

method can be very time consuming, aggravating, and hard on your carpal
tunnel. [ have a much easier — and precise — way to accomplish your goal:

1. Select the errant field that’s out of alignment.
2. Click the anchor field (the field that’s properly aligned).

If you look closely, the selection boxes around the errant field are black,
and the selection boxes around the anchor field are white. This is your
indication that the anchor field stays in place, and the other field lines
up with it.

The last field you click is always the anchor, and all the other selected
fields line up with it. You can align several fields at a time by selecting
them and then holding down Ctrl while clicking the anchor field.

Hold down Shift or Ctrl while clicking the fields in your layout to select
more than one of those puppies at a time. Alternatively, you can lasso
them by dragging your mouse around them.

. Right-click any of the selected fields and choose an alignment option.

As you can see in Figure 14-5, you're given a whole bunch of options
from which to choose. Here are the two you’ll probably use most often:

e Align Lefts: Typically, your fields look the best lined up along the
left edges looking vertically down the layout. To do this, you want
to select your fields from top to bottom before aligning.
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e Align Tops: When you have two or three columns in your layout, you
want your fields to align along the top edges as well. Select your
fields horizontally, from left to right, before choosing this option.

Not a right-clicker? If you look at Figure 14-5, you’ll notice the icons
associated with each of the alignment features. You'll find most of those
same icons on the Layout Designer toolbar, which means you can use
the toolbar to accomplish the same goal.

If you choose the incorrect alignment option, you might end up with a
mess in which all your fields are now on top of one another. Quick!
Reach for the Undo button. Don’t see it? Choose Edit=>Undo.

4. Click anywhere in your layout to remove the selection boxes.
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Resizing fields

You'll probably find yourself in a number of situations in which you need to
resize one or more fields. Typically, you want to make several fields smaller to
squeeze more fields into your layout. You might want to make several fields
larger to add more data into those fields. Or, you might find that a new field you
just placed on your layout isn’t the exact same size as the other fields. Again,
you can manually resize your fields one at a time. You can also knock your head
firmly against the wall several times, but I don’t recommend either activity.

v To resize several fields at once: Select all the fields that you want to
resize en masse. Then place your cursor on one of the selection boxes
on either the left or right edge of the selected fields. When your cursor
turns into a single horizontal arrow, drag the selection box to the left or
right, depending on whether you're making the fields larger or smaller.

+ To resize against the anchor: Select all the fields that you want to be the
exact same size as an anchor field. Press Ctrl, click the anchor field
once, pause, and then click it a second time so that the selection boxes
are now white. Choose Format>Make Same Size=>Both.
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Adding a logo or a graphic

Perhaps the best way to truly personalize your layout is by adding your very
own logo to it. Adding a graphic to the layout means that the graphic appears
on each and every one of your contact records. Don’t confuse this with using
a Picture field; a Picture field varies for every one of your contacts. You can
add your chef-d’oeuvre to your layout by following these easy steps:

1. From the Layout Designer, click the Drawing tool from the toolbox
and then choose the Image tool.

2. With your mouse, draw a shape on your layout to match the graphic
you want to insert.

The Open dialog box opens.
3. Navigate to the graphic you want to insert, select it, and then click Open.

The graphic now appears on your layout. You can drag the graphic to a
new, improved location by placing your cursor on any of the edges of
your graphic. When your cursor turns into a plus sign, drag the graphic
to the appropriate spot on your layout.

Your graphic appears exactly the same size as it was originally created. If the
graphic is too large or small to fit your layout, resize it with a graphics pro-
gram. You might find, however, that the frame that you drew in Step 2 doesn’t
exactly fit your graphic. You can resize it by placing your mouse on one of the
white squares that borders the graphic and dragging the border to match the
size of your graphic.

Creating a circle in a square

Admittedly, no one would ever confuse me with Picasso. However, some of
you might be of a more artistic persuasion, or just want to take advantage of
some of the drawing tools to add a little clarity to your layout. By creating a
square that is slightly larger than a grouping of several of your fields, you in
essence create a frame that serves to highlight those fields.

If you click the Drawing tool in the toolbox, notice the Rectangle and Ellipse
options; these are just fancy words for square and circle, respectively. At

any rate, by clicking either of these options, you can draw a square or circle
(okay, a rectangle or an ellipsis) on your layout. After they’re drawn, you

can head over to the Properties window and change the color of your newly
created shape. This is a great way to emphasize a group of fields, particularly
if your layout is starting to look cluttered.
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<® Did your newly created square or circle plunk itself down on top of your
existing fields? Although this leads to an interesting work of art, you probably
prefer to have the graphic behind the fields. Don’t panic; simply right-click
the graphic in question and choose Send to Back.

Adding text boxes

If a picture is worth a thousand words, a text box might just be worth a mil-
lion. Inconsistent data input is a sure-fire way to decrease the productivity of
your database. This lack of uniformity is often caused not by lack of knowl-
edge but rather by lack of communication. Adding a text box to your layout is
a great way to help users input key pieces of information in the right place
and to help organize the groups of data on the layout. Use your text boxes to
create a heading for a group of fields or to include data input instructions to
your users.

1. From the toolbox, click the Drawing tool and then choose the Text tool.
Your cursor now looks like a plus sign instead of the normal arrow.

2. Find the spot on the layout to add a text box, hold down your left
mouse button, and drag the cursor to create a box.

3. Double-click the box and begin entering text in your new text box.

Guess that’s why they call it a text box. Feel free to write a book here if
you want. When you're finished, just click one of the text box borders and
watch in awe while little white squares appear all around your text box.
Feel free to grab any one of those boxes and expand your horizons — or,
in this case, your text box — to accommodate your verbiage.

4. Use the Properties window to customize your text box.

Here’s where you can really have fun. As long as the new text box is
selected, you can change the text, font attributes, font color, and back-
ground color of the text box.

<® I'm a firm believer in doing things the easy way whenever possible. If you find
yourself longing to have several text boxes all formatted the same way, create
the first text box, customize it just the way you like it, and then clone it by
right-clicking it and choosing Copy. At that point, you can paste it on your
layout — and the only thing you have to change is the text.
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Chapter 15

Zen and the Art of Database
Maintenance

In This Chapter

Performing routine maintenance
Avoiding database corruption
Backing up the database
Restoring the database
Applying ACT! updates

Editing and replacing field data

In this chapter, I show you how to take care of your motorcycle . . . er,

[ mean your database. Would you believe that your ACT! database is

very similar to a motorcycle? Both are made up of many moving parts that
require maintenance. Failure to provide routine maintenance can result in

big problems — for a motorcycle as well as for your database. If something
does go wrong, having a backup is nice and (in most cases) necessary to
keep your job. Sometimes your motorcycle gets dirty; likewise, your database
is prone to clutter. You sometimes have to bite the bullet, roll up your
sleeves, and do a little cleaning — and clear out old or duplicate contact
records from ACT!.

Regular maintenance keeps your database running efficiently. When you
don’t provide routine maintenance for a motorcycle, things get corroded;
likewise, when you don’t provide maintenance for your database, your
records become corrupted. Weird things start happening. No, you won't see
a ghost, but you might not see a note that you know you created the day
before. Or that note just might pop up again later — in the wrong place!



214 Ppartiv: Advanced AcTting

Understanding the Need
to Check and Repair

I love to change the messages on my voice mail, and one of my favorite
choices is, “Have you checked and repaired your database today?” Users
often offer up a variety of excuses for why they don’t perform routine data-
base maintenance. These excuses range anywhere from “I didn’t have time”
to “I didn’t know I was supposed to.” Of course, many of you give these
excuses after your database is already damaged. By then, of course, it could
be too late for checking and repairing. If you're the database Administrator
(or the sole user of your database), you're responsible for the maintenance
of the database because only an Administrator can do the maintenance.

Determining the maintenance frequency

If you're a little old lady from Pasadena who uses your database only once
in a blue moon, you might get away without maintaining your database.
However, if the data in ACT! is extremely important to you, perform your
maintenance on a routine basis. At a minimum, [ recommend that your
database receives a bit of tender loving care at least once a week.

My general rule is that the frequency of maintenance is directly tied to the
amount of use that your database receives. There’s no such thing as doing
too much maintenance — only too little! Here are some situations that war-
rant more than weekly maintenance:

+ You have a multi-user database.

+ You have a large database.

+* You add new fields to your database.

+ You make changes to the drop-down lists in your database.

v You add or delete numerous contact records to your database.

+* You import another database into your existing ACT! database.

+* You add — or delete — users to your database.

+* You experienced a power surge, brownout, or outage.

+ You had network problems.

v You suspect that your database is corrupted.

+* You had a really lousy day when everything seemed to go wrong.
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A little shopping list of database horrors

Database corruption comes in many shapes and sizes. The following list
describes some of the more common indications — the warning signs —
of a corrupted ACT! database:

1 While trying to open a database, you receive an error message or
ACT! stops responding. Smoke might be seen rising from the back
of your CPU.

+ You receive error messages while working in ACT!.
+ You can’t log in to the database as a particular user.

1 Information appears to be missing or mysteriously appears attached
to the incorrect contact record.

+ You notice a significant increase or decrease in the number of contact
records in your database.

v Your database acts funny or runs slower than usual.

If you notice one — or heaven forbid, more than one — of the preceding
warning signs, I'm sorry to say that the time has come to either perform CPR
on your fainthearted co-workers or perform some simple database mainte-
nance. In the next section, I give you the details on performing the simple
database maintenance (that is, checking and repairing). You're on your own
with the CPR.

<® Sometimes determining whether the corruption is in the database or in the
ACT! program itself is difficult. To determine this, try opening the ACTDemo
database that installs on your computer when you install ACT!. If the
ACTDemo opens and runs correctly, the problem lies with your database. If
you encounter the same problems in the ACTDemo database that you're
having in your own database, you might need to reinstall ACT!.

Performing Routine Maintenance

The old adage, “If it ain’t broke, don’t fix it!” doesn’t apply to ACT!. Proper
maintenance enables your database to run efficiently and improves perfor-
mance. Some of the maintenance takes a rather behind-the-scenes approach;
users don’t detect that maintenance has been performed. They do know,
however, that the maintenance hasn’t been done if they start running into
problems with the database. The other type of maintenance involves actual
data cleanup; astute users can detect that changes have been made to the
database.
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Only the database Administrator can perform routine maintenance to ensure
that your database continues to chug away without any problems. That’s
probably to ensure that everyone knows at whom to point if things go wrong.
Some maintenance tasks require that all users log off the database so that the
database can be locked, but those can be scheduled for off-peak or even
overnight hours.

In ACT!, basic maintenance is referred to as checking and repairing. The data-
base Administrator can run the Check and Repair tool regularly to ensure a
healthy database, which consists of two procedures: the Integrity Check and
the Re-index. These procedures are very similar to the Scan Disk and Disk
Defragmenter procedures on a Windows PC. The Integrity Check scours the
database for errors. Re-index squeezes out all the little empty spaces that are
left in your database when you delete contact records in order to ensure max-
imum performance.

ACT! Premium comes with a nifty tool — the ACT! Scheduler — which per-
forms maintenance duties for you at the intervals you specify. That feature
alone makes it worthwhile to fork over a few extra bucks to purchase the
Premium version of ACT!.

Although Check and Repair protects your database from damage, it does
NOT actually repair any damage that has already occurred in your database.
However, ACT! installs the ACT! Diagnostic Tool in the program folders. This
advanced tool is designed to actually repair your database. In the event that
your database needs some repair work, you might want to hire an ACT! con-
sultant to help you.

Yikes! Performing the Check and Repair sounds really important, so you're
probably thinking that it must be really hard. Wrong! Here’s all you need to do:

1. Log in as an Administrator and make sure that all other users are
logged off the database.

If the Check and Repair command is grayed out from ACT!’s Tools menu,
you don’t have sufficient administrative rights to perform that option.
You might want to jog your database Administrator’s memory a bit to
remind him that his salary is directly proportional to the efficient perfor-
mance of your database!

2. Choose Tools~>Database Maintenance~>Check and Repair.
The Check and Repair Database window opens, as shown in Figure 15-1.
3. Select both the Integrity Check and Re-index options and then click OK.

Your computer makes a few whirring noises, and a snazzy indicator bar
appears momentarily onscreen. (Try to look important during this time
so as to justify your administrative salary.) When ACT! finishes the main-
tenance, you receive a cheerful message telling you that everything is
hunky-dory.
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ACT!

Integrity Check - Checks pour database for erors and repairs any that
are found

Re-index - Re-organizes the database storage area to increase access
speed.

Perform these tasks regularly to mantain database integrity and to
improve perfomance.

Cancel

Backing Up the ACT! Database
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You probably already know the three rules of real estate: location, location,
location. Similarly, the three basic rules of computing are backup, backup,
backup! With the proliferation of viruses as well as the poor construction
of many computers, backing up on a daily basis is imperative. Failure to do
so can result in loss of data — as well as time and money! Having a recent
backup enables you to recover quickly when the unexpected happens. (It
might also ensure that you receive a paycheck at the end of the week.)

Only Administrators and Managers of the ACT! database get to back up a
database. After a database is backed up, only an Administrator can restore it.
Because every database requires an Administrator, you automatically landed
the job if you're the only user of the database. If you need to back up the
database and find that the backup option is grayed out on the File menu, you
must find a database Administrator and wheedle him or her into changing
your permissions. In Chapter 16, I explain the various ACT! user permissions.

If you make major changes to your database — such as importing new
records, deleting old contact records, or modifying existing fields — [ recom-
mend creating a backup before you start, just in case!

When you create an ACT! database, ACT! automatically creates several fold-
ers for you. In addition to a database folder that houses the main database
files, ACT! creates subfolders for your attachments, layouts, queries, reports,
and templates. When you back up your database, ACT! compresses all the
data into a single Zip file.

In addition to the aforementioned folders, ACT! also creates a backup folder.
Sounds like a good idea; however, if your database is located on your local
machine, chances are pretty good that the backup folder lives there as well.
One of the main reasons to create a backup is to make sure that you have a
copy of your database just in case something goes drastically wrong with
your computer. If something bad does happen to your computer — and that’s
where your backup is stored — you'’ll find yourself without a computer, data-
base, or backup.
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In a corporate setting, the ACT! database often resides on a network drive
and is backed up to a tape drive on a daily basis. However, you might be feel-
ing a false sense of security knowing that this backup is taking place. ACT! is
a Structured Query Language (SQL) database — meaning that unless you have
a special tool, a routine network backup will not back up your ACT! database.
Feeling scared? Remind your IT person that his job security is directly related
to the security of your database. Encourage him to use the ACT! backup —
and then add the backup file to his regularly scheduled backup.

If you use backup software or store your data on an Internet site, remember
that an ACT! database consists of more than a single file. You need to store
the Zip file backup that the ACT! backup creates in order to ensure that you
do indeed collect all the bits and pieces of your database.

Performing the basic ACT! backup

You must have Administrator or Manager security level to back up your ACT!
database. Open the ACT! database for which you want to create a backup
copy and then follow these steps:

1. From any ACT! screen, choose File>Back Up->Database.

The Back Up Database dialog box appears, displaying the location for
the backup database, as shown in Figure 15-2.

Back Up Database

Back up files to:

C:AMy Docs\BackuphaCT! ACTDemo.zip

[ Password pratect fils

Cancel

2. To back up the database to a different location from what’s showing,
click the Browse button, select a new location for your backup file,
and then click Save.

ACT! automatically places ACT! in front of your database name and ends
the backup file with the . zip extension.

3. (Optional) Select the option to password-protect your database.

In case you fear spies lurking about, password-protect the backup file.
However, you might not feel the urge to do so, knowing that only data-
base Administrators can use the file.
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4. Click OK.

An indicator bar appears, letting you know that ACT! is creating your
backup. The time required to complete your backup varies depending
on the size of your database and the supplemental files that are included
in your backup. When the backup is complete, a message appears telling
you that your backup was completed successfully!

Backing up to various media

Backing up a database is easy. The hard part is knowing where to place your
backup. By default, ACT! places your backup file on your computer’s hard
drive. That’s great if your hard drive is ultimately being backed up, but not
so great if it isn’t — and your computer grinds to a painful halt. Here are a
couple of good alternatives to your backup housing dilemma:

v~ USB storage drive: These tiny powerhouses can store the equivalent of
100 floppy disks on a device the size of your thumb. This is my favorite
backup device for single users who need to back up only a few programs.

v~ External hard drive: The price of external hard drives has plummeted
in recent years; you might want to purchase one to store backups of all
your data files.

v+ CD/DVD burner: Although these puppies come installed on most new
PCs, many users have difficulty using these devices. And, to add to the
confusion, the files that are created are often marked as read-only, which
can sometimes make it difficult to restore your data from them later.

Those of you with both a laptop and desktop computer might think that rou-
tinely backing up and restoring your database on each of the machines is a
good way to keep the two machines “in sync.” Wrong! Because SQL allows only
one database of any given name on a single computer, this method requires
you to continuously create new databases, which creates a lot of confusion.
You might want to take a look at Chapter 17, the chapter on synchronization,
which is a much better way to keep your two machines updated.

Restoring a backup copy of your database

A backup isn’t any good if you don’t know how to use it to restore your data.
Although I hope you never have to use a backup copy, follow these steps to
restore a copy of your database:

1. From any ACT! screen, choose Filer>Restorec>Database.

The Restore Database dialog box opens, as shown in Figure 15-3.
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2. Select one of the restoration options and click OK.
e Restore: Restores all files to their original locations; this restoration
option is most commonly used when data is lost or corrupted.
e Restore As: Allows you to restore the database to a new location
with a new filename; this option works well when you want to copy
a database or move it to another computer.
¢ Unpack and Restore Remote Database: Allows you to install a data-
base that synchronizes back to the main database.
&‘*N\BE" 3. Click the Browse button to navigate to the location where the backup
« file is stored; click Save and then click OK.
Backup files end with the . zip extension.
@“\NG! Many of you are familiar with the . zip extension because you’'ve
S worked with the WinZip software. However, don’t be tempted to unzip

an ACT! backup file with WinZip. The files aren’t placed in the correct
locations, and the backup file is probably rendered useless!

4. Type the backup file password if prompted and click OK.
5. Type the Administrator’s name and password and click OK.

Yikes! ACT! shows you the scary warning message that you see in
Figure 15-4. The warning explains in no uncertain terms that if you
continue, your database will be overwritten with older files. If your
current database is a corrupted mess, that’s a good thing; if your data-
base is perfectly fine, that could be a bad thing!

6. Click Yes to acknowledge that you want to continue.

Your computer whirs and hisses for a few moments, and soon the
restored database opens.
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ACT!

i Files modified after the backup will be overaritten by an older file when restoring the database
. Any modifications will be lost upon restoring the database. Do you want to continue?

o= 1w

Applying ACT! Updates

Nobody’s perfect. Although it might seem that ACT! comes pretty darned
close, from time to time, a few of those dreaded bugs slip by the program-
mers and annoy the heck out of you. Or, you run out to purchase the latest
and greatest version of Microsoft Office only to find that it won’t work with
your existing copy of ACT!. Enter the update.

Applying a new release update is actually a two-step process. First, you apply
the update; then you need to update your database.

The two ways to update your version of ACT! to the latest release patch are
manually or automatically. With an automatic update, ACT! informs you of
any new updates that are available each time you open ACT!. You also see a
blinking message in the bottom-right corner of ACT!. | highly recommend that
you resist the urge to use the automatic update. By using the manual method,
you can update your version of ACT! — and your database — at your leisure.
You also have time to read up on that update before doing the deed.

You can turn off automatic updating with a simple change in the preference
settings. If you're not sure how to change a preference setting, you might
want to race over to Chapter 3 to find out.

If you're responsible for a multi-user database, you want to make sure that
arenegade user doesn’t attempt to update the database prematurely. In a
multi-user environment, you should update the server copy of ACT! first and
then update the database itself directly from the server. Only then should the
local workstation copies of ACT! be updated. The same procedure holds true
for remote databases; remote ACT! users should update their copies of ACT!
and their databases only after receiving the go-ahead from the database
Administrator.

To update your version of ACT! manually, follow these steps:

1. From any ACT! window, choose Help~>ACT! Update.
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A little message appears in the bottom right-hand corner of ACT!. If you
already have the latest and greatest release, the message tells you so;
you can just close the message and go on with your business. If a newer
release is available, the message tells you that as well and encourages
you to follow the directions that are included in it.

2. Continue updating ACT! to the latest release patch.

Although it might take you a few minutes to complete this task, you’ll
find this entire procedure to be relatively painless. Just be patient and
wait for the prompts while the patch is downloading. After the download
is complete, it is applied to your existing version of ACT!.

3. Close ACT! and any Microsoft products when prompted.

ACT! continues to install the update. When finished, ACT! informs you
that your database now needs to be updated to the newest release patch.

4. Wait for your database to be updated.

Feel free to watch the paint dry in the next room or, if you prefer, watch
the flashing blue indicator buttons while ACT! completes the updating
process.

Performing Spring Housecleaning

WING/
&

The good news is that if you're reading this, you're probably the Administrator
or Manager of the ACT! database; after all, if you're not, you don’t have the nec-
essary permission to perform most of these tasks. The bad news is that with
the job title comes quite a bit of responsibility — but hopefully a large salary.

In addition to performing the obvious mechanical maintenance chores, you
probably want to do a little bit of extra housecleaning . . . er, database clean-
ing from time to time. Having blank, duplicate, or incorrect contact informa-
tion serves no purpose other than to make your database perform less
efficiently. So bite the bullet, roll up your sleeves, and get cleaning.

Before you perform any type of maintenance, I strongly recommend that you
back up your database so that you can retrieve any data you accidentally
delete.

Weeding out duplicate contacts

Finding pesky duplicates in your database is tricky but not impossible.
Because having multiple records for the same person or company is common,
ACT! lets you easily check for duplicate records based on predefined criteria.
You can then create a lookup of the duplicate records and delete them. You
can also change the criteria used to find these duplicate records.
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1. From any ACT! screen, choose Tools=>Scan for Duplicates.

By default, ACT! looks for duplicate contact records based on the com-
pany name, contact name, and phone number. If the contents of these
three fields are identical for two or more contacts, ACT! views them as
duplicates. As you can see in Figure 15-5, you can now specify how ACT!
checks for duplicate contact records in the Scan for Duplicate Contacts
dialog box.

Scan for Duplicate Contacts

Find duplicate contacts

tatch an:
[ Company .v
Then on

Contact ™
Then on

Phane [

2. In the Find Duplicate Contacts area, choose the three fields you want
ACT! to use to search for duplicate contact data.

3. Click OK.

The Contact List opens, along with a dialog box informing you that dupli-
cates were found, asking whether you want to combine them. From this
list, you can delete records, keep records, or combine duplicate records.

4. If you want to combine duplicates, click Yes to continue at the prompt.

The Copy/Move Contact Data window opens. This is the first of six win-
dows that you go through when merging duplicate contacts. Merging
duplicates is a slow, grueling task; you have to merge your duplicates on
a pair-by-pair basis.

After contacts are merged together, there’s no unmerge function.
Proceed with caution!

When you progress through the wizard, you perform the following six
tasks:

a. Select a set of duplicates.

b. Decide whether you want to copy the information from the first con-
tact record to the second contact record — or vice versa.

c. Choose a source and a contact. Depending on your choice, one of
the contacts becomes the source, and the other one is the target.
By default, the new, merged contact contains all the target informa-
tion. If you want to retain any source field information, click in the
field and then click the Copy button.
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d. Choose whether you want to move additional information from the
source fo the target or have the information remain duplicated on
both records. As you see in Figure 15-6, you indicate this in the

third step.

e. Select the additional elements

that you want to merge together: notes,

histories, activities, opportunities, secondary contacts, and docu-
ments. If the source contact has three notes and the target has four
different notes, the final contact ends up with seven notes (if my

math is working correctly).

f. Indicate whether to keep or de

lete the source record. For your conve-

nience, ACT! recaps the information to make your decision easier.

If you decide to delete the source record, click Yes on the scary
warning that confirms that you might be losing information.

5. Click Finish.

Your two duplicate records merge into one.

Copy/Move Contact Data (3 of 6)

Copy Data from Source to Target Record
YWou can specify which fields you want to copy fram the source contact record ta the
target contact record.

Ta copy data from a source field to a target field, click the field, and then click Copy.

pm—
=i

)
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Field Name Copy Contact 1 [Source] to Contact 2 [Target] Ll
Addiess 2 Sute 100 Suite 100
Addiess 3
City San Diego San Diego
State CA ca
ZIP Cade 92109 92109
lance@yjbikes.com
Chiiz Huffman Chriz Huffmar
Public Lirited
Altemate Extension 1
Albarsta Plhna i)

) (o)

Copy

Cancel

You can’t undelete deleted records or contact information. If you inadver-
tently delete important information, run — don’t walk — to your backup file

and restore your information.

Copying or moving contact data

For many of you, merging two contact records together is only the tip of the
iceberg. You need to repeat the merge process again for each pair of dupli-
cates in your database. And, after you complete the process, you might want
to start over again by changing the duplicate checking criteria.
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As I stress throughout this book, having some semblance of uniformity is
very important. Lack of uniformity is a great way to sabotage your database.
A search for all your clients in Ft. Lauderdale doesn’t include those clients in
Fort Lauderdale. In the same way, a company or contact might be duplicated
if it’s entered into your database in two different ways. For example, you
might have John Q. Public and John Public, or ABC Company and ABC Co. ACT!
doesn’t recognize any of these examples as duplicates.

To find the duplicates that I mention in the preceding paragraph, you need
to use a different criterion for your search. Changing your duplicate search
parameters might just give you the results that you're looking for. But what if
you just happen to stumble on two contacts that you already know are dupli-
cates? In this case, you can cut to the chase and move the contact data from
one record to another without having to first perform the duplicate scan.

In another scenario, an existing contact might leave a company to work at
another company. You want to create a new record for the individual yet
retain his original record. By using the Copy/Move command, you can copy
specific field information from his old contact record to his new one.

ACT!s Copy/Move Contact Data function works almost exactly like the Scan
for Duplicates function. (See the section “Weeding out duplicate contacts,”
earlier in this chapter.) The only difference is that unlike the duplication
procedure, you're not presented with a list of contacts to start with. The
onus is on you to select the two records whose field information you want
to copy or move.

To copy or move contact data, follow these steps:

1. From any ACT! screen, choose Tools~>Copy/Move Contact Data.

Look familiar? It’s the Scan for Duplicate Contacts dialog box (refer to
Figure 15-5).

2. Click Next to proceed through the wizard screens.
Proceed through the wizard while remembering a few key points:

e Source record: The source record is the record that contains the
data that you want to copy.

e Target record: The target record is the record you want to copy
data to.

e Copy/move data: You have the option to copy or move data on a
field-by-field basis.

® Keep/delete data: You have the option to keep or delete the origi-
nal source record.
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Removing old data

ACT! users tend to be extremely loyal; it’s not unusual to run into ACT!
fanACTics who have been using ACT! religiously for 20 years. Over time, the
amount of information that’s stored in ACT! gets larger and larger, and that
information can become less and less important. ACT! provides you with a
simple tool for clearing the clutter from your database. (I just wish I had a
similar tool to clear the clutter from my closet!)

1. From any ACT! screen, choose Tools=>Database Maintenance=>Remove
Old Data.

The Remove Old Data dialog box opens, as shown in Figure 15-7.

Remove Old Data

To enhance performance, remove the data you no longer need.

If you want an archived copy of the data, you must back up the database before you
begin.

Today's Date:  |5/24/2007

Remove from database

[ Motes older than daps

Histories older than 100} deys
Cleared activities older than 10002 dars
[] Claged*won and Cloged-Lost Opporturities alder than s
[ Open and Inactive Opportunities older than AR
[[] Document tah entries oldsr than s

2. In the Remove from Database area, select the type of data you want to
remove and indicate the number of days that you want to use to
remove that data.

To get rid of data that’s older than a year, indicate 365 days; to get rid of
data that is more than two years old, indicate 730 days; and so on.

3. Click OK.

Like a champ, ACT! searches, scrubs, and ultimately removes any data that
matches your selection criteria.

If you're still not feeling really comfortable with blowing away some of your
older note, history, and activity information, you can always make an archival
database so that you can refer to that information if necessary.
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If you're concerned about deleting old cleared activities — don’t be. In
Chapter 7, I talk about histories that are created automatically when you
clear an activity. So, even if you delete an old, cleared activity, a history of
that activity remains safe and secure on the contact’s History tab.

Deleting a database

You might wonder why you would ever want to delete your database. That’s
good thinking because you're right — you don’t want to delete your data-
base. However, you might have inherited several databases that you no
longer use, or perhaps you created a database or two for specific, temporary
purposes. Many so-called ACT! “experts” create a multitude of databases in
their attempt to master ACT!. In general, allowing users to have access to
more than one database isn’t a good idea; chances are pretty good that one
of your users ends up in the wrong database. Having a multitude of extrane-
ous databases can also put extra strain on your resources and slow down
your general performance.

Before deleting a database, | recommend backing it up, just in case. You
might also consider moving the database to another location for safekeeping
rather than deleting it.

Deleting a database is ridiculously simple — but impossible to undelete
once deleted. Proceed with caution.

Okay, are you ready? Take a deep breath and follow these steps to delete the
database:
1. Open the database that you wish to delete.

2. From any ACT! screen, choose Tools>Database Maintenancer>Delete
Database.

The Delete Database window opens, verifying that you absolutely want
to delete, destroy, and make the current database disappear forever.

3. Click Yes to bid your database adieu.

Ironically, ACT! gives you two options to change your mind: No or Cancel
both serve to keep your database safely in place.

Performing a global edit/replace

Another way to keep your database working well is by ensuring that all fields
contain consistent information. Maybe some of your contacts have the city
listed in all capitals, but others don’t. Perhaps some contacts are listed in
Florida, whereas other contacts reside in FL or Fla. This lack of consistency
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makes it extremely difficult to query your database. Like a forgiving mother,
ACT! provides you with the ability to correct the error of your ways. After
you pinpoint your inconsistencies, you can standardize them in one fell
swoop (instead of by correcting each field on an item-by-item basis):

1. Perform your lookup.

In the preceding example, you might create a lookup of FLA and then
add Florida to the mix. If you need help, flip to Chapter 6 and review the
section on lookups.

Unless you’re planning on changing field data for every contact in your
database, make sure you perform a lookup before proceeding. These
changes are irreversible! For example, say you notice 27 instances of Fla
that you want to change to FL. If you fail to do a lookup first, you end up
changing the State field for every contact in your database to FL rather
than just for the original 27 that you intend to change. Unfortunately,
unless you have a backup handy, you're stuck with the changes because
(again!) these changes are irreversible.

2. From any ACT! screen, choose Edit=>Replace Field.
If you prefer, you can choose one of the other two options as well:
e Swap Field: This option swaps the information between two fields.

e Copy Field: This option copies information from one field and
repeats it in a second field.

You now see the Replace Data dialog box, as shown in Figure 15-8.

Replace Data

Replace contents of: Walue:

State |l FL w

Cancel

3. Select your desired field from the Replace Contents Of drop-down list.

You can select from virtually any of your contact fields with the excep-
tion of the system fields.

4. Enter the desired information in the Value field.

In this example, you type FL in the field. To make life even easier, ACT!
supplies you with the appropriate drop-down list based on the field you
indicated in Step 3.

5. Click OK.

6. Read the warning that appears.
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Generally speaking, when life — or ACT! — gives you a warning, it’s a
good idea to heed it. ACT! is politely asking you to verify that you intend
to change all the contact records in the current lookup (see Figure 15-9).
If you're not sure as to the exact number of contacts in the current
lookup, click No, return to the Contact Detail window or Contact List,
and read the record counter in the top-left corner.

7. Click Yes.

ACT! might have to think about this for a moment depending on the
number of contact records in your lookup. When it finishes, you’ll notice
that the field that you indicated in Step 3 has now changed for each of
the contact records in your lookup.

‘Replace/Swap/Copy

:.’(.- This operation modifies all records in the current [ookup, Are you sure yau want tocontinue?

A few more housekeeping tips

Sure, ACT! can mechanically maintain the integrity of your database.
However, you, as the Administrator, can do a few things to help ensure a
healthy database:

v~ If your organization has customized the database, limit the number of
users who have permission to edit layouts and add new items to the
drop-down lists.

1 Periodically clear unwanted items from the drop-down lists. Insist that
the users routinely pick items from the drop-down lists when entering
new data.

v~ To avoid duplication of contacts, emphasize the importance of query-
ing the database for an existing contact before entering a new one.

1 Delete any fields not being used.
1 Delete outdated attachments, layouts, reports, templates, and queries.

~ Be cognizant of field length. If you have a field that holds a Yes or No
value, consider trimming the field length down to three characters.

v Save contact records you rarely use to a different database and then
remove them from the main database. Use a Contact Activity lookup
to locate infrequently used records.
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Chapter 16
Calling in the Reinforcements

In This Chapter
Working with database users
Limiting contact and field access
Networking with ACT!
Scheduling your chores automatically

Importing information

C hapter 15 talks about the maintenance procedures that should be
done on a fairly routine basis. This chapter calls in the big guns and is
intended primarily for those of you who use ACT! in a networked environ-
ment. And because you're working in a workgroup, you're probably using
ACT! Premium. Many of the features, including custom defining user roles,
limiting contact access, and scheduling your maintenance, are found only
in the Premium edition of ACT!. Other features, such as adding users and
networking, can be accomplished with the Standard version of ACT! but
apply to only those of you with multiple users accessing your database.
Last but not least, the importing feature applies to anyone who needs to
get another database or list of contact information into ACT!.

Working with the Database Users

A Record Manager is a contact in your database who is also a user of your
database. If several people enter data into your ACT! database, I highly recom-
mend setting up each person as a Record Manager. If you and Jane are both
set up as users of the database, make sure that you log in as you and Jane
logs in as herself. ACT! automatically enters several key pieces of information
based on how you log in to the database. For example, you're recognized as
the record creator of each new contact that you add to the database. Likewise,
if Jane enters a note, that note is associated with her name. If you generate a
document from one of ACT!’s templates, your name — not Jane’s — appears
as the generator of that document. Most importantly, your name is associated
with any meetings, calls, or to-do’s that you schedule in ACT!. Having unique,
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identifiable users in a database allows you to view your own activities on a
calendar. Otherwise, you might find yourself driving to Podunk to visit Jane’s
mom on her birthday!

Adding new users to the database

Only the database Administrator has permission to add new users to the
ACT! database.

1. From any of the ACT! screens, choose Tools=>Manage Users.

The Manage Users dialog box opens, as shown in Figure 16-1.

2 Manage Users
UserTasks (z)
Easlelle ltsr Select a user to change passwords, secury roles, and other setlings
Edit User Information
Delete User
Contsol Name | User Hame | Securly Role] Log On Status
o [7) [Aleonbikos  Alionbikola  Stendard  Ackve

Betty Browser  Betty Browser  Browse Inactive
Chiis Huffman  Chris Huffman  Administrator Active
Emst Anderson  Emst Anderson  Standard Inactive
Fred Fenderdine  Fred Fenderdine  Standard Inactive
Jonathan Somme Jonathan Somme Standard Inactive
Juliette Rosseu Juliette Rosseur Resticted  Inactive
Karen Fredicks  Karen Fredricks  Administrator Active
Melissa Pearce  Melissa Peace  Manager Active
Sarah'whiting  Sarsh'whiting  Standard Inactive

Close

2. Click Create New User.

In the next window that appears, you're given a choice to create the new
user from an existing contact or to create a brand-new user who isn’t a
member of your current database.

Always double-check that the new user doesn’t already reside in your
database as an existing contact. When you set up a brand-new user, you
also set up a brand-new contact, which could result in an “evil twin” situ-
ation. For example, although you know only one John Smith, he’s repre-
sented twice in your database — once as a user and the other time as
simply a member of your database.

3. Choose either Existing Contact or New Contact and then click Next.

e Existing Contact: If you choose the Existing Contact option, you see
a list of all the contacts in your database.
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Figure 16-2:
Enter user
information.
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a. You can sort the list alphabetically — by contact or company — by
clicking the corresponding column heading.

b. After you sort the list, type in the first couple of letters of the con-
tact’s last name or company (depending on how you sorted the list)
in the Look For text box. ACT! magically takes you to that name.

e New Contact: If you choose the New Contact option, a dialog

box opens that is similar to the Manage Users dialog box. (See
Figure 16-2.)

1, Manage Users

&) Back ® £ Home

Manage User Tasks (2)
Create New Lser

Edft User Information Edrtact Name:
Speciy Access Bayhehn
Add Pemissions User Name:
Add User to Team Gary Kahn

Manager

Password options

Mew Password:

FReset Password

Confirm Password:

[ User must change password at next lag on
[ User cannct change password.

[ Password rever expires

<Back | [ Mew> | [ Fish ][ Concal

4. If the new user you added is also new to your database, you need to
type in his/her name.

If you already indicated the name of the user in Step 3, his/her name is
sitting there waiting for you.

5. Fill in the user name.
The user name is not case sensitive. Just make sure you remember what
name you decide on. If you set up multiple users for the same database,

consider sticking to a set naming convention: Gary Kahn or gkahn are
good choices; you might want to avoid Gary B. Kahn or Gary Kahn, Esq.

6. Fill in the password.

By now you know the drill: You type in the password once, and because
that was so much fun, you type it a second time.

7. Choose the security role of the new user.

ACT! provides you with five levels of security. Because you're the
Administrator, you set those levels for all subsequent users.

® Browse: This user has the most limited role; he or she can view
contacts, view calendars, and add activities. The Browse user can’t
add, modify, or delete contacts; or modify or add any other data.
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The Browse role is typically assigned to users who need to look up
calendar details and schedule activities. In the real world, the data-
base Administrator typically assigns a user Browse level access if
he has serious doubts as to the user’s ability to add data.

Restricted: This role allows users to access only areas of the appli-
cation to which he or she is granted permission. The Restricted
role is typically assigned to users working in a support capacity. A
Restricted user can access all data that he or she creates but can’t
delete any data, even if he or she created it. This role also doesn’t
allow users to create companies or groups.

Standard: A Standard user is the default user role assigned to new
users. The Standard user can see the records in a database that

he creates or is given explicit access to. Standard users can add,
delete, and modify records as well as synchronize data. A Standard
user can’t add new users to the database, perform database main-
tenance, back up the database, import and export data, or modify
database fields and layouts.

Manager: A Manager role is the second-most-powerful user role.
Typically, Managers are people, such as sales managers, who
manage the various users of the database and control the types of
data that are entered into the database. Managers generally don’t
have the time — or sometimes the technical knowledge — to use
the various maintenance tools that I describe in this chapter. The
Manager can access nearly all the areas of ACT! except for data-
base maintenance and user management. The Manager is also
restricted from viewing, editing, or deleting the private records of
other individuals.

Administrator: The Administrator can perform any database func-
tion and is the chief, the head honcho, the Big Guy — the person
whom everyone blames if something goes wrong with the data-
base. When a user creates a database, he or she is automatically
assigned the Administrator role. This role is the most powerful role
in ACT!, with access to all areas of the application and all data in
the supplemental files folders. The only thing the Administrator
can’t do is access, edit, or delete records marked as private by
another user (and get out of speeding tickets when caught doing 50
in a 35 mph zone).

Assigning two users as database Administrators is always a good
idea. Not only do those two people feel extra special, but it can
also save your little rear end. As hard as it might be to believe,

the Administrator might leave the company suddenly and without
warning — taking the keys for the restroom and the password for
the database with him. This means you might not be able to access
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the database, perform routine maintenance, add users, or make
field changes. You might also find yourself looking for a new job.
Remember: No password, no entry!

8. Select the password options and then click Next.

Here’s where you can assign a password, specify that the user must
change his password the next time he logs on, or specify that he can
never change his password. You can even indicate if you want that
password to last forever by indicating that it should never expire.

9. Select the Logon Access option and then click Next.

This Active option enables the new user to access your database. If you
don’t want a user to have access to your database, feel free to choose
the Inactive option. [ show you how to delete and disable (but hopefully
not maim!) your database users later in this chapter.

10. Select additional permissions for the user.

These additional options are only customizable for Standard and
Manager level users. These options aren’t available to the Browsers
and Restricted users in the audience — and of course, Mr. Bigshot
Administrator automatically has all these options available to him.

¢ Delete Records: Authorizes the Standard user to delete records
(contacts, companies, groups, activity series, notes, histories,
opportunities, and secondary contacts) that he/she owns. By
default, the Manager already has the permission to delete at will.

¢ Accounting Link Tasks: Allows the user to install and use an
Accounting link.

¢ Handheld Device Sync: Gives permission for the user to set up his
handheld device and synchronize his ACT! data into it.

e Export to Excel: Permits the user to export any list view informa-
tion into Excel.

® Manage Sync Subscription List: Allows a Manager or Standard user
to manage the subscription list for a remote database that they’re
using.

e Remote Administration: Lets the user of a synchronizing remote
database back up, restore, and check and repair his own database.
In other words, the user becomes an “almost-Administrator” for
his database.

The preceding options are available only in the ACT! Premium edition.
Sorry, the alloy wheel option is still available only for cars!

11. Click Finish.
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Deleting login users

After you master adding new users to your database, you need to know
how to delete users when they leave. The first thing that you need to do is
to determine whether you’re going to actually delete the user or just deny
him or her access to the database. There’s a slight difference.

If you're the database Administrator and you simply want to stop someone
from accessing the database, you can do so without having to actually delete
that person as a user. You can simply shut off her login privileges.

One of the reasons why you add users to the database is so they can perform
various functions, such as scheduling appointments and creating notes. The
user’s name is also associated with any contact that he may create. Opting to
shut off a user’s login privileges, rather than delete that user entirely, elimi-
nates the possibility of losing this information. Here’s how you shut off a
user’s access to the database:

1. Choose Tools=>Manage Users from any ACT! screen.
The Manage Users dialog box opens (refer to Figure 16-1).

2. Select the name of the user for whom you wish to change the access
rights.

3. Click Edit User Information.
4. Click Next to bypass the Password window.

If you're removing a user’s ability to log in to the database, he no longer
can use a password.

5. Select Inactive and then click Finish.

The number of active users named in a database is dependent upon the
number of ACT! licenses that you purchased. When someone no longer works
for your company — or no longer needs access to the database — make sure
you change the user information to reflect his or her inactive status to make
room for an additional user.

You still might be determined to permanently erase all traces of past users
from both your database and your mind. You might also have other users
who no longer need to be associated with specific contacts, activities, notes,
or histories. ACT!, being the smart program that you’ve grown to know and
love, allows you to delete a user while preserving the information (notes,
histories, and so on) associated with him by reassigning those items to
another user.
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Follow these steps to remove a user from your database:

1. Choose Tools=>Manage Users from any ACT! view.
The Manage Users dialog box appears (refer to Figure 16-1).

2. Select the name of the user whom you want to remove from your
database.

3. Click Delete User.

This is where ACT! shows its true colors — and in fact, shows off a little.
When you choose to delete a user, one of two things happens:

e [f the user never created any information, you receive two message
windows. The first asks whether you really want to remove the
user. If you answer Yes, the contact is no longer a user. The second
dialog box asks whether you want to retain this user as a contact.
If you answer Yes, the user can no longer be one of the contacts in
your database.

e [f the user did enter information into ACT!, a dialog box pop ups that
looks quite a bit like the one you see in Figure 16-3. If you select the
Delete Records Belonging to This User radio button, you in essence
say adios to all contact records and associated data, including
notes and history — no matter who entered that data. You're
also deleting any notes and activities created by that user. A safer
choice is to select the Reassign Records to Another User option;
you retain all the contacts, notes, histories, and activities created
by the user, and the other user’s name is now assigned to them.

V?‘“\NG! After you reassign contact records to a new user, you can’t reverse the
S process. From here on, the notes, histories, and contacts that the deleted
user created appear to have been created by the new user. However, if you
simply delete a user without reassigning his records, you risk losing a lot of
contact information. If you don’t want that to happen, [ recommend simply
removing the former user’s login privileges.

Delete User
“'ou are about to delete user Allison Mikola from this
datsbase. To retain records belonging to Allison Mikola,
you muzt reazsian them to anather user,
Uzer record optionz
() Delete records belonging to this user
(*) Reassign reconds to another user,
I Geleot User
F_ 16 3 | Chiis Huffran
qure -3 | Emnst Anderson
g Fred Fenderling
i Jonathan Sommer
Dele“ng a Karen Fredricks
i Melissa Pearce
user Wlth Sarah Whiting
attached
data.
|
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Rather than deleting a user of your database, you might consider changing
the Record Manager field for all contacts that were associated with the old
user to reflect the Record Manager they’re now associated with. Go to
Chapter 15 to find out how you can change the field data for a whole bunch
of contacts at once.

Locking down the password

As the saying goes, you can never be too rich or have too much security.
Haven’t heard that one? Okay, | haven't either, but the concept is good
nonetheless. If your information is critically important to you — so important
that you're afraid that someone might just walk off with it — you might con-
sider putting a few extra restrictions on the type of passwords that your
users can use. Here’s how it’s done:

1. From any ACT! screen, choose Tools =>Password Policy.

The Password Policy dialog box opens, which looks exactly like the one
you see in Figure 16-4.

Password Policy

Enforcing a stricter password palicy may require users ta change their
passwords to conform to the new policy. & zero [0] setting means no
limitation.

Reguirements
User cannot reuse last |1 |3 password

Password must change everny |30 &) daws

Mirimum duration between password changesis 15 2| days

Password must be at least |8 |3 characters in length

Password must contain |2 4 of 4 character groups

+ Lower-case [a-2)

+ Upper-case [4Z)

+ Mumbers [0-9]

+ Special characters [such as @]

Cancel

2. Choose your password options and then click OK.

If you indicate a zero (0) for any one of the options, you're basically
telling ACT! that you don’t want to use that option. The available options
determine how often a password must be changed, whether a password
can be reused, and whether the password must include character com-
binations (such as a mix of uppercase and lowercase letters, numbers,
and special characters).
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Limiting Contact, Group,
and Company Access

The Premium edition of ACT! includes a neat little party trick: the ability to
assign record level access. Simply, record level access refers to who can see a
record. A database Administrator or Manager can set a record access level
preference for contacts, groups, and companies.

The three levels of access are

v Public: These records are available for the whole world — or at least the
users of your database — to see.

v Private: These records are visible only to the user who created the
record.

v~ Limited Access: Selected users and/or teams of users have the pleasure
of viewing these records.

Here are two good reasons why you want to limit access to the various
records in your database:

1 Users might feel more comfortable working with only their own con-
tacts. By removing access to other contacts, they virtually work in their
own little world — or in this case, database.

v~ As hard as it might be to imagine, management might feel somewhat
protective about the records in its database. Management might have
nightmares about salespeople walking out the door and into the offices
of a competitor with the contents of the company database firmly in
hand. By limiting a user to only the contacts that he developed or is
working with, you eliminate the chance that the rest of the database
could end up in enemy territory.

Creating a team

If you have many users in your database, you’ll probably want to divide your
users into teams. After you create a team of users, you can assign as many
records as you want to that team. The members of the team can access all
records that they’ve been given access to; other database users won’t even
know that those records exist. Fortunately for you, this isn’t as traumatic as
choosing sides for the volleyball team back in middle school. Follow these
three easy steps to set your teams:
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1. Choose Tools=>Manage Teams from any ACT! screen.

The Manage Teams dialog box appears. You'll immediately recognize it
because it looks just like Figure 16-5.

2. Click Create Team from the Team Tasks box area.

The Manage Teams window pops open. Let the games begin! Here’s
where you can name the team and assign the players . . . er, users.

¢ To add one or more users: Select the users in the Available Users
list and then click the right arrow button to add the users to the
Include These Users in Team list.

¢ To add all available users to the team: Click the double-right arrow
button.

¢ To create a new user: Click Create User and follow the steps to
create a user. The new user is automatically added to the team.

3. Click Finish when you’re done.

Manage Teams

Team Tasks

Cieate Team
EditTeam Select a Team to delete or to edit, and then choose a Team Task. You
can change a team name, description, or membership.
Delete Team
Team Name Description MNumber of Users
‘Europe Europe L}
UsaA Usa 5

Figure 16-5:
Creating a
team of
users.
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Assigning access vights to the contacts

After you assign the players to the teams, get ready to rumble! The purpose
of the game is to decide who gets to view which contacts. You can do this on
a contact-by-contact basis. This works out well if you assign access rights to
each new contact when you create it.

< Chapter 3 talks about the various ACT! startup preferences. You can set the
preference for each new contact, group, or company to default to a specific
user or team of users.
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Figure 16-7:
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